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The Melodyne Help Center and this PDF document

This PDF document was generated automatically from the contents of the Melodyne Help Center. It 

contains what, on the date indicated on the front page, were the latest versions of the text and 

images.

You will find the comprehensive and invariably up-to-date Melodyne Help Center along with 

numerous films and inspiring tutorials, as well naturally as the latest version of this PDF document, on 

our web site. Why not take a look? Just follow the link at the foot of each page of this PDF.

Melodyne in Live

   Loading the Melodyne plug-in • Melodyne in Live’s Session View • Backing up and exchanging projects •

  Duplicating tracks • Saving plug-in settings for Melodyne • Bouncing/printing Melodyne edits (freezing

 /flattening) • Miscellaneous notes

Melodyne 5 studio – Quick Start

      Integration • The transfer • Checking the algorithm • Editing • The macros • The Sound Editor • Multitrack 

 editing • What else should I read?

Melodyne expert tips

    Lead vocals • Background vocals • Guitar and bass • Other instruments and mixing • Workflows and 

techniques

Reference manual videos

   Fundamentals and workflow • Tools and functions • Algorithms and note assignment • Tempo
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Installation and activation

   Procedure and terminology • What files are installed and where • Your user account • Licence options: 

    Deactivate • License options: iLok • Checking for updates • Selling your license • Uninstalling Melodyne

Updates and upgrades

  Terminology: major and minor updates, upgrades • Checking for updates • Information about your edition, 

  version and serial number • How updates and upgrades are performed and what the process involves • iLok 

  when updating or upgrading • Compatibility after an update or upgrade • Parallel operation of old and new 

  versions after an update or upgrade • Going back to your old Melodyne • What upgrades are available and 

what benefits do they bring

Transferring audio

  How Melodyne works • Transferring audio to the plug-in implementation of Melodyne • Replace Ranges

The Project Browser

  Opening the Project Browser • The Project Browser and transfers in the plug-in • Automatic selection of the 

  path for transfers • Unused and missing audio files • Commands in the drop-down and context menus

Playback, navigation, zooming

 Controlling playback using the keyboard and transport bar • Controlling playback, scrubbing and zooming 

   using the Time Ruler • Resizing the window • Scrolling and zooming in the Note Editor • Navigation and 

zoom functions

Cycle mode

  Defining the cycle range • Switching cycle mode on and off • Changing the length of, and moving, the cycle 

 range • Defining the cycle range using a blob selection

Display and other options

   Showing and hiding elements of the user interface • Show Pitch Curve • Show Note Separations • Show 

     Note Tails • Displaying sibilants • Displaying fades • Show Blob Info • Show Intended Notes • Highlight 

  Notes During Playback • Show Replace Ranges (in the plug-in implementation only) • Highlight Track 

 Affiliation • Monitor When Editing Blobs

Preferences and keyboard shortcuts

   Opening the window and user interface settings • The audio cache • Shortcuts • Check for Updates

http://helpcenter.celemony.com/M5/?lang=en&startPageEdition=melodyne-studio
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Audio characteristics and algorithms

    The detection process • The Universal algorithm • The “Percussive” algorithms • The Melodic algorithm •

  The “Polyphonic” algorithms • Switching algorithms • Automatic or manual algorithm selection

Note Assignment Mode

  What editing the detection involves • What is edited and where • Various types of notes

Tools for note assignment

   The Main Tool in Note Assignment Mode • The Activation Tool • The slider and the Energy Image • The 

  Venetian Blinds • Starting point lines and designated starting points • The Note Separation Tool and the 

    Separation Type Tool • The Starting Point Tool • The Sibilant Range Tool • The Energy Share Tool • The 

Note Inspector

The Algorithm Inspector

  The Preview parameters • The Algorithm parameters • Sibilant Handling, Robust Pitch Curve, Separate Audio

The Time Grid

 Activating and setting the Time Grid • Moving notes when the grid is active

Chord recognition and the Chord Track

  One Chord Track for all Melodyne instances • Triggering the harmonic analysis • Selecting between 

   alternative designations • Entering chords manually • Keyboard shortcuts for editing the chords • Auditioning 

   chords • Chord symbol conventions • The Key Track and key changes • The Key Track and the Scale Ruler

 • Chords and keys in Note Assignment Mode

The Pitch Grid

 The functions of the Pitch Ruler and access to the Pitch Grid • The Pitch Grid and the background in the Note 

   Editor • The Scale Ruler and the Reference Pitch Ruler • Adjusting the master tuning • Selecting the tonic 

  and scale variety • The Scale Window • Saving a scale

Editing scales

   Displaying the extended scale area • Editing modes • Editing intervals • Intervals displayed as frequency 

   ratios • Defining intervals • Creating your own scales • Working with stretch tuning

http://helpcenter.celemony.com/M5/?lang=en&startPageEdition=melodyne-studio
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Identifying scales

  Showing the Scale Detective and adjusting its sensitivity • Scale detection options • Applying the detected 

scale.

Selecting notes

   Standard selection techniques • Snake selection • Selection using the Pitch Ruler • Selection commands in 

the menu

Correct Pitch Macro

  Opening and using the macro • Closing the macro and correction values when it is reopened • The Correct 

Pitch macro and sibilants

Quantize Time Macro

 Quantizing timing: What is moved and where to? • Opening the Quantize Time Macro and setting the 

 parameters • Closing the macro and correction values on reopening

The Leveling Macro

  Opening and setting the Leveling Macro • The Mean Amplitude • Closing the macro and correction values 

when it is subsequently re-opened

Main Tool

  Modifying the pitch and timing of notes • Modifying note lengths • Editing note separations

Pitch Tool

   Shifting the pitch center • Monitoring pitch shifts • Editing pitch with the inspectors • Correcting pitch with a 

  double click • Pitch transitions • Resetting individual edits and introducing random deviations

Pitch modulation and drift

  Editing pitch modulation and drift • The inspector for pitch modulation and drift • The Reset commands

Formant Tool

   Shifting formants • The inspector for the formants • Formant transitions • The Reset commands

http://helpcenter.celemony.com/M5/?lang=en&startPageEdition=melodyne-studio
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Amplitude Tool

    Editing amplitude • Editing amplitude using the inspectors • Amplitude transitions • Muting notes • The reset 

commands

Tools for fades and sibilant balance

  The Fade Tool: Fade-in and fade-out on notes • Fades in conjunction with other tools • The Sibilant Balance 

 Tool: The management of sibilants and breath noise • Uses for the Sibilant Balance Tool

Timing Tool

  Modifying the position and length of notes • Timing changes in the case of connected notes • Correcting 

  timing with a double-click • Adding random deviations • The reset commands

Time Handles and Attack Speed

  How time handles and the Attack Speed Tool work • Modifying the evolution of notes using time handles •

 Changing the attack speed of notes • Combining time handles with the Attack Speed Tool

Note separation tools

  Inserting, moving and removing note separations • Editing note separations with multiple notes selected •

 Soft and hard note separations • Switching between hard and soft separations with the Separation Type Tool

   • In the context menu: Separate Note • In the context menu: Separate Notes as Trills • In the context menu: 

Merge notes

The Note Inspector

 The parameters of the Note Inspector • Entering values and handling multiple selected notes

Copying notes

  The selection, cursor and grid when copying • Tempo adjustment when copying: the Auto Stretch Switch •

Copying in a multi-track context (without ARA)

The Edit menu

     Restore Original • Adding random deviations • Macros • Select Special • Chords and Keys • Copy 

commands for the detection data

Audio to MIDI

 About Audio-to-MIDI • Exporting MIDI

http://helpcenter.celemony.com/M5/?lang=en&startPageEdition=melodyne-studio
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Multitrack editing

  Multi-tracking in Melodyne • Differences between the stand-alone and plug-in implementations • The track 

   headers • The Editing Mix Fader • Copying between documents, tracks and instances • "Spread Unison 

Tracks"

The Sound Editor – Introduction

   Opening the Sound Editor • The Sound Editor and the "audio source" • The note selection • Individual value 

settings

The Sound Editor – Operation

   The mean spectrum • Emphasis and Dynamics • Bypass, Gain and the global Sound Editor menu • The 

   working areas • The Harmonics, Hi and Lo working areas • The harmonics bars and how to use them • The 

    Harmonics, Lo and Hi macro controls • The EQ working area • The EQ macro sliders • Formants • The 

 envelopes in the Synth working area • The Resynthesis parameters in the Synth working area

Variable tempo in the DAW

  A new constant tempo • A new variable tempo • Important when working with variable tempo

Melodyne 5: Update guide

  The Melodic Algorithm with Sibilant Detection • Compatibility with Melodyne 4 • New tools (not only) for vocals

   • The Leveling Macro • Pitch correction by double-clicking and the Correct Pitch Macro • Chord Recognition 

  and the Chord Track • The new Percussive Pitched Algorithm • Keyboard shortcuts

Already own a Melodyne?

  How does the coupon work? • What if I have already activated my Melodyne 5 essential by mistake? •

Coupons: terms and conditions of use

Version history

    New in Version 5.4 • New in Version 5.3.1 • New in Version 5.3 • New in Version 5.2 • New in Version 5.1.1

   • New in Version 5.1 • New in Version 5.0.2 • New in Version 5.0.1

User manuals for older versions

  Melodyne studio, editor, assistant and essential 4 • Melodyne editor, assistant and essential 2 (singletrack) •

 Melodyne studio 3 • Ending support for older versions of Melodyne

http://helpcenter.celemony.com/M5/?lang=en&startPageEdition=melodyne-studio
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Melodyne in Live

This tour shows you how to make efficient use of Melodyne within Ableton Live.

Please take note also of the  on our information regarding the compatibility of Melodyne with Live

website.

Loading the Melodyne plug-in

Load Melodyne as an insert effect into one of the audio tracks of the Live mixer. You will find the 

Melodyne Plugin in the Live browser under ‘Plug-Ins’ in the Melodyne or Celemony/Melodyne folder.

You are advised, as a rule, to use Melodyne as the first plug-in in a track – i.e. before the 

compressor, EQ or other effects. The reason is this: during the transfer, Melodyne records the input 

signal you intend to edit – and with it all effects ahead of it in the signal chain, which are then frozen 

into the signal and can no longer be adjusted. In order to use your compressor, EQ and other effects 

in the usual way, you therefore need to make sure they are inserted after the Melodyne Plugin in the 

signal chain.

Melodyne in Live’s Session View

If you are using Melodyne in Live’s Arrangement View, you can transfer audio to Melodyne, edit it and 

play back the results using exactly the same procedures as with any other DAW, all of which are 

described in our online user manual. However, Live also offers a Session View, and if you wish to use 

Melodyne in it, you should bear the following points in mind:

http://helpcenter.celemony.com/M5/?lang=en&startPageEdition=melodyne-studio
http://www.celemony.com
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In Session view, Melodyne can sometimes be heard in the wrong places or not at all. Furthermore, 

Melodyne ignores clip changes in Session View and does not record transfers in the correct places. 

All these phenomena stem from the principles upon which Live operates and its special way of 

handling time. The clips in Session View represent small loops within the linear running time of the 

Arrangement in Live. It is from this Arrangement time that Melodyne derives its timing information; 

Melodyne is not informed about loops hidden within clips. Schematically, the picture looks like this:

Whilst the clip is still cycling within in the loop, Melodyne has long since moved on. If you nonetheless 

do wish to use Melodyne with clips in the Session View, you should activate Live’s global 

(Arrangement-) loop and set it to the length of the clip that you wish to edit with the plug-in in Session 

View. Then the loop of the linear time (and therefore also of Melodyne’s time) will correspond to the 

loop of the clip to be edited:

The upshot of all this is that it is impossible to record and subsequently play back the switching of 

clips on a track in Melodyne in any sensible way: if you switch clips during the transfer, Melodyne will 

still record the contents, but do so along the linear time axis that is determined by the arrangement. 

And the contents will be played back accordingly. It is therefore not possible to reproduce in 

Melodyne clip changes implemented in Live’s Session View, as Melodyne is always guided by Live’s 

linear Arrangement Time rather by that of individual clips.

You are therefore recommended to use Melodyne only when working in Live’s Arrangement View. But 

you would presumably do this anyway when editing vocals or other instruments. Besides which, Live 

offers user-friendly functions for transforming clips into building blocks of the arrangement, editing 

them there in Melodyne and then rendering them once more as clips.

http://helpcenter.celemony.com/M5/?lang=en&startPageEdition=melodyne-studio
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Backing up and exchanging projects

During the transfer, Melodyne captures the track’s signal, creating recordings of the corresponding 

passages. The resulting audio files are stored in a transfers folder of their own that you create in 

Melodyne’s Project Browser. It makes sense to create a transfers folder like this within the project 

folder of each Live project. Then, in the Project Browser of the first Melodyne instance that you create 

in each project, choose “Set Path for Transfers” from the settings menu and navigate to that folder.

Following this procedure ensures that when archiving or passing on your work, all the files you need 

will be in your project folder and not elsewhere on your computer.

If you are saving a copy of your Live project to another location, after doing so you should 

immediately open the copy followed by an instance of Melodyne within it. Then, from the settings 

menu of Melodyne’s Project Browser, choose “Set Path for Transfers” and navigate to the newly 

copied transfers folder before saving your Live project.

If you didn’t set the transfer path prior to the first transfer, you can do so at any time later. Melodyne 

will automatically gather the data for the tracks already edited and move it to the storage location you 

have chosen.

When archiving and passing on projects, you do not need to worry about Melodyne’s audio cache, 

the size and location of which can be selected from Melodyne’s Preferences dialog. Melodyne will 

automatically restore the parameters found there, so there is no need to archive or copy them 

separately.

Duplicating tracks

Sometimes you may want to copy a track including its Melodyne instance and Melodyne editing – in 

order, for instance, to generate a second voice. To do this, right-click on the “Duplicate” command in 

the mixer or audio track area.

http://helpcenter.celemony.com/M5/?lang=en&startPageEdition=melodyne-studio
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Saving plug-in settings for Melodyne

Just as with an effects plug-in you can store different settings as presets, in Melodyne you can save 

different edits. You may wish to do this in order, for example, to allow a performer or artist to hear and 

choose between different edits of the same take. To save and reload Melodyne settings, follow the 

same procedures as for all other plug-ins.

Use for the purpose within the relevant effects chain the preset manager for the Melodyne plug-in. 

Save your current settings using the corresponding symbol and assign a name. You can store 

alternative edits as additional presets and switch between them using the preset selector.

Bouncing/printing Melodyne edits (freezing/flattening)

When you are using Melodyne in a project and have finished editing, you have two choices:

i) You can allow the Melodyne instance(s) to remain active until the final mixdown. If you do this, you 

will retain access to your Melodyne editing and will be able to make further refinements up until the 

very last moment. This is convenient, but as long as the plug-in remains active it is draining the 

resources of your system.

ii) You can transform your Melodyne edits into new audio files. This will deprive you of further access 

to your Melodyne editing but free up resources, as the plug-in will no longer be in use. Turning your 

Melodyne edits into new audio files has the further advantage of allowing you to pass projects on to 

colleagues who don’t have Melodyne.

To transform a clip edited using Melodyne into a new audio file in Live, either of two techniques 

suggest themselves: one is simply to ‘freeze’ the track in question and the other to ‘freeze’ and then 

‘flatten’ it.

http://helpcenter.celemony.com/M5/?lang=en&startPageEdition=melodyne-studio
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"Freeze Track": With this option, which you will find in the track’s context menu, you can transform 

temporarily your Melodyne editing and any subsequent insert effects into audio. The advantage? The 

track is now a pure audio track and Melodyne is inactive, freeing up resources. Furthermore, you can 

unfreeze the track (also from the context menu) at any time in order to modify your Melodyne editing. 

The disadvantage? Any additional insert effects are also frozen and cannot therefore be modified 

either without unfreezing the track. Similarly, it is impossible to add new effects to the track while it is 

frozen. Freezing a track is best used, therefore, as a quick temporary measure designed to 

economize on resources rather than as a permanent solution.

"Flatten": If, rather than merely freezing a Melodyne track temporarily, you wish to transform it 

permanently into a new audio file, after freezing it you should select ‘Flatten’ from the track’s context 

menu. This command transforms the frozen track into a normal audio track reflecting permanently the 

result not only of your Melodyne editing but also of any effects that follow it in the signal chain. To 

avoid these insert effects being flattened along with your Melodyne editing and to make it possible to 

modify them later, before freezing and flattening the track, you should remove from it the insert effects 

in question (e.g. by dragging them to an empty track). Once the flattening process is complete, you 

can drag the effects back onto the Melodyne track and use them as freely as before.

http://helpcenter.celemony.com/M5/?lang=en&startPageEdition=melodyne-studio
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Miscellaneous notes

Buffer size

We recommend an audio buffer size of 1,024 samples. Smaller values lead to a marked increase in 

the CPU load.

Should you require a smaller buffer, e.g. when adjusting the headphone mix directly in your computer 

and not via an external channel strip or mixer, switch all instances of Melodyne during the recording 

to bypass. Reactivate Melodyne as soon as you begin editing your new track.

Time signature changes

Melodyne not only follows the time, as described above, but also the timeline of the Live 

arrangement. If you are working on the clip level, however, with different time signatures and insert 

these clips into the arrangement, discrepancies can arise between what is heard and the time 

signatures displayed. The problem here, however, is purely a visual one; the correctness of the audio 

output and editing functions of Melodyne, including the quantization, are in no way compromised by it.

Tempo automation

If you automate the song tempo in the master track within Live’s Arrangement View, Melodyne and 

Live will no longer run in sync or the transfer may break off prematurely. One workaround for this 

consists in transferring all tracks without any tempo changes to Melodyne first and then rendering the 

tracks edited with Melodyne, before using the tempo automation.

You can also, however, alter the tempo in Live manually by setting a new constant song tempo in the 

Tempo Field. If you then use the Tempo dialog in Melodyne (reached via the broken chain symbol), 

Melodyne will ‘learn’ the new tempo.

http://helpcenter.celemony.com/M5/?lang=en&startPageEdition=melodyne-studio
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Melodyne 5 studio – Quick Start

Melodyne 5 studio gives you direct access to individual notes within your recordings, allowing you to 

edit their pitch, position, duration and other musical parameters in an intuitive way. The quality of 

Melodyne’s correction of out-of-tune notes is legendary, but you can also introduce melodic 

variations, create vocal arrangements, quantize audio, improve timing and do many other things with 

it as well.

Here is a quick and concise guide to getting Melodyne 5 studio up and running.

Integration

Open Melodyne as a plug-in on the desired audio track – preferably in the  insert slot, so that it is first

ahead of any other plug-ins (especially reverb, echo or distortion) in the signal chain. Melodyne is 

most effective when it is given a clean, dry signal.

Melodyne 5 studio is suitable for the editing of lead vocals and monophonic instruments but also for 

polyphonic instruments such as the piano or the guitar. You can also edit drum and percussion tracks 

and even entire mixes with it – using functions such as transpose, quantize and time-stretch.

http://helpcenter.celemony.com/M5/?lang=en&startPageEdition=melodyne-studio
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The transfer

When you first insert the plug-in, you will see an empty Melodyne window.

All the passages that you wish to edit with Melodyne on the track in question must first be transferred 

to the Melodyne plug-in. In other words, you must play them through to Melodyne so it can record 

them, analyze their contents, and display the notes they contain. To do this, proceed as follows:

1. Position your DAW’s playback cursor at the beginning of the passage you wish to transfer.

2. Click the “Transfer” button in the Melodyne window.

3. Start the playback in your DAW.

4. When you reach the end of the passage, either click the Transfer button a second time in 

Melodyne or stop the playback in your DAW.

Repeat the procedure until you have transferred to Melodyne all the passages you wish to edit; 

whether to transfer one long passage or a number of shorter ones is a matter of personal preference.

As the track plays back, you will hear Melodyne during the passages transferred, and the rest of the 

time, the original track.

http://helpcenter.celemony.com/M5/?lang=en&startPageEdition=melodyne-studio
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Checking the algorithm

Melodyne’s characteristic blobs represent the notes found in your recording, which you can select, 

drag and edit using the tools provided. Before you begin, however, there is one thing you must check:

Based on its analysis of the audio material, Melodyne studio will have chosen to use either its 

Melodic, its Percussive or its Polyphonic algorithm. When the Percussive algorithm is used, all the 

notes are displayed in a single horizontal line; when the Melodic or Polyphonic algorithms are used, 

on the other hand, the vertical position of the notes represents their pitch.

If your audio material is not displayed the way you want, you can select a different algorithm from the 

Algorithm menu. Please note, however, that if you do this, any editing of the track you may already 

have done using Melodyne will be lost! That is why, you should always make sure that the correct 

algorithm has been selected before you begin editing.

The detection process in Melodyne is mainly automatic and it delivers consistent results. Since, 

however, in the case of polyphonic material the issues are more complex and more interpretations 

are possible than with the other algorithms, it is sometimes necessary to revise the detection – where, 

say, a prominent overtone is identified as a separate note rather than simply one of the partials of an 

existing one. All such corrections should be made in Melodyne’s  before you Note Assignment Mode

begin your actual editing.

Editing

In Melodyne studio, you will often be working with Melodyne’s Main Tool, which can be used not only 

to change the pitch of notes but also their position in time and their duration as well as to split them. 

With the other tools, you can alter, among other things, the vibrato, amplitude and formant spectrum 

of notes as well as their internal timing.

http://helpcenter.celemony.com/M5/?lang=en&startPageEdition=melodyne-studio
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Using the tools, you can edit notes individually or entire selections of notes simultaneously. The Main 

Tool is used as follows:

To change the pitch of a note:

– Click in the middle of the corresponding blob and drag it up or down. The note will move in steps of 

a semitone.

– If you hold down the Alt key as you drag, the grid will be deactivated and you will be able to move 

the note by smaller amounts (in steps of a cent).

– If it’s the right note but simply out of tune (“off key”), double-click on it and it will snap at once to the 

intended pitch.

To change the position in time of a note:

– Click in the middle of the corresponding blob and drag it to the left or right. When released, the note 

will snap to the nearest grid line.

– If, however, you hold down the Alt key as you drag, the grid will be deactivated and you will be able 

to position the note freely.

http://helpcenter.celemony.com/M5/?lang=en&startPageEdition=melodyne-studio
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To change the duration of a note…

…by making it begin earlier or later: Click the left-hand side of the blob and drag it, respectively, to 

the left or right. 

…by making it end earlier or later: Click the right-hand side of the blob and drag it, respectively, to the 

left or right.

– If you hold down the Alt key as you drag, this will deactivate the grid, allowing you to position the 

beginning or end of the note freely.

To split a note in two:

– Position the tool at the intended split point – not on but slightly  the blob; the appearance of above

the mouse pointer will then change, and you will be able to split the note with a double click. This can 

give you greater flexibility when correcting or reshaping notes.

– The note separation that is created can be removed with a double click to reunite the two segments.

The macros

Whilst the tools are used primarily to solve specific problems with individual notes, the macros allow 

you to edit multiple notes and even entire recordings in one go. The macros affect only the notes 

currently selected, unless none are, in which case they affect all the notes of the current audio file. 

There are three macros:

Correct Pitch, which moves notes to, or towards (you decide how far), the nearest semitone. How far 

they move also depends upon how badly out of tune they were to begin with. With the second slider, 

you can rein in pitch drift within notes.

http://helpcenter.celemony.com/M5/?lang=en&startPageEdition=melodyne-studio
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Quantize Time moves notes to or towards (you decide how far) either the intended beat or the 

nearest line of the selected grid.

Note Leveling allows you to make loud notes quieter, or quiet notes louder, or both. In this way, you 

can smooth out disparities in volume and give your recordings greater homogeneity. It is also the 

perfect way to optimize input to any compressor after Melodyne in the signal chain.

http://helpcenter.celemony.com/M5/?lang=en&startPageEdition=melodyne-studio
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The Sound Editor

With Melodyne studio, you can edit not only the pitch, timing, phrasing and tempo of your recordings 

in a unique manner but also their sound. For this, the Sound Editor, which works on the spectral level 

and offers you far-reaching access to the overtone structure of the notes of each track, is particularly 

valuable. To open this area of Melodyne’s function set, choose “Show Sound Editor” from the Options 

menu.

http://helpcenter.celemony.com/M5/?lang=en&startPageEdition=melodyne-studio
http://www.celemony.com


Melodyne 5 studio - Live 12.0

   © Celemony Software GmbH 2024 • Last updated on 06/19/2024 • Help Center • www.celemony.com 22

Multitrack editing

In Melodyne studio, you can work with multiple tracks – in both the stand-alone and plug-in 

implementations. You can move from track to track with the utmost ease, and even see and edit 

simultaneously notes belonging to different tracks.

In the list, you see the Melodyne instance that is currently open as well as all the other Melodyne 

instances that you have used on the tracks of the current DAW project. The idea behind this is to 

allow you to work at all times in a  Melodyne plug-in window, whilst being able to see and edit single

there the contents of  your Melodyne instances.all

The colored blob icon in the track header is the Edit button, which causes the notes of the track in 

question to be displayed in the Note Editor. If you click the Edit button or double-click in the track 

region of another track, its notes will replace those of the first track in the Note Editor. If you hold 

down the [Cmd] key now and click on the Edit button of another track, the notes of the new track will 

be  to those already displayed in the Note Editor.added

What else should I read?

In this tour we have covered only the points needed to get you off to a fast and successful start with 

Melodyne. But there’s plenty more to discover and to learn. Take a look at the list of topics on the left: 

In the Help Center, you will find each of these topics explained in detail as well as a wide range of 

video tutorials. You can access these any time via Melodyne’s Help menu.
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Melodyne expert tips

Rich Crescenti is a freelance engineer who works as a Melodyne specialist for our American 

distributors, writes pro audio articles, interviews and reviews, and conducts numerous courses and 

seminars, having clocked up over 10,000 hours of classroom instruction time.

Sensho is an audio engineer, music producer and Melodyne specialist that built his career working in 

recording studios all over Los Angeles. In his work he explores and shares innovative ways for 

modern production processes.

Look over the shoulders of our experts in the following videos and watch them at work. Benefit from 

their experience, and draw fresh inspiration. They are working in each case with Melodyne 5 studio. 

Smaller editions may differ.

Lead vocals

Background vocals

Guitar and bass

Other instruments and mixing

Workflows and techniques
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Reference manual videos

Here you will find all the videos to accompany the Reference manual, sorted by topic. The videos are 

in English with subtitles in German, French, Spanish and Japanese. Shown here: Melodyne 5 studio, 

smaller editions may differ.

Fundamentals and workflow

Tools and functions

Algorithms and note assignment

Tempo
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Installation and activation

From this tour, you will learn all you need to know about installing and activating Melodyne. We begin 

with the basic procedure and the most important terms before outlining further options and details. 

From the separate tour “Updates and upgrades”, you can learn how updates and upgrades work and 

what you need to bear in mind when considering them.

Procedure and terminology

Serial number and Melodyne license: Your serial number is a multi-character string that 

corresponds to your Melodyne license. If you make the purchase in our web shop, we give you your 

serial number; if you buy it from a dealer, you will get it from them. If you obtain Melodyne essential 

as part of a bundle, whoever supplied the bundle will provide the serial number as well.

Registration and user account: Your user account is created when you first register a Melodyne 

license. To do this, simply enter the serial number. When you make the purchase from our web shop, 

that is part of the procedure. You can then register any further Melodyne licenses via your user 

account. From your user account, you can manage your Melodyne licenses, choose your newsletter 

options and download installation programs.

Installation program: When you download the installation program (whether for macOS or Windows) 

from your user account, it installs the latest versions of the stand-alone implementation of Melodyne 

as well as of all the various plug-ins.
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Activation: In order to run Melodyne on a particular computer, the computer must first be activated 

for Melodyne. In the course of this process, Melodyne checks the validity of your license data with our 

server, so an Internet connection is required. You will be prompted to activate Melodyne the first time 

you launch the program; this only takes a few clicks and you will need your serial number. Please 

note: Unlike the deactivation process (see below), you can only activate a computer from the 

computer itself, not from your user account.

Licence, number of activations and workstations: The standard Melodyne license allows you to 

use Melodyne on  workstation only at a time. However, the license does allow you two activations, one

the second being an emergency one you can use to activate a substitute computer quickly and easily 

if, for example, your primary computer breaks down in the middle of a production.

If you wish to use Melodyne simultaneously on two or more workstations, you can purchase further 

activations, converting your standard license into a team license. If you perform an update or upgrade 

of your team license for which a charge is made, up to four workstations are included for the same 

price as a single workstation update or upgrade. For five workstations or more, special purchase 

discounts and update/upgrade conditions apply. You can find out more about these in our .web shop
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What files are installed and where

The installation program you download from your user account installs the stand-alone 

implementation of Melodyne as well as all the various plug-ins. In the process, the following files are 

placed in the following locations:

Windows 10

VST 3: C:\Program Files\Common Files\VST3\Celemony\Melodyne.vst3

AAX: C:\Program Files\Common Files\Avid\Audio\Plug-ins\Melodyne.aaxplugin

Melodyne stand-alone: C:\Program Files\Celemony\Melodyne 5\Melodyne.exe

Note for Windows users: For its audio processing, Melodyne needs to be able to store temporary files 

on your hard disk and read them. For this purpose, a directory called: C:

\Users\*\Documents\Celemony\Separations is created. To avoid Windows Defender (virus protection) 

being invoked every time data is read from this directory – which would slow Melodyne down 

drastically – an exclusion from Microsoft Defender anti-virus scans is defined for this folder when 

Melodyne is installed.

macOS 10.12 (and later)

VST 3: Macintosh HD/Library/Audio/Plug-Ins/VST3/Melodyne.vst3

AAX: Macintosh HD/Library/Application Support/Avid/Audio/Plug-Ins/Melodyne.aaxplugin

AU: Macintosh HD/Library/Audio/Plug-Ins/Components/Melodyne.component

Melodyne stand-alone: Macintosh HD/Applications/Melodyne 5/Melodyne.app
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Your user account

You can access your user account via the menu of our website, the following link: www.celemony.com

 or by choosing License from Melodyne’s Help menu./login

In addition to the latest installation program for your Melodyne and your newsletter preferences, you 

will find in your user account various options for managing your license. There is the option, for 

example, of deactivating an activated computer or of transferring an activation to iLok (except with 

Melodyne essential or in the case described above of the emergency activation).
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Licence options: Deactivate

Any computer that has been activated to run Melodyne can be deactivated. The activation will then be 

credited to your user account, so that it can be transferred later to a different computer.

This means that if you have no activations left in your user account but wish to use Melodyne on a 

new computer, you can simply deactivate another computer that is still active, and this will free up an 

activation to transfer to your new one. You can switch between computers like this as often as you 

like. The only restriction is the number of computers involved. If you want to switch activations 

frequently between a fairly large number of computers, we recommend using the iLok USB copy-

protection dongle (see next section).

To deactivate a computer: Log in to your user account via our website or by choosing “License” 

from Melodyne’s Help menu. If you log in via our website, you must click the “License options” button 

to get to the page with the “Deactivate” option. If you choose “License” from Melodyne’s Help menu, it 

will take you to this page directly.

Nice to know: The fact that you can deactivate a computer from any other computer (provided you 

first log in to your user account) is important, as it allows you to retrieve your Melodyne activation 

from a lost or stolen computer or from one that has broken down. You can only  a computer, activate

on the other hand, from the computer itself and cannot do it through your user account.
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License options: iLok

iLok is a service provided by Pace that we offer as an optional supplement to our computer-based 

activation system (except in the case of essential, the smallest edition of Melodyne).

The iLok USB copy-protection dongle is popular because it can store many licenses and be used on 

different computers. So it allows you to take your Melodyne activation “on the road” with you if you 

are constantly moving from one computer to the next and want to use Melodyne on each computer in 

turn.

Pace offers a variety of license-protection solutions. For technical reasons, we only support one of 

these i.e. activation by means of an iLok USB dongle, which is available from dealers for around 50 

US dollars. The two other varieties (computer-based iLok activation and activation via the iLok Cloud) 

are  supported by Melodyne.not

If you wish to use iLok, you can transfer your Melodyne activation to your iLok account. Your second 

Melodyne activation is reserved for our own computer-based activation, as an emergency solution, so 

to speak, if your iLok is not to hand when needed. Additional activations that you may have 

purchased for your Melodyne license can also be transferred to iLok. Please note that a Melodyne 

activation that has been transferred to an iLok account cannot be retrieved. So before transferring an 

activation, you should make sure you really can, and do wish to, use an iLok USB copy-protection 

dongle to activate Melodyne.

Checking for updates

Each time you launch Melodyne, it automatically checks to see whether a newer and better version of 

the program is available for download. If a new version is available, a page giving you details of it will 

open in your browser and from this you can download the new version.

If you open the “Check for Updates” page of Melodyne’s “Preferences” dialog, you can opt, if you 

prefer, to check for updates manually (which is done by clicking the “Check Now” button) rather than 

have Melodyne do this for you automatically at program launch. We recommend you to leave the 

default setting (“Automatically”) so that you never miss an important update.
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Selling your license

Naturally it is possible to sell your Melodyne, but to do so you need to contact our support. Since the 

person you sell it to will require their own user account with their own access data, we will have to 

remove your serial number from your user account and also cancel any activations you may have 

transferred to iLok. Only then can the license be transferred to the purchaser.

Please note : Resale of a Melodyne license purchased by credit card from our web shop is not 

possible within three months of the date of purchase. This is to prevent possible credit card fraud.

Uninstalling Melodyne

To uninstall Melodyne under macOS, just run the program “Melodyne Uninstaller”, which you will find 

in the “Melodyne 5” folder within your “Applications” folder. Under Windows, follow the standard 

procedure for uninstalling applications.
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Updates and upgrades

From this tour, you will learn all about updating and upgrading Melodyne. We explain the installation 

procedure, the Melodyne license and the activation of the program in the tour “Installation and 

activation”.

Terminology: major and minor updates, upgrades

Minor update: This is a free update containing bug fixes and perhaps new functions of lesser 

importance. In this case, although the version number is incremented, its first digit remains the same 

(e.g. from 5.  to 5. ).0.3 1.0

Major update: This is an update that contains significant new features and is indicated by a change 

in the first digit of the version number (e.g. from .2.1 to .0.0). These updates are not free of charge. 4 5

Exception: Melodyne essential, for which even major updates are free of charge.

Upgrade: This is a change, for which you do have to pay, from a smaller edition of Melodyne to a 

larger one with more functions (e.g. from Melodyne essential to Melodyne assistant).

An  may also contain a major . For example, an upgrade from Melodyne  to upgrade update 4 editor

Melodyne . It is not necessary to update to editor 5 before upgrading to studio 5.5 studio

Checking for updates

Each time you launch Melodyne, it checks automatically to see whether a new and improved version 

is available for download. If this is the case, a page will open in your browser giving you details and 

allowing you to download the new version.

In Melodyne’s Preferences dialog, you will find a page entitled “Check for Updates” where you can 

switch from automatic checks (the default) to manual checks triggered by clicking the “Check Now” 

button. We recommend you to leave the default setting (“Automatically”) unchanged, so you never 

miss an important update.
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Information about your edition, version and serial number

To discover which version of which edition you have, as well as your serial number, choose Melodyne 

> “About Melodyne” from the main menu.

The name of your edition and your serial number are also displayed in your user account. There you 

will also see which basic version you have (i.e. the first digit of your version number: 4, 5 etc.) but not 

which specific update is currently installed on your computer (e.g. 5.1.0).
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How updates and upgrades are performed and what the process involves

When you are notified by Melodyne’s Check for Updates function or by newsletter that an update for 

your Melodyne is available, you will always be provided with a download link for the corresponding 

installation program. If you learn of an update in some other way or if you have purchased an 

, you will find the installation program in your user account.upgrade

Every update or upgrade requires you to install the latest version of Melodyne. In the case of a free-of-

charge  update, that’s all there is to it. In the case of a  update or an upgrade, on the other minor major

hand, you will be given a new license and at the same time your old one will expire. This also means 

that your old serial number will be replaced by a new one. So Melodyne may also need to be 

reactivated after the update or upgrade.

When you are reactivating the program after a major update or an upgrade, your old activations will 

no longer count, because along with your new license you will receive new activations.

A tip about updates: If you are running Melodyne on more than one computer, a major update is liable 

to involve many changes to the program, some of which may also affect the sound. For this reason, 

you will probably not want to update Melodyne on the production computer until the projects you are 

working on there are complete, but you may still want to try out the new version on your laptop. This 

is not a problem: if you buy an update from Melodyne 4 to Melodyne 5, your activations for Melodyne 

4 will not be removed immediately but only after the installation of Melodyne 5. You can update 

Melodyne on one of the computers and continue to run Melodyne 4 on the other for a transitional 

period.

iLok when updating or upgrading

With iLok, too, a distinction has to be made between (on the one hand) a  update and (on the minor

other) a  update or an upgrade. In the case of a minor update, you don’t need to do anything; major

your iLok USB dongle will continue to work.

With a , however, you receive a new license, so in both these cases major update or an upgrade

your iLok license must be updated. If you are using iLok, we transfer your new licence automatically 

to your iLok account, where it replaces the old one.

At this point, action from you is required: To run your new Melodyne, you must then transfer your 

new Melodyne license from your iLok account to your iLok USB dongle.
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Compatibility after an update or upgrade

An update will give you new features and possibilities, but will remain compatible with your existing 

projects. Please note, however, that we are talking here about  compatibility only: You will be upward

able to open projects saved by your old version of Melodyne in your new one, but you will not be able 

to open projects saved with your new version of Melodyne in your old one.

In the case of massive leaps, however, such as from Version 1 to Version 5, there will naturally be 

major differences, as the pace of development at Celemony is unrelenting. New processing methods 

and bug fixes, as well as new and improved functions, all find expression in higher sound quality – or, 

to put it in neutral terms, acoustic differences. For this reason, you are advised in case of doubt not to 

perform this type of major update while you are still working on a project.

Different  of the program are also compatible, provided they have the same version numbers. editions

You can, for instance, open a project created by Melodyne editor Version 5.0.1 in Melodyne essential 

Version 5.0.1 or even in Melodyne player (a non-activated Melodyne) Version 5.0.1. Everything will 

sound exactly as it did when it was saved by Melodyne editor, even if some or all of the functions you 

used to perform the edits in Melodyne editor are not available in Melodyne essential or player.

The reason is that Melodyne editions differ from one another not in the technology they use but in the 

range of functions they provide. Since Melodyne essential offers fewer functions than Melodyne 

editor, you will be limited to these when performing any further editing in Melodyne essential of a 

Melodyne editor project, and no further editing of it at all will be possible using Melodyne player. A 

wider range of functions, on the other hand, would be available to you if you opened the same editor 

project in the more powerful Melodyne studio.

Parallel operation of old and new versions after an update or upgrade

This is impossible for technical reasons: DAWs recognize the Melodyne plug-in by its identifier, and 

this does not change when the product is upgraded or updated. The advantage is that this allows you 

to update or upgrade Melodyne in the middle of a project and continue working seamlessly. It does 

mean, however, that you cannot run your old and new versions of Melodyne in parallel inside the 

same DAW, as they would need to use the same identifier and no DAW will allow the same identifier 

to be used more than once.

Going back to your old Melodyne

After a major update or upgrade, it is usually not possible to go back to the version or edition of 

Melodyne you were using previously. However, if serious problems or incompatibilities arise in your 

system after an update or upgrade, please contact our support. We’re sure to find a solution.
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What upgrades are available and what benefits do they bring

You can upgrade from any edition of Melodyne to any of the larger editions – even directly from the 

smallest, Melodyne essential, to the largest, Melodyne studio.

You will find an overview of all updates and upgrades in our web shop. Under “More Info...”, you can 

discover which key functions and features not offered by your current edition the upgrade will bring 

you.

You will find a table comparing the various editions .here
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Transferring audio

In this tour, you will learn how to transfer audio material to the plug-in implementation of Melodyne as 

well as the fundamentals of its use.
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How Melodyne works

Before it can make its editing functions available to you, Melodyne must first analyze the audio 

material. Since for this analysis the audio file has to be examined as a whole, it cannot be conducted 

in real time; it is performed once only, at the start, before the first blobs appear in the Note Editor. In 

the stand-alone implementation of Melodyne, this is when the audio file is first opened.

In the case of the plug-in, the matter is somewhat more complicated. Since most commonly-

encountered plug-in interfaces are designed for pure real-time operation, a plug-in, logically enough, 

is only shown the part of the audio file that is being played at that instant, which is rather like looking 

through a keyhole. But Melodyne, as we have seen, requires a more comprehensive overview; for 

this reason, you have to send it in advance the track segments you wish to edit, so that it can study 

them.

This is the purpose of what we call the “transfer”: This is essentially a recording process whereby the 

plug-in implementation of Melodyne makes its own copy of the track segments playing back in the 

DAW. In this way, Melodyne obtains the audio data that it must have if it is to detect and display the 

notes. These transfers make using Melodyne more effort than one would like, but there is no other 

way of overcoming the limitations of real-time plug-in interfaces.

There are, of course, exceptions: To make working with Melodyne in a DAW more effortless, we have 

developed the ARA plug-in interface extension. DAWs that support ARA provide Melodyne with all the 

information it needs about the audio files they are using and make it possible to open a track for 

editing in Melodyne immediately – i.e. without going through the transfer procedure first. This is the 

most convenient way of using Melodyne in a DAW.

If your DAW supports ARA, apart from the next paragraph, the rest of this tour need not concern you. 

Instead, search for your DAW in the Help Center, where you’ll find details of how to take advantage of 

ARA with each of the various DAWs that support it.

The following, however, applies to all scenarios involving Melodyne – with or without ARA: The 

amount of memory Melodyne requires depends partly upon the length of the files you are transferring 

to it or loading but mainly upon the number of notes they contain: the more notes a file contains, the 

longer the detection process takes and the more memory it requires. This makes it difficult to 

formulate a concrete rule, but, in general: with files longer than an hour, the detection process is 

generally slow; files longer than two hours, however, may be impossible to load or transfer at all, due 

to shortage of memory. In such cases, please divide the file up and transfer or load only the 

segments that you actually wish to edit in Melodyne.
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Transferring audio to the plug-in implementation of Melodyne

Open in your DAW the project you wish to edit.

Load the plug-in implementation of Melodyne as an audio insert effect in the audio track containing 

the material you wish to edit. Position the plug-in implementation of Melodyne above any insert 

effects you may be using in the track – if in doubt, put it in the first insert slot. For the analysis (or 

“detection”) to achieve the best possible results, Melodyne needs to be given as dry and clean an 

input signal as possible.

Move the playback cursor in the DAW to a point before the beginning of the passage you wish 

to edit with Melodyne.

Click the Transfer button at the top left of the Melodyne window to prepare it to accept the 

transfer.

Press Play in the DAW to transfer the material, which Melodyne will import automatically. 

Press Stop when the end of the passage you wish to edit is reached.

Stopping the DAW playback automatically brings to an end Melodyne’s transfer readiness. You can 

also interrupt a transfer in progress at any time by clicking the Transfer button.

If you wish, you can transfer to Melodyne further passages from different parts of the DAW track. 

Clicking the Transfer button during playback by the DAW toggles Melodyne’s “enable transfer” 

function on and off, allowing you to punch in and out as the playback proceeds. Alternatively, as you 

reach the end of each of the passages you wish to transfer you can stop playback by the DAW, find 

the start of the next passage, transfer-enable Melodyne again, restart playback by the DAW, stop it 

again, and so on. If you wish, you can just transfer the entire track or even several tracks 

simultaneously to multiple instances of Melodyne. To do this, simply enable the Transfer buttons of all 

the instances to which you wish to transfer material simultaneously.

Important: If your DAW project contains changes of tempo or time signature, please consult the tour 

entitled “Adjusting to tempo variations in the DAW”.
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Tip: Initialize the key prior to the transfer: In the case of monophonic or polyphonic audio material, 

Melodyne also recognizes the key (or “tonality”) of the music. With short melodic phrases, however, 

the key chosen is often not the one intended, simply because too few notes are available for a correct 

appraisal. To prevent this happening, you can set the key using the Scale Ruler of an empty instance 

of the plug-in or an empty document (if using the stand-alone implementation of the program)  before

the transfer or loading of an audio file. To do this, simply click on the desired keynote in the Scale 

Ruler and select the desired scale or key from the context menu. Melodyne will then retain this 

initialized value, regardless of its own subsequent analysis.

Replace Ranges

During playback, those passages that have been transferred to Melodyne will be played back by 

Melodyne; all others by the DAW. In other words, wherever it has material to play back, Melodyne’s 

signal will replace that of the original track.

From the Options > Note Editor sub-menu, choose Show Replace Ranges. All the passages that will 

be played back by Melodyne (as opposed to the DAW) will now be marked. Such regions can be 

extended simply by dragging their borders with the mouse.

To shorten a playback region, delete a few blobs and select Set Replace Ranges to Notes from the 

context menu of the Time Ruler. This command works not only at the borders of the playback region 

but also when you delete notes from the middle of the region – as shown in the following illustration.
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The Project Browser

The Project Browser shows you all the audio files used by each project and helps you manage them 

and locate missing files.

Opening the Project Browser

Both the stand-alone implementation and the plug-in possess a Project Browser. In each case, this is 

opened by clicking the “Project” tab in Melodyne’s info pane.
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The Project Browser and transfers in the plug-in

In the plug-in implementation of Melodyne, the Project Browser displays a file entry for every 

Melodyne transfer from the DAW that has been conducted.

The Melodyne plug-in records the audio material transferred from the DAW track, creating audio files 

in the process that it stores on your hard disk. For material to be played back and edited in Melodyne, 

it is not enough simply for the original audio files to be present in the DAW project; Melodyne also 

requires its own audio files – the ones it created at the time of the transfer.

It is important to remember this when you wish to archive a DAW project or pass it on to another user 

complete with your Melodyne editing. In this case, you must be sure to archive or hand over not only 

the DAW project along with its audio and other files but also the transfer files created by Melodyne. 

Otherwise, when the archived project is restored or when the recipient comes to open it, the 

transferred passages and the editing you have applied to them will be inaccessible.

The question that arises, therefore, is this: Where does Melodyne store the files it creates and how 

can you append them to your project? The answer is found in the Project Browser, which allows you 

to manage the transfer files and also search for lost ones.

The Project Browser of the plug-in allows you to choose the folder in which the transfers will be kept. 

To do this, click on the cog icon near the top right-hand corner of the Project Browser and choose Set 

Path for Transfers. Your choice applies only to the current project. We recommend, therefore, that 

you choose a folder within your DAW’s project folder as the path for transfers, as this will make both 

archiving and passing on the project to others more straightforward.

You can set the path for your transfers at any stage in the editing process. As soon as you do so, all 

the transfers created up to that point in the course of the project (and stored in Melodyne’s temporary 

transfers folder) will be moved to the folder you have selected. Whether the new folder is on the same 

or a different volume (e.g. a different hard disk) makes no difference; the existing files will be copied 

to the new location. New transfers will be stored in the newly created folder.

Each time you set a new path for transfers, Melodyne tells you to save your DAW project so that the 

new file references can be stored in a permanent fashion.
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Automatic selection of the path for transfers

Many DAWs are able to tell Melodyne where the folder of the current project is located. In these 

DAWs, you are not offered the option of specifying a different path. Instead, Melodyne automatically 

stores its transfers in the project folder created by the DAW, thereby ensuring that your transfer files 

are integrated into the project and do not get lost.

Do not worry, then, if your DAW offers you no way of choosing a path for the transfers. If that is the 

case, Melodyne will store the files in question in the right place automatically.

Unused and missing audio files

In both the stand-alone implementation and the plug-in, audio files are color-coded in the browser as 

follows:

Black: The file is present and being used by the project

Gray: The file is present but not in use (e.g. because you have deleted from the project all the 

notes it contains)

Red: The file is needed but unavailable

The reason unused files are retained in the Project Browser rather than being deleted automatically is 

that this allows you to undo the delete operation, which would otherwise be impossible.

If Melodyne cannot find one of the files it needs to use – either because it has been deleted or 

because it was not moved to a new computer along with the other project files – the missing file will 

be shown in red in the Project Browser. The notes belonging to such a file are shown in gray with a 

red outline in the Note Editor and are muted during playback.

http://helpcenter.celemony.com/M5/?lang=en&startPageEdition=melodyne-studio
http://www.celemony.com


Melodyne 5 studio - Live 12.0

   © Celemony Software GmbH 2024 • Last updated on 06/19/2024 • Help Center • www.celemony.com 45

Commands in the drop-down and context menus

The drop-down menu opened by the cog icon in the Project Browser as well as the context menu in 

the same browser offer the following commands, some of which are designed to facilitate the 

assignment of missing files.

Set Path for Transfers... (only in the plug-in): This allows you to specify where the transfer files 

should be stored, as is explained above.

Show in Finder/Explorer: If you choose this command after right-clicking on a file in the Project 

Browser, a Finder/Explorer window will open showing you the location of the file.

Copy File(s): This copies the selected file(s) onto the clipboard. This might be useful, for example, if 

you have passed on to another user a project missing one or more of the requisite transfer files; by 

selecting the missing file(s) in the Project Browser, choosing Copy File(s) and then pasting the 

contents of the clipboard onto a hard disk or other storage medium, you can remedy the error swiftly 

without having to hunt around for the missing file(s).

Copy Path for File(s): This copies as text to the clipboard the path of the selected files. This is useful 

if you need to send someone a list of missing files.

Find Missing Files: This opens a file selection window that allows you to locate the missing file on 

your hard disk and “show” it to Melodyne.

It is advisable to save your project after reassigning files, in order to store the updated references.

Copy External Files to Project Folder (only in the stand-alone implementation): This command 

results in all the files that you have imported into your project from different locations on your hard 

disk, whether via the File menu or by drag ‘n’ drop, being copied into the audio folder of your 

Melodyne project. This folder, which is created when your Melodyne project is first saved, is on the 

same level in the file hierarchy, and bears the same name, as the MPD file of the project, but with the 

suffix “_Audio”. It is advisable to save your DAW project after executing this command, in order to 

store the updated references.

Delete Unused Files in Project Folder: If you are certain that you will have no further need for files 

marked as unused in the Project Browser, this command allows you to delete them and liberate 

space on your hard disk.

The last two commands in the context menu allow you to specify whether the files in the Project 

Browser should be displayed in alphabetical order or according to status (missing, used, unused).
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Playback, navigation, zooming

This tour will give you an overview of the functions Melodyne offers for navigation and the playing 

back of audio.

Controlling playback using the keyboard and transport bar

The plug-in implementation of Melodyne is integrated into the DAW and keeps perfectly in step with 

its playback. When you reposition the DAW, this information is conveyed to Melodyne, which mirrors 

the new position. As soon as the DAW starts, Melodyne also starts. It is not possible to start, stop or 

reposition the DAW’s playback cursor from within Melodyne.

With the stand-alone implementation of Melodyne, you start and stop the playback using the buttons 

in the transport bar at the top or by pressing the space bar. If you hold the [Alt] key at the same time, 

playback will be confined to the current selection.

You can also control playback in Melodyne Stand-Alone using the numeric keypad of your computer. 

The shortcuts can be selected from the Preferences dialog, the default settings being as follows:

Playback/Pause [space bar]: Stop or Start playback from the current position of the playback 

cursor

Start [Enter] when stopped: Commence playback from the current position of the playback 

cursor

Start [Enter] during playback: Jump to, and continue playback from, the last starting point

Stop [0 on the numeric keypad] during playback: Stop and jump to the last starting point

Stop [0 on the numeric keypad] twice in succession: Jump to the beginning of the project

In both the stand-alone and plug-in implementations of Melodyne, the arrow keys on the keyboard 

can be used to step through the blobs. When playback is stopped, the blob currently selected will 

sound.

Before you can play back the blobs in this way in the stand-alone implementation of Melodyne, it may 

be necessary to click once in the Note Editor so that it has focus. It is the focus that determines to 

which part of the user interface any shortcuts you use apply. The pane with focus at any given 

moment is the one enclosed in a thin orange frame.

Please note that you can define a wide variety of keyboard shortcuts – including new playback 

shortcuts – using Melodyne’s Preferences dialog. If for any reason you are not satisfied with the 

default shortcuts, you can redefine them at will.
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Controlling playback, scrubbing and zooming using the Time Ruler

The following playback functions are available in both the stand-alone and plug-in implementations of 

Melodyne – in the Melodyne plug-in, however, only when the DAW is stopped; as soon as it starts 

again, Melodyne plug-in resumes its shadowing of the DAW as described earlier.

 

Double-click in the Melodyne Time Ruler (or directly in the background of the Note Editor) to 

commence playback from the position in question. If you hold down the [Alt] key as you double-click 

in the Time Ruler, playback will be confined to the current selection.

If you double-click again in the Time Ruler while the playback is in progress, the playback will stop 

and the playback cursor will move to the point clicked.

A single click in the Time Ruler moves the playback cursor to the point clicked. If you do this while 

playback is in progress, instead of halting, playback skips to the position clicked and continues from 

there. If you do it while playback is halted, the playback cursor moves to the position clicked but 

playback remains halted and only resumes if you double-click in the Time Ruler.

When playback is halted, you can scrub through the audio material by clicking and dragging in the 

Time Ruler.

By dragging upwards or downwards, you can zoom the display at the current position. Scrubbing and 

zooming can be used in combination, allowing you to navigate and position the cursor intuitively, 

setting the zoom factor at the same time.

Please note: In Melodyne studio, when you start playback or scrubbing via the Time Ruler of the Note 

Editor, it is the Editing Mix Fader (near the right-hand end of the toolbar) that determines what you 

hear; if the fader button is moved all the way to the left, you will hear only the notes corresponding to 

the colored blobs in the Note Editor. As the fader button is moved back towards the center, the gray 

blobs, which are only displayed for reference, will become gradually louder. Finally, with the fader 

button moved all the way to the right, you will hear all Melodyne tracks, including those not currently 

displayed in the Note Editor.
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Resizing the window

To change the size of the window, click and drag the bottom right-hand corner. The procedure is the 

same for both the stand-alone and plug-in implementations of Melodyne.
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Scrolling and zooming in the Note Editor

Select the Scroll Tool (the hand icon) from beneath the main tool or hold down the [Command] and 

[Shift] keys to move the display area with the mouse.

Select the Zoom Tool (the magnifying glass) from beneath the Main Tool or press [Command]+[Alt] to 

zoom the display with the mouse. You can zoom horizontally and vertically at the same time – with 

different levels of intensity in each case.

[Command]+[Shift]+double-click zooms in on one blob or several (if several are selected). A 

corresponding double-click in the editing background returns you to the previous zoom level.

If your hardware supports the corresponding functions, you can also scroll and zoom with the mouse 

and trackpad:

The mouse wheel and swiping with two fingers on the trackpad can be used for horizontal and 

vertical scrolling.

Pinching with two fingers on the trackpad zooms the display simultaneously on the horizontal 

and vertical planes.

Drag the horizontal or vertical scrollers (i.e. the scroll boxes or ‘thumbs’)  to move the display. The 

horizontal scroller contains a miniaturized image of the contents as an orientation aid.
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Drag the ends of the scroller to zoom the display.

If you are editing a particularly long audio file, you may find the reduced size of the scroller makes it 

difficult to achieve the desired zoom resolution. In that case, you can zoom in further by holding down 

the [Command] and [Alt] keys whilst dragging in the edit pane or else by dragging vertically in the 

Time Ruler.

If you pull one end of the horizontal or vertical slider as far as it will go and hold it, you can increase 

the vertical or horizontal size of the area displayed. This can be useful in the plug-in, for example, 

when you have only transferred the first three bars (measures) of your material but wish to insert 

something at bar 20.

Double-click in the center of the scroller to zoom in or out just enough to ensure that all the blobs are 

displayed. If cycle mode is active, double-clicking on the horizontal scroller zooms the display just 

enough to ensure that the entire contents of the cycle range are visible.

Use the slider in the bottom right-hand corner near the Note Editor to alter the height of the blobs. 

This does not alter their volume. Your likely motive will be to obtain a clearer view of material 

containing a lot of particularly quiet or particularly loud notes.

A note about automatic scrolling in the Note Editor

If you have selected one or several notes, Melodyne assumes that you wish to see and edit them, 

and exercises the requisite restraint by deactivating the auto-scroll function temporarily. Only when 

you deselect the notes (for example, by clicking in the background of the Note Editor) and restart the 

playback does the display resume its pursuit of the playback cursor.

Similarly, if you move the horizontal scroller so far during playback that the playback cursor actually 

disappears from the screen, automatic scrolling will be deactivated. Stopping and restarting in this 

case will reactivate the auto-scroll function.

If automatic scrolling has temporarily been deactivated, the auto-scroll icon in the bottom right-hand 

corner of the Note Editor takes the form shown here.
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Navigation and zoom functions

To resize the window (also in Plugin), drag the bottom right corner

Hold down the [Command]+[Shift] keys and drag the editing background of the Note Editor to 

move the area displayed

Use the mouse wheel to scroll up and down or else (holding the [Shift] key) left and right

A two-finger swipe on the trackpad can be used to scroll the display

A two-finger pinch on the trackpad can be used to zoom the display.

[Command]+[Alt]+drag in the Note Editor serves to zoom the display horizontally and/or 

vertically

Drag vertically in the Time Ruler to zoom in on the area indicated

Press [Command]+[Alt] and use the mouse wheel to zoom both axes simultaneously

Press [Command]+[Alt] and double-click to zoom in on a blob or the current selection of blobs

Press [Command]+[Alt] and double-click in the editing background to restore the previous 

zoom setting

Drag the scrollers to move the display horizontally or vertically

Drag the ends of the scroller to zoom the display horizontally or vertically

Pull the left- or right-hand ends of the horizontal slider as far as they will go to increase the 

length of the section displayed (important in the plug-in e.g. when you have only transferred 

the first four bars and  are able to navigate only in this area but wish to insert something at bar 

20)

Double-click the scrollers to zoom in or out horizontally or vertically until all notes are displayed

The slider in the bottom right-hand corner governs the height of the blobs
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Cycle mode

In Melodyne’s cycle mode, a selected passage is repeated endlessly.

Defining the cycle range

To define a cycle range, click and drag in the lower part of the Time Ruler. If, as you do so, you hold 

down the [Alt] key, the Time Grid will be ignored, allowing you to position the start and end points 

(which we call the “cycle locators”) freely.

Switching cycle mode on and off

Double-click on the cycle range in the narrow strip immediately below the Time Ruler to toggle cycle 

mode on and off. When cycle mode is active, the cycle range is shown in dark grey

In the stand-alone implementation of Melodyne, you can also switch cycle mode on and off from the 

transport bar.

It is also possible by choosing File > Preferences > Shortcuts to define a keyboard shortcut for 

toggling cycle mode on and off.
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Changing the length of, and moving, the cycle range

Drag the right- or left-hand locators to alter the length of the cycle range. If, as you do so, you hold 

down the [Alt] key, the Time Grid will be ignored, allowing you to position the locators freely.

Drag the middle of the cycle range to move it ‘en bloc’ to the left or right. If, as you do so, you hold 

down the [Alt] key, the Time Grid will be ignored.

If you [Shift]+click near either of the cycle locators, it will move to the designated position. If, as you 

do so, you hold down the [Alt] key, the Time Grid will be ignored.

Defining the cycle range using a blob selection

To move the cycle locators to the beginning and end of the current blob selection (snapping to the 

grid) hold the [Shift] key and double-click anywhere in the cycle range. If you hold the [Alt] key as well 

as the [Shift] key as you do this, instead of snapping to the grid, the locators will be placed at the 

beginning of the first, and end of the last, blob in the selection.
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Display and other options

Melodyne offers for the user interface and working in the Note Editor various options that allow you to 

adapt the appearance and behavior of the program to your tastes.

Showing and hiding elements of the user interface

Melodyne’s user interface can be adapted to a variety of different work situations and demands. You 

will find the means of doing so in the Options menu as well as the interface itself.
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List All Plug-in Instances (A): Shows/Hides the pane in which the headers for the various plug-

in instances are displayed and adjusts the height of the info pane accordingly, assuming it is 

not hidden at the time.

Scale Editor (B): Shows/Hides successively one, two or all three panes of the Scale Editor 

window.

Pitch Grid (C): Offers the choice between various options for the Pitch Grid.

Time Grid (D): Offers the choice between various options for the Time Grid.

Show Info Pane (E): Shows/Hides the info pane.

Show Sound Editor (F): Shows/Hides the Sound Editor beneath the Note Editor.

Auto-Scroll (G): When this option is selected, the display in the Note Editor follows the 

playback cursor.

With the “Keys” (H) and “Chords” (I) switches, you can show or hide the Key and/or Chord 

tracks.

A note about automatic scrolling in the Note Editor:

If you have selected one or several notes, Melodyne assumes that you wish to see and edit them, 

and exercises the requisite restraint by deactivating the auto-scroll function temporarily. Only when 

you deselect the notes (for example, by clicking in the background of the Note Editor) and restart the 

playback does the display resume its pursuit of the playback cursor.

Similarly, if you move the horizontal scroller so far during playback that the playback cursor actually 

disappears from the screen, automatic scrolling will be deactivated. Stopping and restarting in this 

case will reactivate the auto-scroll function.

If automatic scrolling has temporarily been deactivated, the auto-scroll icon in the bottom right-hand 

corner of the Note Editor takes the form shown here.

All the options described below relate to the Note Editor and are found by choosing Options > Note 

Editor Options from the main menu or by clicking the cog icon in the top right-hand corner of the Note 

Editor.

Please note that these options can be selected independently for Edit and Note Assignment modes.
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Show Pitch Curve

If you check the option Show Pitch Curve, a thin line tracing the exact pitch of the tone at each instant 

will be superimposed on the corresponding blob.

On the left, you can see the ‘naked’ blobs (with none of the Note Editor display options selected) and 

on the right, the same blobs with the Show Pitch Curve option checked.

Regardless of whether or not this option is checked, the pitch curve will be displayed whenever the 

Pitch Tool is selected.

Show Note Separations

If you select the option Show Note Separations, gray vertical lines appear at the beginnings and 

endings of notes indicating their limits or separations.

Note Separations are either shown as lines (soft separations between connected notes) or thin 

brackets (hard separations).

Note separations are always displayed when the independent Note Separation Tool is in use, 

regardless of whether or not the menu entry is checked.
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Show Note Tails

In the detection and display of notes, Melodyne editor draws a distinction between the notes 

themselves and their tails – notes being the events of musical relevance and tails depicting the non-

musically-determined fading-away of the sound. The share of the reverberation ascribed to a given 

tone, for example, is reflected in its tail. The Show Note Tails option allows you to decide whether the 

reverberative phase of notes should be displayed or hidden. This is likely to depend upon whether 

you prefer to concentrate upon their musical or their acoustic aspects.

If the tail is not displayed, the end of the musically relevant part of the note provides the handle you 

can drag with the Time Tool to make the note longer or shorter. Any reverberation present will in this 

case automatically be governed by the changes made. This display option serves to provide a clearer 

overview of the intended musical events.

If the note tail is displayed (assuming it has one), it is this that provides the handle for the Time Tool. 

Show Note Tails is the option most suitable when what is sought is as authentic a picture as possible 

of the sounds actually heard – including any reverberation present.
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Displaying sibilants

If you check the option “Show Sibilants”, the presence of sibilants (usually “s” sounds or breath noise) 

is indicated by hatching.

When the Sibilant Balance Tool is selected in normal edit mode, or the Sibilant Range Tool is 

selected in Note Assignment Mode, the sibilants are invariably displayed, whether this option is 

checked or cleared.

Displaying fades

If the “Show Fades” option is checked, the control elements belonging to the Fade Tool are displayed 

beside any notes you have previously edited using the Fade Tool.

When the Fade Tool is selected in normal edit mode, the control elements in question are invariably 

displayed, whether this option is checked or cleared.
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Show Blob Info

With the option Show Blob Info, you can elect to show or hide a variety of display elements designed 

to facilitate working with individual notes.

The most striking of these elements is the Local Pitch Ruler that appears directly in front of any note 

over which you move the mouse pointer. Within the blob itself, thin lines mark the drag zones for the 

context-sensitive tools.

If you drag a blob when the Show Blob Info option is checked, a vertical line also appears in the Time 

Ruler aligned with the exact start of the note. This makes more precise positioning possible.

Show Intended Notes

If you check the option Show Intended Notes, gray frames appear around each blob.

These invariably lie directly on the semitone and coincide exactly with a gridline. They represent, in 

other words, Melodyne’s assumptions (based on its own analysis of the audio) as to the intended 

pitch of the note and its intended position within the measure or bar. These assumptions generally 

turn out to be correct, but are not inevitably so. They are to be thought of as suggestions.

The frames also display the positions in pitch and time towards which the notes in question will 

gravitate if partial quantization is applied to them with the macros, which are also the positions they 

will snap to if you double-click on them with the Time Tool or Pitch Tool.
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Highlight Notes During Playback

With this option, you can select whether or not you would like your eye to be drawn to the note 

currently playing back. Highlighting is mainly useful when the screen is thick with notes.

Show Replace Ranges (in the plug-in implementation only)

If you check this option, those passages will be indicated that have been transferred to the plug-in 

from your host and for the playback of which, in consequence, Melodyne rather than the host is 

responsible.

This information is conveyed by the fact that the Time Ruler is shaded more palely for the duration of 

all such passages.

Highlight Track Affiliation

This option gives you a better overview of which notes belong to which tracks when multiple tracks 

are being displayed simultaneously in the Note Editor: When the option is checked and you click on a 

note with a tool, all notes belonging to tracks other than that of the note selected will be displayed in 

grey for as long as you hold down the mouse key. This lets you see at once which notes do, and 

which do not, belong to the same track as the note selected.
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Monitor When Editing Blobs

When you shift the pitch of blobs in the Note Editor with this option selected, Melodyne plays for the 

purpose of orientation the sound of the note at the position originally clicked. You can turn this 

acoustic feedback on or off.
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Preferences and keyboard shortcuts

From the Preferences property sheet, you can select fundamental options governing the modus 

operandi of Melodyne as well as define a number of keyboard shortcuts.

Opening the window and user interface settings

In the plug-in implementation of Melodyne, you open the Preferences property sheet from the 

Settings menu; in the stand-alone implementation, choose Preferences from the program (macOS) or 

File (Windows) menu. The settings available in the stand-alone implementation differ slightly from 

those offered by the plug-in.

The following user interface options, however, are available in both implementations of Melodyne. 

Any changes you make in either implementation apply to both.

Language: Determines the language of the user interface.

Pitch labels: Determines which system is used to name the notes – i.e. (descending 

chromatically) English (C, B, Bb etc.), German (C, H, B etc.) or Latin (Do, Si, Sib etc.).

Chord spelling: Here you can choose the spelling convention used on the Chord Track.

Appearance: Here you can select between different contrast settings for the user interface.

Default tuning: Determines the default frequency of the reference pitch A4 for newly created 

documents.

Maximum undo levels: Melodyne allows you to undo up to 100 actions. The default value, 

however, is 25. You can, if you wish, increase this value, which will consume more RAM, or 

you may prefer to reduce it, if memory is running short.

Show tooltips: Once you are thoroughly familiar with Melodyne, you may prefer to hide the 

tooltips, i.e. the explanatory text that appears as you move the cursor over the various icons 

and other elements of the user interface.
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The audio cache

On the Audio Cache page of the Preferences dialog you will find the following two options:

Audio cache: This shows the location of the audio cache Melodyne uses for its work.

Audio cache size: This allows you to adjust the size of the cache.

The cache is used to store files Melodyne needs temporarily. The size of the files generated depends 

on the audio files being processed as well as upon the algorithm Melodyne is using for the detection.

If these files are deleted and the Melodyne project that created and was using them is later opened 

again, they have to be recreated, which, obviously, means it takes a little longer to open the project. 

If, on the other hand, the files are still available, Melodyne will just carry on using them as before.

You can adjust the size of the cache. If, when the program is next opened, the cache is full, Melodyne 

frees up space automatically for fresh data.

Please note: The location of the audio cache is predetermined and cannot be altered:

 C:\Users\USERNAME\Documents\Celemony\Separations.Windows:

 /Users/USERNAME/Library/Caches/com.celemony.Melodyne/SeparationsmacOS:

Detect audio after transfer: When this option is selected, the detection (analysis) of the audio 

material does not begin until the transfer is complete, thereby reducing the CPU load during 

the transfer. Select this option if your computer is not especially powerful and there are 

indications during the transfer that its resources are becoming overstretched (e.g. clicks, drop 

outs, extreme slowing-down of the system).
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The Audio and Recording pages of the Preferences property sheet display the following additional 

options:

Audio device: allows you to select an audio driver or the audio hardware driven by it.

Sample rate: determines the sample rate used by Melodyne.

Buffer size: determines the size of the buffer used for audio editing. The smaller the value, the 

lower the latency but the greater the load on the CPU.

Ignore buffer underruns: If Melodyne Stand-Alone is running on a slow computer where the 

possibility of an overload (and an ensuing click or dropout) exists, by checking this box, you 

inform Melodyne that you consider the former to be the lesser of the two evils – the point being 

that audio hardware is often very sensitive to dropouts and can even in such cases cause the 

entire computer to crash. Check the box if ever this happens. Such occurrences are very rare, 

however, and most users can safely ignore this option.

Master output: selects the main output for Melodyne stand-alone. The level at this output is 

controlled by the Master Volume control in the transport bar. If your audio hardware only offers 

one output, this is automatically the Master output

Default input: selects the main input for Melodyne Stand-Alone. If your audio hardware only 

offers one input, this is automatically the Default input.

Audio file format: determines the file format used by Melodyne to store recordings. The most 

commonly used formats are WAV and AIFF.

Shortcuts

From the “Shortcuts” page, you can assign keyboard shortcuts to a large number of Melodyne 

functions and commands. The functions and commands in question are grouped according to 

category; click on the triangle alongside a given category to see a list of all the functions it includes. 

The following screenshot, for example, shows all the commands associated with the editing tools.
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Click on a command (“Pitch Modulation Tool” in our example) and then press the key or key 

combination you wish to assign to it. Melodyne will remember your choice, so any time you press the 

key or combination in question, this will activate the Pitch Modulation Tool. Repeat the procedure for 

as many commands as you like.

To the right of each key combination assigned, you will see an “x”. If you click on this, you can choose 

one of the following functions:
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“Delete”: This cancels the assignment, so it will no longer be possible to invoke the command 

in question using a shortcut.

“Melodyne 5”: This restores the default shortcut for the command in question. (In the case of 

many commands – namely those for which there  no default shortcut – choosing “Melodyne is

5” here will have the same effect as choosing “Delete”).

As an alternative to opening and closing the categories and scrolling through list of commands, you 

can find the command you’re looking for by typing in the  search box. This rapidly narrows left-hand

the choice and can save time. You don’t have to type the entire name of the command; just typing 

“Modulation”, for instance, throws up two search results:

If you change your mind, just click on the “x” in the left-hand search box and the original list will be 

restored in its entirety.

As well as searching by command or function name, you can search for the keys or key combinations 

already assigned; you do this using the  search box. Here, too, an incomplete entry can right-hand

yield multiple search results, which is very helpful in practice.
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For example, suppose you wish to assign a keyboard shortcut to the command that activates the 

Pitch Modulation Tool. In that case, [M] (i.e. the “M” key on its own, standing here for ‘modulation’) 

would appear to be the obvious choice; or, if that key’s already taken, perhaps [Shift] [M]. [M] or [Cmd]

To find out, just type “m” in the right-hand search box, and you will see what your options are:

[M] on its own, as you see, has already been assigned, but the combinations [Alt] [M] [M] and [Shift]

are still available.

You could also combine both fields, like this, for example:

This makes it child’s play to find a suitable shortcut. And, naturally, in our example, you could still opt 

for [M], even though it’s assigned by default to another function; it appears in your filtered list to make 

it easy for you to reassign it, if you choose to do so.

You can save your preferred shortcut assignments as a set and also load custom-designed sets, 

such as those recommended for particular DAWs. To manage all such sets, use the gear/cog menu 

at the top left.
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“… edited”: This shows you which set of shortcuts you are currently using. If it says “Cubase”, 

for example, and nothing more, this means that the set of shortcuts currently loaded is the one 

designed for the Steinberg DAW of that name and that you have not yet modified it in any way. 

If, on the other hand, it said “Cubase (edited)”, this would indicate that, after loading the set 

designed for Cubase, you had made certain changes of your own. In such cases, you might 

wish to save the set under a new name (see below).

“Melodyne 5”: Click here to load the factory default shortcuts for  commands and functions. If all

you do this, any unsaved assignments of your own will be lost.

“Open” and “Save”: These commands allow you to load an existing set of shortcuts or save the 

changes you have made to the hard disk. By saving your preferred shortcut assignments, you 

can take them with you when you change studio and load them into Melodyne there.

When you use the Save function, Melodyne suggests you store your shortcuts in the following folder:

macOS:

/Users/Shared/Library/Application Support/Celemony/Shortcuts/Melodyne5

Windows:

C:\ProgrammData\CelemonySoftwareGmbH\Shortcuts\Melodyne5

The advantage of storing your shortcuts in the folder suggested (give them a name such as 

“MyShortcuts”) is that they will then appear in the list and be readily to hand at all times.

If, on the other hand, you’re travelling to a different studio where you will be working on a different 

computer, you should simply ignore the folder suggested and save your shortcuts to some other 

location, such as a USB stick or your Dropbox folder.
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Check for Updates

On this page, you can determine whether Melodyne checks for updates automatically or manually i.e. 

only when you click the ‘Check Now’ button, which you can do at any time.
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Audio characteristics and algorithms

For the display and editing of different types of audio material, Melodyne employs different 

algorithms. Here, we outline which algorithms are available and for which types of audio material 

each is used.
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The detection process

Melodyne analyzes the audio material to find the notes it contains and offer them to you for editing. 

We call this process “detection”.

In the course of the detection process, Melodyne itself takes a view as to what kind of material it is 

confronted with and decides which algorithm to use for the display and playback of the notes. You 

can tell which algorithm is selected at any given time by the check mark in the Algorithm menu as well 

as by the blobs in the Note Editor. Please bear in mind, however, that the detection process – in 

particular in the case of polyphonic audio material – cannot, for reasons that have to do with 

immutable principles, always deliver perfect results. Since a musically correct analysis of the recorded 

material is the most important precondition for efficient editing and convincing acoustic results, we 

recommend you to check the results of the detection systematically and make whatever corrections in 

Note Assignment Mode are necessary.

A brief overview: Which algorithm for which type of material?

To obtain the most suitable and detailed editing possibilities, for the following sound sources, the 

following algorithms are generally used:

Singing, speech, saxophone, flute, monophonic bass etc.: "Melodic"

Drum and percussion sounds or loops, and other percussive sounds with no significant pitched 

components: "Percussive"

808-kicks and -toms, tabla and similar percussive sounds with a pitched component: 

"Percussive Pitched"

Pianos, strings, organs, guitars and other instruments capable of sounding more than one note 

at a time, where you wish to edit individual notes:  or "Polyphonic Decay" "Polyphonic 

 (depending upon their sound or the playing techniques employed e.g. in the case of Sustain"

strings:  or )pizzicato legato

Rhythm guitars (funky guitars or distorted riffs and similar sounds), where you only wish to 

time-stretch or transpose them and no access to individual notes is required: "Universal"

Loops featuring multiple instruments, or complete mixes, that you wish to time-stretch, 

quantize or transpose: "Universal"

Experimental sound design (regardless of the original sound source): potentially any algorithm 

with extreme settings but primarily  or "Polyphonic Decay" "Polyphonic Sustain"
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The Universal algorithm

The Universal algorithm is particularly suitable for complex signals containing both percussive and 

tonal elements. If, for example, you wish to alter the pitch, timing or tempo of an entire piece of music, 

this algorithm will deliver the best sound quality.

The Universal algorithm, like the Percussive one, displays all the detected notes at the same pitch. 

The Pitch Ruler displays no note names, merely relative values for the semitones, and the scale 

functions are deactivated. The Universal algorithm completes the detection process very quickly and 

also consumes far fewer resources than the Polyphonic algorithm. It represents a good choice, 

therefore for recordings of individual instruments of all kinds that you intend simply to speed up, slow 

down or transpose. Tracks, in other words, for which you do not need bells and whistles such as DNA 

or Melodyne’s scale functions. Please note that with files that have been detected using the Universal 

Algorithm, the Attack Speed Tool cannot be used. Attack speed handles will therefore not be 

displayed for the corresponding blobs and the Attack Speed field in the Note Inspector will be grayed 

out. Please note that “Universal” is never used automatically for the detection; it must be selected 

manually if required.

The “Percussive” algorithms

The  algorithms are suitable for recordings of drums and other percussion instruments "Percussive"

but also noise and atmospheric effects as well as other material in which Melodyne cannot detect any 

clear pitch in the sounds. In this case, successive drum strokes (for example) are distinguished, but 

they are all displayed at the same pitch. The blobs can still be raised or lowered, however the Pitch 

Ruler does not display the names of any notes but simply relative values in semitones. The scale 

functions are deactivated.
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Some percussion instruments, however,  have what can be understood as a melodic capability, in do

that many of their sounds have a perceived pitch. Certain 808 kick drums, for example, are clearly 

tuned to the bass. The berimbau, too, for all the percussive character of its sound, plays recognizable 

melodies – as does the tabla. It is for such instruments – instruments that are in fact percussive yet 

still somehow also melodic – that the  algorithm is intended. Here the detected "Percussive Pitched"

sounds are separated and assigned to individual pitches. This makes it easy to adjust the tuning of an 

808 kick drum, berimbau or tabla to the piece of music in question.

Whilst the Percussive and Universal algorithms are similar in terms of the way the blobs are handled 

and displayed – just as the Percussive Pitched and Melodic algorithms seem similar at first sight – the 

two percussive algorithms in fact operate in a different way internally from their optical “twins”, as they 

are optimized for various aspects of percussive sounds and consequently deliver their most 

convincing sound quality when dealing with material of a predominantly percussive nature. When 

dealing with non-percussive sources, however, such as the human voice, guitars, pianos and so forth, 

they are at a distinct disadvantage compared with the other algorithms, which are optimized for 

sounds with a distinct pitch.

In case of doubt – with instruments seeming to fall (or perhaps alternate) between the stools 

“percussive” and “melodic” – the best policy is to try each algorithm in turn.
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Another distinctive feature of the “Percussive Pitched” algorithm, which it shares only with the 

“Melodic” algorithm, is that Melodyne is able here to detect, display and permit the editing of sibilants. 

With the “Melodic” algorithm, however, this happens automatically, whereas with the “Percussive 

Pitched” algorithm, sibilant control is by default switched off. To switch it on, go to Note Assignment 

Mode and check “Sibilant Handling” in the Algorithm Inspector. You can learn more about this .here

The Melodic algorithm

Melodic material is monophonic, by which we mean it is such that only one note is ever sounding at 

any given instant. Please bear in mind, however, that reverberation can cause notes to overlap even 

in monophonic material, creating, in effect, a kind of polyphony. If melodic material is to be edited in 

Melodyne, therefore, you should aim for as clean and “dry” (reverberation-free) a recording as 

possible.

The blobs representing notes in melodic material are displayed at different pitches. Whether the blobs 

are isolated or joined to other blobs depends on the way they were played or sung: staccato or legato.

The “Melodic” algorithm is predestined for lead vocal tracks, as these are invariably monophonic; for 

there to be polyphony, there would have to be at least two singers. Furthermore, this algorithm takes 

into account the sibilants invariably heard in vocal parts. In the term ‘sibilants’, Melodyne includes not 

only consonants and digraphs such as “s” and “ch”, but also word fragments like “k” and “t” as well as 

the sound of the vocalist inhaling or exhaling between words.

Such sounds, which Melodyne identifies automatically and displays hatched, share one peculiarity in 

nature: There is no way singers can give them a particular pitch, so they remain unaffected by 

melodic changes. This behavior is preserved perfectly by Melodyne’s “Melodic” algorithm: Sibilants 

remain unaltered even when the word or syllable to which they belong is shifted upwards or 

downwards in pitch.
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Let’s say the word is “sweet”, and we move the blob that represents the note in question upwards or 

downwards. Whilst the entire note will appear to move, acoustically this will not be the case as the “S” 

at the beginning and the “T” at the end will sound exactly the same after the pitch shift as they did 

before; only the “wee” in the middle will change pitch – in the direction, and by the amount, of the blob 

movement.

When editing timing, too, you will notice that the sibilants (indicated by the hatching) are never 

unnaturally squeezed or stretched.

This intelligent treatment of sibilants is vital to achieving natural-sounding correction of intonation and 

timing. Melodyne even takes into account the borderline cases that occur in nature, where sibilants 

and pitched components are heard simultaneously (rather than successively, as was the case earlier 

with the word “sweet”).

In Note Assignment Mode, you can edit the results of the detection and  the length of (if need be) alter

the sibilants detected or  sibilant detection for an audio file in the Algorithm Inspector.deactivate
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The “Polyphonic” algorithms

In Melodyne, thanks to DNA Direct Note Access, notes can be detected and edited within recordings 

even of polyphonic instruments such as the piano or guitar – including the individual notes of which 

chords are composed. When the Polyphonic algorithm is used, the blobs are displayed in a similar 

manner to those of monophonic material, with the obvious difference that the blobs are stacked 

vertically (at their respective pitches) whenever a chord or harmonic interval sounds.

There are two versions of the Polyphonic algorithm.

Polyphonic Sustain is suitable for a wide range of polyphonic audio material in which the 

start of each note does not differ significantly from the rest, as is the case with string 

instruments played legato and organ music.

Polyphonic Decay is a variation of that algorithm designed for instruments or playing 

techniques where the start of each note is markedly different from what follows, examples 

being string instruments played pizzicato, guitars and pianos.

Please note that DNA is intended for polyphonic instruments recorded , as it separates notes by singly

pitch – not by instrument. This means that if you were to record two different instruments on the same 

track, whenever they played the same note, a ‘single’ blob would appear (representing the combined 

sound of both instruments) rather than a separate blob for each instrument playing the note.
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Switching algorithms

You can at any time select a different algorithm to that chosen automatically for you by Melodyne. 

You might want to do this, for example, if you find that the material has not been interpreted in a way 

that suits your editing needs. To do this, while playback is halted, select the algorithm you prefer from 

the Algorithm menu. Melodyne will reinterpret the material in the light of your choice and adjust the 

display accordingly.

Note: when you do this, any editing of the same track performed prior to switching algorithms, 

including any copying of notes, will be lost (copied notes on other tracks are retained) . The right time 

to decide which algorithm you wish to use, therefore, is before you begin editing.

In the plug-in implementation of Melodyne, the choice of algorithm applies per transfer, whereas in 

the stand-alone implementation and an ARA DAW, it applies per audio file in the document being 

edited – collectively, we describe all such material as ‘audio sources’. Before you can change the 

algorithm applied to a particular audio source, you must first select one or more notes belonging 

exclusively to it. If you have selected no notes, or notes from two different audio sources, the 

Algorithm menu will be grayed out. In such cases, reduce your selection to notes belonging to one 

audio source only and it will be possible to switch algorithms.

A special feature of the stand-alone implementation: When you switch algorithms, triggering a fresh 

detection, Melodyne looks at the status of the Auto Stretch switch: if the Auto Stretch function is 

activated, once the new detection is complete, the tempo of the file will also be adjusted: if Auto 

Stretch is not selected, the original tempo of the file will be retained.

NB: There is some audio material that cannot be detected using the polyphonic algorithms because it 

contains too few tonal components. If in the case of such material you have chosen one of the 

polyphonic algorithms as the default (see below), the polyphonic detection process will be interrupted 

and a fresh detection of the material using the Percussive Algorithm, which is better suited to it, will 

commence. If you wish in such cases, when this detection is complete, you can still switch to 

Universal or Melodic.

Automatic or manual algorithm selection

By default, Melodyne makes its own determination, based on the characteristics of the sound, as to 

which is the best algorithm to apply, distinguishing between these types of material:

Percussive material, in which case the “Percussive” algorithm is selected.

Monophonic melodic material, in which case the “Melodic” algorithm is selected.

Polyphonic material, in which case, depending upon the audio material, either the “Polyphonic 

Decay” or the “Polyphonic Sustain” algorithm is selected.
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If, however, in an instance of the plug-in implementation of Melodyne or on a track of the stand-alone 

implementation material has already been detected, when new material is transferred to that instance 

or a new file dragged into the track of the stand-alone implementation, Melodyne will use the same 

algorithm for the new material as it used for the old – even if Automatic is selected.

Overruling the Automatic setting in this way is designed to ensure maximum consistency in the 

detection and avoid all risk of one of the transfers from a vocal track suddenly being interpreted as 

percussive. If, however, you have altered the algorithm of a transfer or file manually, the automation 

kicks in again afterwards, and no further attention is paid in the case of further transfers or files to 

already detected material.

This rule only applies when Automatic is preselected as the algorithm and it does not apply when, in 

the stand-alone implementation of Melodyne, you first drag a file into the document for which you 

have already saved additional information regarding the algorithm and note detection. (From Note 

Assignment mode in the stand-alone implementation of Melodyne, it is possible to store this type of 

assignment data in an audio file.)

By setting a different default via the Algorithm menu, you can prevent Melodyne selecting an 

algorithm automatically for the detection. This can be useful if, for example, you regularly want to edit 

particular files using the Percussive algorithm but Melodyne, each time they are opened, is 

interpreting the material as polyphonic. By preselecting the Percussive algorithm in such cases you 

can save time, as you will no longer have to wait needlessly as Melodyne performs its polyphonic 

analysis, only to discard the results moments later when you manually select the Percussive 

algorithm.
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Do not forget, however, when you no longer need to impose your choice of algorithm on Melodyne, to 

restore Automatic as the default setting. Otherwise, since Melodyne remembers your default selection 

even after you have quit the program, you might be surprised to discover when the program is next 

launched that your vocals have been interpreted as percussive.

You will find further tips on working with these algorithms in the  section.Melodyne Training
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Note Assignment Mode

Since Melodyne invariably conducts an analysis (we call it “detection”) of the audio material before 

you can do any editing, the correctness or otherwise of this analysis has a considerable influence 

upon how well you are able subsequently to work with the material and how authentic the results of 

your editing will sound. For this reason it is important to check whether Melodyne has identified the 

notes within your material accurately and if necessary correct any mistakes. This where Melodyne’s 

Note Assignment Mode comes in.
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What editing the detection involves

When you are working in Note Assignment Mode, none of the changes you make has any audible 

effect on the notes themselves. All you are doing is ensuring that the notes that are displayed do 

actually correspond to those that were played or sung. In other words, you are bringing what you see 

into line with what you hear. In the process, you are working at all times on the display of the original 

recording and, with it, so to speak, on the basis for all musical changes made later with Melodyne. 

The sounder the basis, the better the eventual sound of your edits.

The fact that it is sensible and necessary to check and edit the detection and, with it, the 

interpretation of the audio material may seem tiresome at first sight. But it brings with it enormous 

advantages, for there are often several possible interpretations of the audio material, and which is the 

correct one in a given acoustic and musical context is for you, ultimately, to decide.

But don’t worry. The detection process in Melodyne is mainly automatic and delivers logically 

coherent results. How much there is to edit in this mode depends upon the algorithm used and the 

audio material in question. With a dry recording of a single vocalist, for example, you will very rarely 

encounter problems. It may happen from time to time that a note is detected in the wrong octave, in 

which case, if you later transpose it, it will sound unnatural. Correcting the detection in such cases is 

a task swiftly accomplished. The same goes for percussive material, where it is generally only 

necessary to introduce or remove the occasional note separation.

It is the detection of polyphonic material, naturally, that requires the most fine-tuning in Note 

Assignment Mode. Here the issues are more complex, and plausible interpretations more abundant, 

than with the other algorithms; though, once again, the amount of editing required is chiefly 

dependent upon the nature of the audio material. Thanks to their clear overtone structure, notes 

played on a xylophone, for example, are far easier to detect accurately than any found on a distorted 

guitar track. This is because, in the latter case, the array of overtones is more complex, and assigning 

them to the correct notes (i.e. to the fundamentals to which they belong) is more difficult. With such 

signals, it can also happen that a particularly prominent overtone is mistaken for a fundamental i.e. it 

is interpreted as a note in its own right, when in fact it is merely the by-product of a lower note. If this 

mistake is not corrected and you later shift the pitch of the overtone only (leaving that of the 

fundamental unchanged), the two components will clash and sound unnatural.

The overtone example illustrates clearly why in certain cases Melodyne cannot have 100% 

confidence in its decisions, why it cannot always know with certainty which notes were and were not 

played. In Note Assignment Mode, therefore, the object is to establish an exact, one-to-one 

correspondence between the notes displayed and those that were actually played. The payoff comes 

later, when you begin editing, as the Note Editor then will display only the correct notes and your 

editing will deliver the most authentic-sounding results possible.
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What is edited and where

Like the choice of algorithm, Note Assignment Mode applies invariably to all the notes of i) a 

particular audio file, ii) a particular recording, or iii) a particular transferred segment – we will use the 

term “audio source” to cover all three. When the Note Editor contains notes from different audio 

sources, begin by selecting a note belonging to the source the detection of which you plan to edit.

Now click the wrench (spanner) icon next to the toolbox of the Note Editor to activate Note 

Assignment Mode. The background in the Note Editor changes color to show that you are no longer 

in normal Edit Mode but have switched to Note Assignment Mode. In Note Assignment Mode, what 

you see and hear is the original state of the audio source; any editing you may have performed on it 

previously is ignored here.

Any time you click on the blob icon (to the left of the wrench), you will leave Note Assignment Mode 

and return to Edit Mode. There you will hear once again the results of any editing you performed 

before switching to Note Assignment Mode. This only applies, however, if you have not changed 

algorithm in Note Assignment Mode, as any change of algorithm triggers a fresh analysis, and any 

time you trigger a fresh analysis – any time, in other words, the detection process is repeated – all 

editing that has been performed on the notes previously is lost.

Various types of notes

A Melodyne “blob” represents a note, but Melodyne distinguishes between several types of note, and 

it is important – especially when you are working in Note Assignment Mode – to understand the 

difference between them. They are:

active notes

inactive/potential notes

silent notes.
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Most blobs represent . These are what Melodyne, having carefully analyzed the active notes

recording, believes to have been the notes (i.e. the fundamentals) that were actually played or sung. 

Active notes correspond to the notes that would be displayed on the sheet music: here a D, here an 

F#, here another D or an A etc. As well as a definite pitch, active notes have a definite length; and 

naturally, you can alter these and other characteristics of the notes in Melodyne.

When the Melodic algorithm is used, only one note can ever be active at a time; that is because this 

algorithm is the one designed for monophonic sound sources (the human voice, say, or an instrument 

such as the clarinet or trumpet that is only capable of playing one note at a time). With the polyphonic 

algorithms, which are designed for instruments like the piano or the guitar that are capable of playing 

chords, or multiple melodic lines simultaneously, two or more notes can be active at the same time, 

with a separate blob assigned to each. When the audio material has been analyzed using the 

Percussive or Universal algorithms, however, all the notes of a chord are represented by a  single

blob. So it is better, with these two algorithms, to think of a blob as representing a “slice of time” 

rather than a musical note. To illustrate the difference, here we see a guitar chord detected (on the 

left) using the Polyphonic algorithm, and (on the right) using the Percussive one:

From the blobs on the left, you can see exactly which notes comprise the chord. From the “time-slice 

blob” provided by the Universal algorithm, on the other hand, it is impossible to tell which, or even 

how many, notes comprise the chord.
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In terms of their editability using the tools, there is not a great deal of difference between the ordinary 

blobs provided by the Polyphonic algorithm and the Universal algorithm’s time-slice blobs – except, 

that is, when it comes to editing chords: When represented by a time-slice blob, a chord can only be 

transposed ; so a chord of F major, for example, could become G major or A major. In other en bloc

words, the intervals  the various notes that make up the chord cannot be changed because between

all the notes hidden behind the (single) time-slice blob move exactly the same distance when the 

chord is shifted upwards or downwards. With the Polyphonic algorithm on the other hand, a separate 

blob is assigned to each of the notes that make up the chord and you can move each blob individually 

– perhaps in a different direction and/or by a different amount to the blobs above or below it. In this 

way you can turn an F major into an F minor – or any other chord you like.

Melodyne’s  form our next category.potential notes

Represented by outlines (or “hollow silhouettes”), they lie at pitches where Melodyne thought about 

drawing a regular, solid blob, but decided in the end to place this somewhere else, leaving the 

silhouette as a hint at to what might be a possible alternative for that particular note.

So you might consider turning this potential note into a regular note. This, you can only do in Note 

Assignment Mode, so it is only in Note Assignment Mode that you will ever see a hollow silhouette. 

Once you return to normal edit mode, only solid blobs (representing the active notes) appear in the 

display. It should be added that potential notes are only ever encountered with the Melodic or 

Polyphonic algorithms.

Finally, there are what Melodyne calls . These can be seen in both Note Assignment and silent notes

normal Edit Mode, regardless of which algorithm is used to detect the material. A silent note appears 

wherever there is a break between two notes; it corresponds, therefore, to a rest or pause in the 

score.
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Like a rest, then, it has a definite length but no pitch, so you cannot transpose silent notes. Their 

length, however, will change if the notes that precede them are shortened or lengthened, or if the 

notes that follow them are moved forwards or backwards in time, in the same way that an eighth note 

(quaver) rest in the score would become a sixteenth note (semiquaver) rest if the preceding note 

were lengthened, or the following note moved forward, by the same amount.

Silent notes are not in fact  silent, because even during breaks between normal notes the entirely

recording continues, picking up things like the hiss of the microphone preamp or the hum of the guitar 

amp, but they are generally far quieter than the notes around them.

Here we see three notes: an active note, followed by a silent one, followed by another active one:

This illustrates the two significant visual characteristics of the silent note: i) it has no Pitch Curve; and 

ii) it is always placed level with the note to the left of it; if you shift the latter up or down, the silent note 

moves with it, but the change is purely visual; whatever sounds the silent note represents remain 

unaltered.

It is when you come to use the tools in Note Assignment Mode that a clear understanding of the 

nature and behavior of the various types of note found in Melodyne will pay the greatest dividends. 

That is the subject of the next tour. You will also learn there how to transform silent notes into normal 

ones – as well as silhouettes into solid blobs and vice versa, thereby activating and deactivating, 

respectively, the corresponding notes.
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Tools for note assignment

The Main Tool in Note Assignment Mode

In Note Assignment Mode, the toolbox contains tools with functions other than those used in normal 

Edit mode. The most important difference is this: In Note Assignment Mode, the tools have no direct 

or immediate impact on the sound of the notes; their object, rather, is to bring the detected and 

displayed notes as closely as possible into line with the actual music. This makes it possible 

subsequently to edit the material more efficiently and obtain optimal acoustic results.

Which tools are available depends upon the algorithm, as, to a lesser extent, do their functions.

As is the case in normal editing mode, the Main Tool in Note Assignment Mode combines a number 

of the most important functions of the other tools, so as to allow you to perform a variety of common 

tasks without having to change tools.

In the lower part of a blob, the Main Tool functions as the .Activation Tool

In the upper part of a blob, the Main Tool functions as the .Note Separation Tool

We will deal with each of these in turn.

The Activation Tool

The Activation Tool has no function when the Percussive and Universal algorithms are selected. What 

follows, therefore, only applies when either the Melodic, the Percussive Pitched or one of the 

Polyphonic algorithms is selected.

If you move the Activation Tool over a blob, its overtone series will be displayed in the background. 

This enables you to see at a glance which of the blobs above it coincide in pitch with the partials of 

the note selected.
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In addition to the normal solid blobs used in Melodyne to represent notes, you may see hollow blobs 

of which only the outlines or “silhouettes” are visible. These represent what we call “potential notes” 

and lie at pitches where Melodyne considered drawing a regular, solid blob, but decided instead to 

place this at a different pitch, leaving the silhouette as a hint that this might be a possible alternative 

for that particular note.

So you might consider turning this potential note into a regular note. This you can only do in Note 

Assignment Mode, so it is only in Note Assignment Mode that you will ever see a blob silhouette. 

Once you return to normal edit mode, only solid blobs (representing the active notes) appear in the 

display. It should be added that potential notes are only ever encountered when the Melodic or 

Polyphonic algorithms are employed.

In the case of polyphonic instruments, these inactive/potential notes play a particularly important role, 

because Melodyne may occasionally mistake for a note that was actually played what was in fact 

merely a particularly prominent overtone of some other note and, as a result, display it as a solid blob. 

Since your objective in Note Assignment Mode is to ensure that only the ‘fundamentals’ (the notes 

that were actually played or sung) are represented by solid blobs, your first task in such a case will be 

to replace that solid blob with a silhouette – i.e. to deactivate the note in question.

The opposite situation can also arise: If a note is played very quietly, Melodyne may mistake it for the 

overtone of some lower note, in which case it will not display it as a solid blob but as a silhouette. In 

this case, you will need to replace that silhouette with a solid blob – i.e. activate the note in question.

Double-click on a silhouette and it will be replaced by a solid blob, indicating that the note in 

question has been activated.

Double-click on a solid blob and it will be replaced by a silhouette, indicating that the note in 

question has been deactivated. Each time a note is deactivated in this way, the spectral energy that 

was originally assigned to it is distributed between the remaining (active) notes sounding at that time. 

So when you deactivate an overtone that has mistakenly been displayed as one of the notes played, 

its spectral energy will be correctly reassigned to the note to which it properly belongs.

Of course, if you deactivate all the blobs corresponding to notes sounding at a given moment in time, 

Melodyne has no note to reassign their spectral energy to, so in place of the deactivated blobs it 

creates a silent note. The same principle applies when there is only one note sounding. Such is 

always the case when either the Melodic or the Percussive Pitched algorithm is used; but even with 

the polyphonic algorithms, in a melodic passage (in which no more than a single note is ever 

sounding at a time), any note you deactivate will automatically be replaced by a silent note.

Deactivating all the notes, or the only note, sounding at a given instant (leading to the creation of a 

silent note) only makes sense, of course, if the instrument in question is meant to be silent at that 

time (e.g. where there’s a rest in the score). Silent notes – what distinguishes them, how they arise in 

nature, and how they behave in normal edit mode – are described in greater detail .here
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Dragging blobs with the Activation Tool

A double-click is the gesture you will use most often when working with the Activation Tool. It is also 

possible, however, to drag blobs with it, as a means of persuading Melodyne to move the focus of its 

search to a different area. Particularly with material in which pitches are unclear, a new note can (in 

theory) be assigned to almost any pitch in this way, provided Melodyne finds something there. This is 

especially true when the option “Robust Pitch Curve” has been activated in the Algorithm Inspector.

In the case of the polyphonic algorithms, you have to drag a blob about an octave downwards to 

trigger the search for a new pitch. The new note will then in all probability appear an octave below the 

previous one.

If Melodyne finds a plausible destination for the note in the area to which you have dragged it, the 

blob will snap to it; otherwise, it will fall back to its original position. Melodyne only considers certain 

pitches to be plausible. This is one of the strengths of Melodyne: It brings to its analysis of the audio 

material real musical intelligence, and does not therefore automatically ascribe every cluster of 

spectral energy to the presence of a separate note. So, having eliminated all the pitches at which the 

note played could not possibly lie, Melodyne is left with a handful of candidates it considers 

“plausible” and invites you to choose between them.

Alt-dragging with the Activation Tool

With polyphonic material, however, you can tell Melodyne what it should, and should not, consider a 

plausible pitch. If, for instance, all attempts to drag the blob to the desired pitch have failed (because 

Melodyne does not consider the pitch in question to be plausible), just hold down the [Alt] key and 

drag the blob to the target pitch yourself. This allows you to “force” the blob to a position with a 

straight pitch curve.

If you hold down the [ALT[ key, you can drag blobs in either direction – upwards or downwards – 

even with the polyphonic algorithm.

Recalculation of the pitch center

When you move notes with the Activation Tool, a fresh search for the Pitch Curve within the note is 

conducted automatically, but this only occurs when one of the monophonic algorithms is selected.

While conducting the new search, Melodyne also recalculates the pitch center of the note. It does this 

even if you have only moved the blob a very short distance before returning it almost immediately to 

its original position. You can also trigger a fresh search for the Pitch Curve and a recalculation of the 

pitch center by holding down the [Alt] key and double-clicking – for instance, after activating or 

deactivating the option “Robust Pitch Curve” in the Algorithm Inspector.
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This is particularly useful when you are importing a file from an older version of Melodyne, as the 

technology Melodyne 5 uses to determine the pitch center of notes is greatly superior to that of earlier 

versions. After the recalculation (most swiftly triggered by holding down the [Alt] key and double-

clicking), the blobs will be realigned slightly on the vertical axis – some higher, some lower than 

before – with the results representing the musical content better than those of earlier versions of the 

program. This provides for better results – especially when you are quantizing pitch by double-clicking 

or using the Correct Pitch macro in normal edit mode.

If, on the other hand, the original detection was performed by Melodyne 5 itself, recalculating the pitch 

centers will change nothing, as the results – already optimal – will be no different the second time. 

The only circumstance in which [ALT]-double-clicking in Note Assignment Mode makes a difference is 

when the option “Robust Pitch Curve” is checked in the Algorithm Inspector. This option is discussed 

in greater detail .here

The slider and the Energy Image

When you are editing the detection of polyphonic audio material and have selected the Main or 

Activation tools, you will see a slider next to the toolbox. This allows you to determine the number of 

potential notes to be displayed and how many actual notes are derived from them.

If you move the right-hand indicator (the “Parenthesis”) in the slider to the left, fewer potential notes 

will be displayed. If you drag it to the right, more potential notes will appear. Choose a setting that 

ensures that only as many potential notes are displayed as you may conceivably wish to activate in 

the course of the subsequent editing. That will give you a clearer overview.
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Now drag the left-hand indicator (the “Ball”) from side to side. As you drag it to the left, you reduce the 

probability of the potential notes displayed becoming active notes, thereby reducing the number of 

active notes. As you drag it to the right, you increase that probability, thereby creating more active 

notes from the potential notes displayed.

There can never be more active than potential notes, so the Ball can never pass through the 

Parenthesis but merely pushes it to the right when it wants to go further, thereby causing additional 

potential notes to be displayed and activated simultaneously. Adjust the two indicators until the 

number of active notes displayed is as close as you can get to the number of notes that were actually 

played. Then proceed to the manual correction of individual notes.

Tip: If you move the indicator a long way, Melodyne is required to do a great deal of processing, 

which is why it can take a moment to display the results. You can reduce this delay by opening the 

Algorithm Inspector and, under the heading “Separate Audio”, clearing the checkmark next to “Auto”. 

This speeds up the display, but if you wish then to hear the result of the redistribution of the signal 

components between the notes, you have to click on the flashing “Now” button or activate the “Auto” 

option once more.

Now and then, it can happen that a note that can be heard in the material is not detected as an active 

note, and, even with the Parenthesis at its maximum setting, is not even shown as a potential note. If 

that happens, move the Parenthesis fully to the right (to its maximum setting) and then move the 

mouse pointer over the position in the Note Editor where the missing note ought to be. Around the 

mouse pointer, in the form of an “energy image”, notes will now appear that were detected neither as 

active nor as potential notes. When you have identified the missing note in this way, double-click on it 

to transform it into an active note. Thereafter, by subsequent double-clicking, you can toggle the 

status of these notes between “potential” and “active” just like that of any others.
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The Venetian Blinds

With instruments in particular that generate powerful overtones, it can happen that over a wide range 

notes are detected that you perfectly well know are far higher (or lower) than any that were actually 

played. In such cases, the Venetian Blinds come in handy; if you can’t see them at the top or bottom 

of the editing area, scroll upwards or downwards until you can.

You can raise or lower the top blind by dragging its thick bottom edge and do the same with the top 

edge of the bottom blind, in this way delimiting the range within which Melodyne assigns notes. All 

notes partially concealed by the Venetian Blinds are automatically deactivated unless they have 

previously been activated by hand. You can still “reach through” the Venetian Blinds, however, to turn 

notes on or off. The Venetian Blinds provide a useful first approximation that you can later correct by 

activating and deactivating notes singly by hand.
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Starting point lines and designated starting points

If, in Note Assignment Mode, you select one of the separation tools, vertical lines appear in the Note 

Editor. At the same time, a slider with two indicators appears next to the toolbox.

We call the vertical lines “starting point lines”. Rising in parallel from their respective blobs to the Time 

Ruler, they show the  that Melodyne has identified in the audio file. A musical starting points

“designated starting point” is indicated by a short vertical line (a “vertical”) topped by an inverted 

triangle and is invariably found near the start of a blob (though not necessarily at its leftmost 

extremity); when active, it indicates what, for the purposes of timing, Melodyne considers to be the 

effective musical starting point of the note. The musical starting point may, but does not necessarily 

have to, be aligned with the separator at the beginning of the note. Think of a brass instrument, for 

example, where each note is often heralded by a certain amount of wind noise. This noise also 

belongs to the note, so it falls to the right of the note separator. What is relevant from the standpoint 

of timing, however – as is the case also with quantization – is the moment when the sound really 

unfolds and the pitch first becomes discernible;  is the timing-critical moment, and it is that later that

instant that is designated the musical starting point. If Melodyne is unable to pinpoint the musical 

starting point of a note, no starting point line is displayed and the note has no designated starting 

point. For the purposes of quantization, the leftmost extremity of the note is then considered to be the 

starting point.

http://helpcenter.celemony.com/M5/?lang=en&startPageEdition=melodyne-studio
http://www.celemony.com


Melodyne 5 studio - Live 12.0

   © Celemony Software GmbH 2024 • Last updated on 06/19/2024 • Help Center • www.celemony.com 93

Each of the longer, starting point lines also culminates in an inverted triangular indicator, which you 

will see just below the Time Ruler. This indicator can be solid, in which case the corresponding 

starting point line is visible and active; or it can be hollow, in which case the line is invisible: we call it 

in this case a “potential” or “inactive” starting point line. An inactive starting point line invariably 

coincides with the beginning of a note. For the note in question, however, Melodyne has been unable 

to discern with sufficient confidence a musically relevant starting point; it is for this reason that the 

starting point line is only a potential one and that no vertical (no designated starting point indicator) is 

displayed at the blob.

The two slider indicators, the Parenthesis and the Ball, govern, respectively, how sensitive Melodyne 

is to the presence of potential starting points and how willing it is to activate them, the result being 

reflected in turn by the total number of triangles displayed and the percentage of these that are solid 

red. As you move the Parenthesis gradually to the right, more and more hollow triangles (indicating 

the presence of “potential” starting points) appear beneath the Time Ruler; this reflects Melodyne’s 

increasing sensitivity that is allowing it to divine more and more points in the material at which a 

starting point  reside – “might” because the lines that are added remain invisible and do not (yet) might

have any effect upon the blobs.

You can alter this, however, with the slider’s second indicator: the Ball. As you move the Ball to the 

right, more and more of the previously invisible, “potential” starting point lines will become active; and 

directly below them, at the level of the blobs, designated starting points will appear at the same time.

You can activate a potential starting point line by double-clicking on the hollow triangular indicator 

beneath the Time Ruler and, conversely, deactivate an active line by double-clicking on the 

corresponding solid triangle. Double-clicking in a free place in the ruler generates a new starting point 

line.
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By dragging its indicator, it is possible to move a starting point line forwards or backwards in time; 

this, however, will seldom be necessary, as Melodyne almost invariably identifies the ideal position. 

You may still wish, though, to do some fine-tuning. If, for the purposes of experiment, you move a 

starting point line from left to right, you will notice that as soon as you pass over the start of a blob, a 

vertical appears complete with inverted triangle (indicating the presence of a designated starting 

point) that follows the line for a while before disappearing as soon as the note begins to decay, as, 

clearly, it would be futile to look any further for the musical starting point.

Starting point lines exhibit a kind of “magnetic” property seen not only when you move them but also 

when separating notes and designating starting points manually.
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The Note Separation Tool and the Separation Type Tool

The Note Separation Tool and the Separation Type Tool (directly below it in the toolbar) are available 

with all algorithms and function in the same way as their counterparts in Edit Mode. You can set or 

remove note separations by double-clicking and also move them along the time axis. With the 

Separation Type Tool, you can toggle between hard and soft separations.

By contrast with normal editing mode: In Note Assignment Mode, the separation tools are not used to 

reshape the music but to edit the analysis or “detection”. The object is to ensure that the blobs 

represent as accurately as possible the actual music. Also, edits performed in Note Assignment Mode 

on chords are implemented, thanks to the magnetic quality of the starting point line, with sample 

accuracy. In normal Edit mode, this is not possible. Tip: To provide two or more notes of differing 

pitch with a soft separation, you can select “Convert Selection to Connected Sequence” from the 

context menu (see below).

Since the placing of note separations and the editing of starting points often go hand in hand, you can 

also edit starting points with the Note Separation Tool. Simply move the pointer into the vicinity of the 

triangular starting point markers near the Time Ruler and it changes appearance to resemble the 

Starting Point Tool.

It is possible at any time to deactivate a designated starting point (i.e. withdraw the designation). A 

new starting point can only be designated if an active starting point line is present in a plausible place 

i.e. the left-hand end of a blob. Look for a moment at the starting point indicators: In the relevant 

place, a hollow triangle (indicating the presence of a potential starting point) will probably already be 

displayed. Double-click on the triangle to activate the starting point line.

http://helpcenter.celemony.com/M5/?lang=en&startPageEdition=melodyne-studio
http://www.celemony.com


Melodyne 5 studio - Live 12.0

   © Celemony Software GmbH 2024 • Last updated on 06/19/2024 • Help Center • www.celemony.com 96

If no potential starting point line has been identified at the desired position, using the slider near the 

toolbox you can cause additional potential starting point lines to appear: to do this, simply move the 

right-hand control element (the Parenthesis) further to the right.

Alternatively, by double-clicking on an empty area of the ruler at the level of the starting point 

markers, you can create a new starting point line and drag it into position with the mouse. If, in the 

case of polyphonic material, a chord appears at the corresponding position, the action will affect all 

chord members. When, with the Melodic, Percussive or Universal algorithms selected, you activate a 

potential starting point line or create a new starting point line, a note separation is automatically 

inserted near a note at the position in question.

Tip: When editing starting point lines, if ever you have the feeling that somewhere a note starting 

point exists but that it is not indicated even by a potential starting point line, scrubbing in the relevant 

area often makes it to easier to locate the exact position. At the position in question, a rather loud 

noise component will be audible. Where the noise is loudest, release the mouse button and double-

click to place a starting point line.

The context menu: When you select one of the note separation tools, a context menu appears in the 

Note Editor in which you will find the following commands:
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Convert Selection to Connected Sequence: With this command, you can convert a selection 

comprising two or more adjacent notes between which there are hard separations into a 

connected sequence with soft separations. This is also possible with notes differing in pitch 

and allows you gather together melodic lines to make more coherent editing possible later.

Separate Note: This command separates a note automatically at a point determined by 

Melodyne. It is useful when you need to make precise cuts in a vocal passage and isolate 

sibilants or breathing noise prior to editing using the tools.

Reseparate Notes at Starting Point Lines: This command splits the selected notes at all active 

starting point lines passing through them. It offers you, therefore, a convenient way of inserting 

separations at the same point in multiple notes simultaneously, while removing any 

superfluous separations found elsewhere.

Separate Notes as Trill: The effect of this command is to slice a selection of one or more notes 

into smaller segments determined by the instantaneous pitch of each note. This is done by 

inserting note separations into the slopes of the pitch curve as it rises and falls, thereby turning 

each ‘hill’ and each ‘valley’ of a vibrato into a separate note.

Please note that the fluctuations in the Pitch Curve must be fairly pronounced for the “Separate Notes 

as Trill” function to have any effect and that it is only available when the Melodic algorithm is active, 

being grayed out in every other case. If you wish to assign a shortcut to the command “Separate 

Notes as Trill”, this can be done using the Preferences dialog.

Reset Separations Based on the Selected Grid: This command separates the notes at obvious 

starting points as well as at suitable positions on the selected Time Grid. This command is 

available with the Melodic, Percussive and Universal algorithms.
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The Starting Point Tool

The Starting Point Tool is the second sub-tool of the Note Separation Tool.

It is available with all algorithms and is used to designate or undesignate starting points manually by 

double-clicking. This tool function is also available in Note Assignment Mode by checking the 

corresponding option in the Note Inspector. A designated starting point is indicated by a vertical (i.e. a 

short vertical line) with a red triangle on top located at or near the leftmost extremity of the blob.

By moving the Starting Point Tool in the region of the starting point markers beneath the Time Ruler, 

you can also edit these with the Starting Point Tool. As a rule, however, you will generally use the 

Note Separation Tool for this purpose, as described above.

The Sibilant Range Tool

Melodyne defines as “sibilants” all components of the sound that have no detectable pitch curve. In 

the case of vocals, these include not only fricative consonants and digraphs such as “s”, “z”, “ch” and 

“zh”, but also other unvoiced consonants such as “k” and “t” as well as the sound of the vocalist 

inhaling or exhaling between words. When the various pitch tools are used, these components are 

treated differently from the pitched components – a policy that leads to particularly good and natural-

sounding results when editing vocal tracks. For Melodyne to detect the presence of sibilants, either 

the Melodic or Percussive Pitched algorithm must be active.

Sibilants are detected, and their extent ascertained, automatically; but, if need be, you can overrule 

Melodyne and move the start and end points of sibilants at will. This is done in Note Assignment 

Mode using the Sibilant Range Tool.
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When this tool is selected, the range of the sibilants detected by Melodyne is represented on the 

display by hatching. A sibilant might lie at the beginning and/or end of a note, but never in the middle. 

The tool has the following functions:

Click and drag the edge of the hatched area to extend or shorten the range of the sibilant in 

question.

Double-click on the hatching to remove it. (This instructs Melodyne to treat the sibilant in 

question the same way it treats all other components of the sound, which would allow you to 

apply radical pitch shifting to a “S”, for example, as a special effect). If multiple blobs are 

selected at the time of the double-click, all their sibilants will be declassified in the same way.

Double-click on a note without any hatching (or from which the hatching has been removed): 

this instructs Melodyne to search the note for sibilants. Depending upon the note, one of the 

following states will result:

- Melodyne will find a sibilant at the beginning and/or end of the note and display its extent through 

hatching. Sometimes the entire blob will be hatched (e.g. in the case of breath noise). It makes no 

difference in the case where exactly in the blob you click; towards the beginning, towards the end, the 

result is the same. This case in fact only occurs if you have previously declassified any sibilants it 

contains by double-clicking. Melodyne will then rediscover the sibilants when you double-click a 

second time.

- If the note represented by the blob is in fact sibilant-free (i.e. it contains no sound components that 

Melodyne regards as sibilants), but you wish it to be treated as though it did contain them, the effect 

of the double-click is to create a sibilant range at the point clicked. To be more exact: if you double-

click with the tool on the front half of the blob, the sibilant range will extend from the start of the blob 

to the point clicked. If you double-click in the second half of the blob (i.e. right of center), the range 

will extend from the point clicked to the end of the blob. You can also do both: create a sibilant range 

at the start of the blob and then another at the end, or vice versa.

Tip: To check the boundaries of the hatched area acoustically, use the “Sibilant” preview control in 

the Algorithm Inspector. With the control at the extreme right setting, you will hear only the hatched 

area of the note; at the left extreme, you will hear only the part of the blob without the hatching.
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The Energy Share Tool

This tool is only available with the Polyphonic Sustain and Polyphonic Decay algorithms. It regulates 

the distribution of particular sound components among notes sounding simultaneously.

In the case of chords or certain harmonic intervals (e.g. an octave), the same overtone might be 

shared by two or more fundamentals, so Melodyne is obliged to share it out among the notes 

concerned. It may be that the resulting distribution is not to your liking, in which case you can exert a 

healing influence: By assigning more energy to one fundamental (at the expense of the others), you 

enrich its harmonic content, giving it, generally, a brighter sound with greater penetration. Conversely, 

you can deprive a fundamental of some of its energy (to the benefit of the others). In this way, you 

can adjust the tone color of the various notes to achieve the ideal balance.

Please note that this tool, by its very nature, only has any effect when two or more notes sounding 

simultaneously have been detected in polyphonic material and one of them is being edited. 

Furthermore, only as much energy can be shared as is actually present at the place in question and 

available to the blob in question. With this tool, you are therefore to some extent entering a desired 

value. How and to what extent it can be attained depends upon the realities of the audio material.

In the extreme case, the tool does ... nothing. If you have two notes sounding simultaneously, for 

example, the higher of which does not appear in the overtone series of the lower (you can see 

whether or not this is the case by using the Activation Tool to display the overtone series), then these 

two notes have no shared energy that could be reassigned using the Energy Assignment Tool. In 

such cases, therefore, the tool has no effect whatsoever, whether visual or acoustic.

Click with this tool on a blob and drag upwards to increase its allocation of energy or downwards to 

reduce it.
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The Note Inspector

As is the case in normal edit mode, the Note Inspector in Note Assignment Mode governs the 

selected notes – only here, different parameters are on view.

Pitch: The three fields correspond to those in edit mode and display i) the nearest note of the 

chromatic scale, ii) the deviation (if any) in cents from it, and iii) the equivalent frequency in hertz. It is 

not possible to input values into these fields but their content is updated whenever a blob is assigned 

to a different pitch (e.g. to correct an octave error).

   The inspector field reflects the changes made with the Energy Share Tool as well as Energy share:

allowing you to enter values directly.  

 The status of this field is determined either by changes made with the Separation Hard separation:

Type Tool or by checking/clearing the box. You can only check this box if there is currently a soft 

separation between the selected note and an adjacent one.

Starting Point: The status of this field is determined either by changes made with the Starting Point 

Tool or by checking/clearing the box. Here, just as with the corresponding tool, you can attach the 

selected note to a starting point line or detach it from it.
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The Algorithm Inspector

The Algorithm Inspector in Note Assignment Mode offers you a number of options that allow you to 

adjust and optimize the way the selected algorithm operates to suit the audio material to be edited.

Whenever Note Assignment Mode is active, the Algorithm Inspector is available in the info pane.

Algorithm: The pop-up button at the top shows the current algorithm. With the menu displayed, you 

can select a different algorithm from the list, thereby triggering a fresh analysis. Warning: Any time 

you switch algorithms, all editing previously performed on the audio source in question is lost! For this 

reason, you should make a habit of checking to make sure the best algorithm has been selected and, 

if this is not the case, choosing a more suitable one  you begin correcting the analysis or before

editing notes.

 

The Preview parameters

In the Preview section, you will find the following important options to assist you with the editing of the 

detection and the fine-tuning of the algorithm parameters.
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Synth: The objective in Note Assignment Mode is to ensure that the notes displayed really do match 

the notes intended and played. Since, however, in Note Assignment Mode you are listening to the full 

original sound of the audio file you plan to edit and editing of the blobs has no audible effect, 

determining whether notes have been correctly detected is generally only possible on a visual basis. 

This is where the Monitoring Synth comes in: Using a synthetic tone generator, the Monitoring Synth 

plays the blobs exactly as they appear, thereby providing you with acoustic as well as visual 

feedback. You can toggle the synth on and off by clicking on the “Z” icon; click and drag upwards or 

downwards to control the volume. The Monitoring Synth is not available when the Percussive or 

Universal algorithms are selected.

Tempo, Pitch and Formants: With these three controls, you can “simulate” changes to the 

corresponding parameters in order to examine their effect upon the current algorithm settings. 

Example: you have changed the formant character in the Algorithm Inspector. This change, however, 

has no effect until you shift the formants in normal edit mode, as in Note Assignment Mode you 

always hear the original state of the audio source. You would have, therefore, to leave Note 

Assignment Mode, shift the formants by way of experiment in normal edit mode, and then return to 

Note Assignment Mode if you felt any further adjustment to the formant character was necessary. The 

preview controls make such a procedure unnecessary: simply turn the formant control, and you can 

begin at once experimenting with the character slider without ever leaving Note Assignment Mode. 

The tempo and pitch controls operate much the same way. The values of all three preview controls 

only apply temporarily and are reset each time you leave Note Assignment Mode.

NB: When the synth is in use, the controls for pitch and formants are grayed out, as they cannot be 

used simultaneously.

Sibilance: With this control, you can simulate the effects of the Sibilant Balance Tool. This is useful 

when your intention is to modify a sibilant range in Note Assignment Mode, as it allows you to hear 

exactly where the sibilant in question begins and ends. With the Sibilant Preview Control slider at its 

rightmost extreme, you hear only the sibilant; at its leftmost extreme, it is the other way around: you 

hear everything  the sibilant areas. If you then notice that a sibilant is still sounding in a pitched except

zone, or pitched components in a sibilant zone, you know that the boundaries of the sibilant range are 

not perfectly drawn.

The Algorithm parameters

The other parameters in the Algorithm Inspector relate to the behavior of the algorithm, allowing you 

to fine-tune it for the entire audio source.

http://helpcenter.celemony.com/M5/?lang=en&startPageEdition=melodyne-studio
http://www.celemony.com


Melodyne 5 studio - Live 12.0

   © Celemony Software GmbH 2024 • Last updated on 06/19/2024 • Help Center • www.celemony.com 104

Playback Type: Melodyne applies two different processes for the playback of audio. The Melodic 

Algorithm employs as standard the playback type “Tonal”, whilst the other algorithms favor 

“Complex”. These choices are generally the best in practice but you can override them here if you 

wish.

The difference is most noticeable when time stretching is performed (and also when notes are 

transposed upwards): material with clearly recognisable pitches generally sounds better with the 

“Tonal” option. For material in which the pitch of notes is not clear and where noise components are 

more in evidence better results are generally obtained with “Complex”. Experimenting with the two 

playback types is therefore most useful when material falls between these two stools. Experiment with 

the tempo and pitch preview controls to see which playback type is best suited to your needs. Please 

note, however, that if “Tonal” is selected, the Character, Transients and Formant Character 

parameters described below are no longer available and therefore grayed out.

Tip: For the playback type “Tonal”, a variation called “Tonal (high)” is also available. If you are 

working with sopranos or very high-pitched melodic instruments (such as piccolos), instead of “Tonal”, 

you should try out the variant “Tonal (high)”, as this could enhance the sound quality. Voices or 

instruments with normal registers, however, are less well served by “Tonal (high)”, so its use in such 

cases is best avoided.

Character: This is a another pop-up button and allows you to select between a smoother and a 

crisper playback. If “Crisp” is selected, Melodyne uses a smaller processing window that allows fast 

acoustic movements in the signal to be reproduced more clearly. This setting is therefore best for 

percussive sounds and others with many fast tone changes. To soft, sustained sounds, however, the 

crisper setting can introduce a certain restlessness. To avoid this, opt for “Smooth” which employs a 

larger processing window and is therefore more suitable for the reproduction of smoother, more 

gradual tonal transitions.
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Transients: This parameter is only available when the Universal and Percussive algorithms are in 

use. It determines how the transients in the signal should be handled during playback. With the slider 

fully to the right (the default position in the case of the Percussive algorithm), the transients are 

clearer and more acute. As the slider is moved to the left, the transients become softer. By default, 

with the Universal algorithm selected, the slider is in the middle. Experiment to see which setting 

delivers the best sound with your own material.

Formant Correction Up/Down: Whenever you transpose a note in Melodyne, the formants are 

automatically corrected to avoid, in the case of vocals, the dreaded “Mickey Mouse” effect. Or, in 

technical terms, whenever you transpose a note a whole tone upwards, Melodyne automatically 

corrects the resulting formants by shifting them back down a tone, in this way preserving the original 

timbre. In the case of the human voice, this is generally what is wanted, but with an acoustic guitar 

perhaps not: With many sounds, it can add charm if the formants are transposed in parallel with the 

fundamentals – i.e. not automatically corrected.

The Formants Up and Down sliders are provided, therefore, to allow you to determine the degree of 

the automatic formant correction – independently for upward and downward transpositions. With the 

slider all the way to the right, the full 100% formant correction is applied; fully to the left, no automatic 

formant correction at all is applied. When you return to normal edit mode, you will only hear the effect 

of these parameters if you shift, or have shifted, the formants of one or more notes in the Note Editor. 

To simulate and test their effect in Note Assignment Mode, use the pitch controller in the preview 

section of the Algorithm Inspector. If the current value for this is positive, you will be able to preview 

the effect of the Up slider; if the current value is negative, you will hear the effect of the Down slider.

F(ormant) Character: When formants are shifted, this slider alters their weighting in the frequency 

range and therefore alters the sound of the shifted formants. Experiment to see with which setting 

your material is best reproduced. This parameter has no audible effect when you return to normal edit 

mode unless and until notes have been transposed in the Note Editor. To simulate and test its effect 

in Note Assignment Mode, use the formant control in the preview section of the Algorithm Inspector.

The Formant Center parameter is only relevant to the algorithms Universal and Percussive, as the 

blobs are not sorted by pitch when either of these two algorithms are active, and the formant center is 

therefore not determined automatically. Not only with the Melodic and Polyphonic but also with the 

Percussive Pitched algorithm, the formant center is derived from the pitches themselves, so this 

control is grayed out when any of these algorithms is selected.
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Sibilant Handling, Robust Pitch Curve, Separate Audio

Sibilant Handling The Melodic algorithm detects the presence in a recording of what we define 

broadly as “sibilants”. Included here along with fricative consonants and digraphs like “s”, “z”, “sh” and 

“zh”, and certain other word fragments such as “t” and “k”, is breath noise, such as the sound of a 

vocalist inhaling or exhaling between words. Melodyne 5 treats these differently from all other 

components of the sound when you begin to make pitch or timing adjustments, and the editing 

sounds more natural as a result. If you prefer, you can decline to give sibilants this special treatment 

by clearing the checkmark next to “Sibilant Handling”.

For vocals, Sibilant Handling is without question ideal; whether that is equally true of monophonic 

instruments varies enormously from case to case. If with a bass guitar, for example, the attack noise 

is marked as sibilant, you should listen critically to the results when you first change the melody or 

timing, and decide whether or not they are to your liking. If not, clear the checkmark next to “Sibilant 

Handling”.

By default, Sibilant Handling is always switched on when the Melodic algorithm is selected, whereas 

with the Percussive Pitched algorithm it is by default switched off. With the other algorithms, the 

corresponding functions are unavailable, so the option is grayed out.

Note: When you open older projects (from the time before Melodyne 5), you will find that the Sibilant 

Handling option on their vocal tracks is not checked. The reason for this is that you may already have 

perfected the vocals, in which case we assume you’ll want your project to sound exactly the same as 

it did before. If so, leave the Sibilant Handling option switched off.

If, on the other hand, you want the project in question to enjoy the benefits of Melodyne 5’s new 

functions, you should activate Sibilant Handling. Your older vocal tracks will then most likely sound 

better at once, and you will enjoy greater creative freedom in other areas besides.

Robust pitch curves: With the algorithms “Melodic” and “Percussive Pitched”, Melodyne detects the 

Pitch Curve in very high resolution. This is especially advantageous in the case of vocals, as there is 

then particularly detailed control over all aspects of the intonation, and the pitch tools are able to 

deliver optimal sound quality.
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With certain recordings, however, this high resolution can be counterproductive. This is particularly 

the case with instruments that were in fact played monophonically but where sub-optimal recording 

conditions (resulting for example, from obtrusive room resonances) or the physical composition of 

their resonance chambers gives rise to what we might call “technical” polyphony.

Examples of this might be the electric upright bass or frequency modulated synthesizer sounds – 

sometimes, even, the human voice, when, for example, a (usually male) rock singer wrings deep 

throaty sounds from his voice.

In such cases the pitch tools (at least, when heavy use is made of them) deliver artifacts, and it is 

then that switching to a “robust pitch curve” makes sense.

The simple act of switching to a robust pitch curve initially results in no detectable change, but as 

soon as a note is edited with one of the tools in Note Assignment Mode, Melodyne searches afresh 

for the pitch curve of this note (and of this note only) and delivers then, when this option is checked, a 

simpler, more stable, more  curve.robust

The simplest command to trigger this type of renewed search for the pitch curve, but which otherwise 

changes nothing, is a [Alt]+double-click with the first assignment tool.

The Polyphonic, Universal and Percussive algorithms have robust curves by default, so with these 

algorithms the option is grayed out.

Separate Audio: When you are editing the detection of an audio source, Melodyne sometimes has a 

great deal of processing to perform in the background and large volumes of data to move in and out 

of its cache. The option Separate Audio gives you control over this behavior. If the Auto box is 

checked, with each change you make, Melodyne performs all the requisite calculations immediately. 

The advantage? Whenever you use the preview controls to test your algorithm settings, Melodyne 

accesses the latest data, and everything sounds exactly as it would in normal edit mode. The 

disadvantage? Melodyne sometimes needs to introduce a processing pause during which the 

progress indicator appears and your work is interrupted.

Since you do not always need the preview controls, you have the option of changing this behavior by 

clearing the Auto checkbox. In the case of certain editing actions, the requisite calculations are then 

not performed immediately but only when you click the Now button or leave Note Assignment Mode. 

The advantage of this is that your workflow is not interrupted. The disadvantage is that the preview 

controls in such situations cannot access the latest data and therefore do not always reflect the 

changes you have made. Should there be a discrepancy between the previous data and the current 

state, the Now button will flash to warn you. If you then click on it, Melodyne will perform all the 

outstanding calculations and update the totality of the data.
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Loading note assignment data by menu command

If you click on the cog wheel at the bottom of the inspector, you will see the command: “Load from 

Compatible File”. This allows you to apply the detection data of another audio file to the current file. 

For this to happen, two conditions must be satisfied:

The file must be exactly the same length as the current target file.

The file must be present on another track in the current song. It is not enough for it simply to 

be on the hard disk; it must have been imported from there into the song.

Now, suppose there is a playing error that you wish to correct on all three tracks simultaneously. For 

the correction to be phase-locked and optimal sound quality to be preserved, all three tracks must be 

accessing exactly the same detection file. This is where the command “Load from Compatible File” 

comes in. The full procedure is then as follows:

Examine the track GTR_DI in Note Assignment Mode and optimize the detection if necessary.

Now open the file GTR_SM57 in Note Assignment Mode and choose the command “Load from 

Compatible File”. A list will appear with two entries: GTR_DI and GTR_U87. Select the track 

you have just optimized: GTR_DI. Now you will see exactly the same detection for the SM57 

signal as for the DI signal.

Next follow the same procedure for the GTR_U87 track, assigning the DI detection file to this 

track as well.

Finally, exit Note Assignment Mode and you will be able to optimize the guitar performance on 

all three tracks simultaneously in normal Edit Mode.

The reason we strongly recommend you to begin by optimizing the detection of the DI signal rather 

than that of either of the microphones is this: the polyphonic detection of the DI signal is usually right 

first time, so adopting this approach will require less work on your part in Note Assignment Mode. The 

microphones, on the other hand, depending on your amp settings and any pedal boards you may be 

using, tend to capture a distorted signal which takes considerably longer to optimize. By using the 

trick we have just described (substituting the detection data of the DI track for those of each of the 

microphone tracks), you will obtain the best-sounding results in the shortest possible time.
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The Time Grid

The Time Grid slices up the time axis at regular intervals to provide a clearer temporal overview. It 

can also have the function, however, of causing content as it is moved to snap to the nearest grid 

line, thereby making it easier to position notes exactly on the beat. For the spacing of the grid (i.e. the 

distance between adjacent grid lines), you can choose between Seconds and any of a variety of note 

values (half note, quarter note etc.).

Activating and setting the Time Grid

To adjust the Time Grid, either choose Options > Time Grid from the main menu or click the note icon 

(at the top right of the Note Editor) to open the pop-up menu shown here.

Clicking on the note icon activates or deactivates the grid; you can also define a keyboard shortcut for 

this command from the Shortcuts page of the Preferences dialog. If you click the note value or the 

arrow alongside it and hold down the mouse button, the grid menu pops up.

This allows you to the set the interval between grid lines to any of a variety of regular or triplet note 

values or else to Seconds.
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The time axis is then graduated at intervals equivalent to the note value selected. If you have chosen 

a small note value (such as 1/16) and then zoom the display outwards, at a certain point it will 

become impossible to display all the grid lines; the grid value selected, however, will remain active.

Moving notes when the grid is active

When the Time Grid is active and Seconds is not checked, notes moved from one beat to another will 

end up the same distance from the new beat as they were from the old one. In other words, whilst the 

grid does influence their position, they don’t snap exactly to the nearest grid line unless they were on 

a grid line to begin with. The note depicted below, for example, sounds slightly after the first beat of 

the bar.

If, while the grid is active, this is moved to the second beat, there, too, it will sound slightly after the 

beat – the offset in the two cases being identical.

Even if the grid is active, you can still adjust the position of a note (or a selection of notes) 

independently of the grid by holding down the [Alt] key as you move it.
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Chord recognition and the Chord Track

Melodyne is capable of recognizing the chords and detecting changes of key (or ‘tonality’) in your 

recordings. Here you will find all you need to know about Melodyne’s Chord and Key tracks.

One Chord Track for all Melodyne instances

The Chord Track is displayed in all instances of Melodyne that are open – i.e. on each track. You 

therefore see the same chords for all instruments, although the melodic line, or chords, played by 

each instrument may be different.

So what the Chord Track is displaying is the combined effect of all the instruments: the harmonic 

structure of the song or composition . Armed with this information, you can examine the as a whole

notes played by any instrument at any moment and see how well they accord with the overall 

harmony.

Triggering the harmonic analysis

To get Melodyne to identify the chords, proceed as follows:

Open the recording of a polyphonic instrument (e.g. piano or guitar). In Melodyne studio, you 

can open multiple tracks simultaneously in the Note Editor (e.g. guitar and bass) so the 

harmonic analysis can take all of them into account.

Display the Chord Track (and the Key Track too, if you wish) by checking the relevant entries 

in the Options menu. Alternatively, you can click on the icons beneath the Time Grid Settings 

menu in the top right-hand corner of the Note Editor.
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Right-click in the Chord Track and select “Analyze Chords” from the context menu. You will 

then see a ‘lead sheet’ of your recording.

Please note: Before optimal results can be obtained from the chord recognition function, the detected 

tempo must be correct; otherwise the chord symbols may be aligned with the wrong beats. For this 

reason, prior to the chord analysis you should choose “Copy Song Tempo to File” from the Tempo 

dialog.

You can repeat the “Analyze Chords” command at any time to update the analysis.

You might do this, for example, after recording a new guitar part containing different chords.

If it’s only certain chords that need to be reexamined, select the chords in question in the 

Chord Track and choose “Analyze Chords”.

To select two or more chords, use the Shift and Cmd keys.

If you click on one chord and then press Cmd+A, all the chords will be selected.

Note: The chord analysis is invariably based on all the notes in selected areas of the Chord Track. It 

is not possible to influence the analysis by selecting or deselecting individual blobs. That would in any 

case make no sense from a musical point of view, as the less information taken into account, the less 

accurately the chords displayed would reflect the overall musical content of the recording.

There could, however, be cases – if you were analyzing the chords of a complete mix, for example – 

when certain blobs (attributable to the kick drum, say, or the cymbals) might lead to confusion. The 

solution in such cases is to the copy the audio file to a new track, delete the offending blobs, and 

trigger a fresh chord analysis based on that track only.
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Selecting between alternative designations

The context (right-click) menu of the Chord Track suggests alternatives for the chords detected:

These, we must stress, are  compositional suggestions, as in “here you could also play this chord”. not

The alternatives suggested are simply alternative interpretations of the audio material.

A chord made up of the notes C, E, G and A, for example, could be interpreted as either C6 or Am7. 

Both interpretations are legitimate, but which is the more apt might depend on the degree to which 

the various notes are emphasized; Does the highest note sound loudly and clearly, for instance, or is 

it barely perceptible? The most appropriate interpretation might depend also on the surrounding 

chords or the prevailing key (or ‘tonality’) of the passage in question. These are questions of content 

but also of taste that are best left for you, the user, to answer. For this reason, Melodyne offers you all 

plausible interpretations and lets you choose between them.

Of course, in the case of very basic chords, there will be fewer alternatives and in some cases only 

one. If the chord, for example, consists of three notes: C, E and G, this can only sensibly be 

interpreted as “C Major”.
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Entering chords manually

Independently of the results of the chord detection, you can also fill in the Chord Track manually, by 

typing in the names of the chords or standard chord symbols.

To do this, select an existing chord (a frame will appear, highlighting the chord selected) and type in 

text in the normal way:

In areas of the Chord Track where no chord symbols are displayed, you can enter them simply by 

double-clicking in the appropriate places and typing them in.

Melodyne accepts all the standard conventions for denoting chords.

For “F minor”, for example, you can spell the chord in any of the following ways: “Fminor”, “Fmin”, 

“Fm” or “F-” (with the “F” in upper or lower case). By default, Melodyne prefers the set language.

You can eliminate specific chord changes by moving the cursor over the borders between chords (the 

cursor than changes its shape) and then double-clicking.

Conversely, you can insert additional chord changes by double-clicking on an existing chord. By 

default when you are inserting or moving chords, they snap to the nearest quarter note (crotchet) on 

the grid. By holding down the Alt key, however, you can temporarily increase the resolution of the grid 

and in this way reach intermediate destinations, an eighth or a sixteenth note to either side.

In the context (right-click) menu of the Chord Track, you can decide whether when you introduce a 

new chord change, a fresh anlysis of the newly created chord halves should take place:
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Keyboard shortcuts for editing the chords

The following shortcuts, which are the same as those used for the selection and editing of blobs in the 

Note Editor, allow you more swiftly to enter and edit the chords to be displayed. If you wish, you can 

change the shortcut assignments in the Preferences dialog.

Shift-click and Cmd-click: Extend the chord selection

[Left/Right Arrow]: Select previous/next chord

Shift+[Left/Right Arrow]: Extend selection to include previous/next chord

[Up/Down Arrow]: Switch between alternate chord designations (as described above)

Cmd+[Up/Down Arrow]: Shift the chord up or down diatonically i.e. using only the notes of the 

current scale, so major intervals are replaced where necessary with minor ones and vice versa 

to suit the key. For example, if the key is A minor and the chord selected is C major. After 

pressing Cmd+[Up Arrow], this will become D minor (not D major, which is not found in the key 

of A minor). If, on the other hand, the key were E minor, selecting a C major followed by Cmd+

[Up Arrow] would produce D major. In this case, the quality of the chord (e.g. the type of triad) 

would not change.

Shift [Up/Down Arrow]: Transpose the chord chromatically upwards without regard to the Cmd

key. So C major becomes C# major, followed by D major, then D# major etc. So the quality of 

the chord does not change: major chords remain major, minor chords remain minor.

By editing the Chord Track in this way, you are not (initially) changing the recorded music. However, 

such changes to the Chord Track will make a difference when you come to edit the notes, if you 

select “Chord” or “Chord Scale” as the Pitch Grid.

Auditioning chords

In the Context (right-click) menu of the Chord Track, you will find an option to audition the chords:

If this option is activated, as you step through the chords with the arrow keys or alter them through 

text input or using the keyboard shortcuts, you will hear the chords in question played with a guitar 

sample.
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Chord symbol conventions

Melodyne’s Preferences dialog allows you to choose the chord symbol conventions used in the Chord 

Track. There are various conventions in common use and Melodyne is familiar with all of them. Some 

musicians, for example, write “Cm” to indicate a chord of C minor, whilst others prefer “C-” or “c-”.

Even though you may have chosen a particular format (e.g. “c-”) for the display, you can still use a 

different convention (e.g. “Cm”) to input the data; Melodyne will simply translate “Cm” into “c-” for you. 

This is particularly useful if you have opted for a convention that involves special characters that are 

awkward to type in. In the Preferences dialog, you could specify, for example, that a chord of F major 

with a major seventh should be displayed as “F#7”, but use a format that is easier to type (such as “F 

maj 7”) when entering chords in the Chord Track.

As well as choosing a naming convention for the display, you can also influence the complexity of the 

chords. For certain musical genres, you may prefer to make the lead sheet easier to read. The 

context (right-click) menu of the Chord Track offers the following options:

Slash Chords

If the guitarist is playing a chord of C major, for example, but the note sounding in the bass is not C 

but G, then – even though this does not change the chord (since the note G does appear in the chord 

of C major) – you may still feel it is important for the notation to take account of this fact using the 

familiar “slash chord” notation: C/G (i.e. C major with a G in the bass). 

If you check this option, this convention will be used throughout the track.
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Expanded chords

If you check this option, Melodyne finds expanded chords (such as those common in jazz). If the 

option is cleared, a simpler description will be preferred. For example, if the chord in question is C 

Major but a D is sounding at the same time. D is the ninth of a C major chord, so an exact description 

of the chord would be “Cadd9”. In this case, though, it would be a perfectly legitimate simplification to 

just write “C major” in the lead sheet. This would in any case have no effect (initially) upon the music 

itself. Whether or not this option is checked could have implications, but only on the manner in which 

you edit notes later on. (The editing of the notes in the chord context is dealt with in the next tour).

Less Thirds

Melodyne adds thirds in the course of the chord detection even when none were played, which is 

usually very helpful. But in the blues genre, for example, the musicians often omit thirds on purpose 

and in such cases the addition of thirds is undesirable. If you check this option, the added thirds are 

hidden. Thirds that were actually played, however, remain unaffected and are always shown. If no 

added thirds are present, this option is grayed out.

The Key Track and key changes

The methodology for editing the Key Track is basically the same as that just described for the Chord 

Track.

The only real difference is that the context (right-click) menu has fewer entries:

The upper area offers you alternatives to the detected key.

Analyze Key: This triggers a new detection of the key.

Church Modes: Uses the church modes (Dorian, Phrygian etc.)

Open Scale: Opens a separate window to let you select a key.

Conduct New Analysis after Slicing Modes: By double-clicking in the Key Track, you can slice 

an existing segment in two, or merge two segments. This option determines whether or not a 

fresh analysis of the key of the segment or segments involved should be carried out 

automatically whenever you slice or merge segments in this way.
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The Key Track and the Scale Ruler

The Scale Ruler (the left-hand margin of the Note Editor) invariably displays a key, for which 

numerous variations are possible. If your song contains key changes, which scale is displayed will 

depend upon the playback position:
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Chords and keys in Note Assignment Mode

In Note Assignment Mode, you do not see a shared Chord Track for the entire song, as is the case in 

normal Edit Mode, but only the chords played by the instrument you are examining.

If, in Note Assignment Mode, you make changes to the blobs using the Activation Tool and 

subsequently trigger a new analysis, the chords may change.

For this reason, we speak in the one case of “project chords” that relate to the entire song and in the 

other of “file chords”, which are only visible in Note Assignment Mode and relate only to the 

instrument in question. In the Edit menu, you will find commands that allow you to replace file chords 

with project chords, and vice versa.

It is the same with the keys: The song has a common Key Track (“Project Scale”), whereas what you 

see in Note Assignment Mode in each case is the current “File Scale”.
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The Pitch Grid

You can shift the pitch of notes in Melodyne either continuously or in discrete steps using the grid. 

When the grid is active, notes can only be moved to such pitches as the snap mode selected at the 

time will allow.

The functions of the Pitch Ruler and access to the Pitch Grid

You can change the options relating to the Pitch Grid either from the sub-menu of the same name 

under Options in the main menu or by clicking the clef icon directly above the Pitch Ruler.

Clicking on the Clef icon toggles the grid on and off. When the grid is deactivated, you can slide notes 

continuously upwards or downwards in pitch. Only faint lines in this case separate the notes in the 

Pitch Ruler.

If you click on the Clef icon (or the little arrow next to it) while holding down the mouse key, the menu 

containing the grid options drops down.
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The Pitch Grid and the background in the Note Editor

The Pitch Grid, when activated, causes notes to snap to particular pitches as you drag and release 

them. The white horizontal beams beneath the blobs in the Note Editor represent the pitches allowed 

by the currently selected grid. The gray beams represent pitches that are not included in the current 

grid and that the blobs therefore spring over as they are moved.

When you double-click on a blob with the Main Tool or the Pitch Tool, it will snap to the center of the 

nearest white lane – so whether it was perfectly in tune or slightly offset from its previous pitch, its 

offset from its new pitch will be zero. Thus, as well as moving notes to more suitable pitches, a simple 

double-click perfects their intonation at the same time.

If, on the other hand, you hold down the [Alt] key as you double-click, if a blob was offset 10 cents 

(say) from its previous pitch, it will be offset from its new pitch by the same amount. In other words, 

even though the blob may move to a different pitch, its “degree of imperfection” (in terms of 

intonation) will be preserved – such deviations are, after all, often musically desirable and used 

intentionally in order, for instance, to obtain a warmer, richer tone.

For the Pitch Grid and the background to the blobs in the Note Editor, the following options are 

available:

Pitch Grid

No Snap: The Grid is deactivated and notes can be shifted continuously up or down in pitch.

Chromatic Snap: Notes snap to the nearest note of the chromatic scale.

Key Snap or Chord Snap: Notes snap to the grid currently selected as the display background 

in the Note Editor.

Pitch Background

Keyboard: The background in the Note Editor mimics the pattern of black and white keys on 

the piano keyboard – only in this case, the pitches produced by the black keys are shown in 

gray. When the grid is active, these pitches are inaccessible, so you are effectively locked into 

C Major – which is fine if the song happens to be in that key but not much use otherwise.

Key: Now the notes of the current key or tonality are displayed in white and notes foreign to 

the key in grey. Again, when the grid is active, only the white beams are accessible. If there is 

a change of key in the course of the song, the pattern of white and gray beams will change 

accordingly.
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Chord: Now the background pattern changes from chord to chord, with white beams 

representing chord members and notes foreign to the current chord shown in gray. So in the 

case of chords based on simple triads (C Major, F minor etc.), only three notes per octave will 

be available. In the case of more complex chords, more pitches will be available – four per 

octave in the case of a major seventh chord, for example.

Chord Scale: With this option, once again seven white beams per octave are displayed. Unlike 

the case, however, when “Key” was selected, these are not the notes of the current key, but 

instead form a scale that reflects the current chord.

A brief explanation: It is perfectly possible, in jazz for example, for chords to be used that do not fit the 

key, without the listener immediately interpreting this as a key change. For example: You are in C 

major, and the chord played is D major, which does not actually fit the key. If the option “Chord Scale” 

is selected, for this one chord a black-and-white pattern will be displayed corresponding to the notes 

that fit the chord played within the key. So, in our example, F# would be a legitimate tone and would 

be shown in place of F.

Pitch lines: When this option is selected, a ruled line appears in what was previously the center 

of each beam, and the beams are no longer displayed. The pitch lines invariably reflect the key 

– including any key changes – but not the chords; bold lines indicate the pitch of notes 

belonging to the key; that of notes foreign to it are denoted by thin lines. This display mode is 

useful when you are correcting intonation errors, as the lines show the exact pitches to aim for.

Pitch Labels

Here you can choose whether the names of the notes (C, D, E etc.) or degrees of the scale (I, II, III 

etc.) are shown on the Pitch Ruler.

A practical example

You are perhaps wondering what earthly purpose is served by all these options. An example may 

make things clearer. Let’s suppose you want to import a guitar part from your loop library and adapt it 

to the current song. Here’s how it’s done:

First create a chord track (either by applying the chord recognition function to the instruments 

you already have or by typing in the chords).

Now activate Scale Snap

As the Pitch Background, choose "Chord"

Insert the guitar part from your library and select all its notes (shortcut: [Cmd]+A)

Then double-click any of the selected notes

Now the imported guitar part will follow the chords of the song. You may perhaps want to shift one or 

two of the chords upwards or downwards along the Chord Grid to obtain inversions.
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With this procedure, of course, you may find occasionally that two notes that were different in the 

original guitar part end up on the same pitch. This is bound to happen where, for example, in the 

original recording, there’s a major seventh chord (which is made out of 4 notes) but a simple major or 

minor chord (consisting of 3 notes) in the current song. Such problems, however, are easily solved: 

just select one of the two notes and drag it by hand to a “free” white note. Or you could switch the 

display background from “Scale Notes” to “Chord Scale” to obtain a wider choice of suitable notes.

When you are dealing with vocal parts, on the other hand, you will hardly ever find the “Chord” setting 

useful – it would limit the voice to too few notes (often only 3 or perhaps 4 per chord). Choose instead 

“Chord Scale”, which will allow you greater flexibility when working with melodies. Where, on the other 

hand, you have multiple vocal tracks comprised of little more than “Ooh” or “Aah” sounds that you are 

using to provide layers of harmony, then “Chord” might be the most useful setting.

Once you have finished composing the melodic line and begin to address the finer points of 

intonation, switch the display background to Pitch Lines. This is because the lines – which represent 

perfect intonation – provide a clearer indication of which notes are out tune (and by how much) than 

that provided by the (far broader) beams.

The Scale Ruler and the Reference Pitch Ruler

To select a scale for the Pitch Grid yourself or change other settings, click the rightmost icon (the two 

sharp signs) beneath the Pitch Ruler. Two new columns will appear to the left of it.
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Adjusting the master tuning

The narrow column on the very left is the Reference Pitch Ruler. Drag in either direction the mark 

alongside any note – A4, for example – and the Frequency Ruler appears, which you can consult as 

you fine-tune the note in question and, with it, of course, all the other notes of the scale. What you are 

doing here is adjusting the master tuning for the entire Pitch Grid. A tip: increase the vertical zoom 

factor, as this will make it easier for you to locate the value you want.

By right-clicking any of the marks on the ruler, you can open a small context menu. This offers a 

number of pointers to help you bring the Pitch Grid swiftly into line with a particular tuning:

At the top, you will see the current frequency of the note selected.

Concert: bases the tuning on modern standard concert pitch (where A4 = 440 Hz).

Default: bases the tuning on the frequency currently assigned to A4 in the Preferences dialog.

Detected: bases the tuning on Melodyne’s analysis of the music being edited – the original 

tuning.

Set as Default: tells Melodyne to use the current value as the default tuning for new 

documents and adjusts the value in the Preferences dialog accordingly.

The various settings for A4, incidentally, can be found quickly by clicking the tuning fork icon at the 

top of the Reference Pitch Ruler. By typing into the box immediately below this icon, you can assign 

to A4 any frequency you like.
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Selecting the tonic and scale variety

The wider ruler next to the Reference Pitch Ruler is the Scale Ruler. Here you can select the ‘tonic’ (i.

e. the first degree or keynote) of the scale as well as its mode or type. First click on the note you wish 

to use as the tonic. The following menu opens:

Related scales: in the top part of the menu, you will find a varying number of scales preceded by a “=” 

sign. These are scales that correspond to the current scale but are differently named. Please note 

that when you select a related scale from this menu, only the main structure of the mode in question 

is adopted: the scale is simply given a new name and, if applicable, a new tonic. It can be, however, 

that the exact definition of the related scale in question contains additional secondary degrees or fine-

tuning. If you wish to use these, please choose Open Scale... from the scale drop-down menu.

The current note: in the middle of the submenu, grayed out, you will see the name of the note 

you have clicked on and which you can now make the tonic.

Major / Minor: Allows you to select a major or minor scale with the note selected as tonic. To 

select C Major, for example, click C in the ruler, followed by C Major from the submenu.

Open Scale... : opens Melodyne’s Scale Window, which offers access to a wide variety of 

additional scales. This window will be described in the next section.
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Analyzed: this offers you rapid access to two options derived from Melodyne’s analysis of the 

material: the closest major or minor scales and an exact microtonal scale.

Notes Reflect Scale Changes: normally when you change the scale, Melodyne adjusts the 

Pitch Grid but does not change the notes themselves unless you double-click on them first, in 

which case they will snap to the grid. If, however, you wish the notes to adjust automatically to 

any change of scale, select either Tuning or Tuning and Mode. Then any changes will take 

effect immediately and you will hear them at once during playback.

Play Scale: plays the current scale. When this function is active, the loudspeaker icon appears 

above the Scale Ruler. By clicking on this icon, you can deactivate the function without 

needing to access a menu.  

Apply Dynamic Just Tuning: fine-tunes the selected notes applying the principles of just 

intonation to ensure that pure intervals result.

Dynamic just tuning: Dynamic just tuning eliminates the slight dissonances and resulting 

interference (or ‘beating’) between notes that come with equal temperament. By this means a 

smoother sound can be obtained, as is demonstrated, for instance, by real orchestras. We speak of 

“dynamic” just intonation because not only are the intervals pure but the pitches are also shifted 

minutely to ensure that the chord member most affected by the just intonation is as near in pitch as 

possible to its counterpart in equal temperament. Example: Melodyne shifts a justly tuned chord of C 

major (C ± 0 ct, E – 13 ct, G +2 ct) six cents up, so that the E is not too far removed from its even 

temperament counterpart. Furthermore, this fine-tuning of notes is not static but governed by the 

current harmonic context. So in the time dimension, too, it is dynamic, to ensure that at each instant 

optimal tuning is obtained. Dynamic just tuning is particularly effective and pleasing to the ear in a 

multi-track context, as it’s when you select notes from multiple (or all) tracks and apply just intonation 

to them that its benefits are most apparent.

Tip: Initialize the key prior to the transfer/load: In the case of monophonic or polyphonic audio 

material, Melodyne also recognizes the key of the music. With short melodic phrases, however, the 

key chosen is often not the one intended, simply because too few notes are available for a correct 

appraisal. To prevent this happening, you can set the key using the Scale Ruler of an empty instance 

of the plug-in or an empty document (if using the stand-alone implementation of the program)  before

the transfer or loading of an audio file. To do this, simply click on the desired keynote in the Scale 

Ruler and select the desired scale from the context menu. Melodyne will then retain this initialized 

value, regardless of its own subsequent analysis.

The Scale Window

Melodyne’s Scale Window offers a multitude of scales you can select, listen to, and make use of. To 

access this window, choose “Open Scale” from the context menu of the Scale Ruler.
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The selected scale applies to all instances of the Melodyne plug-in. In the stand-alone implementation 

of Melodyne studio, it also applies to all the tracks of the current document.

To open the Scale Window, select Open Scale from the context menu of the Scale Ruler.

Now choose a category from the left-hand pane followed by the desired scale from the pane on the 

right. Click the loudspeaker icon to the right of each entry to hear the scale selected.

If you have activated the option Notes Follow Scale Changes, during playback you will hear 

immediately the effect of applying the scale selected to your audio material. The window allows you to 

try out (or ‘audition’) different scales quickly and easily. If you wish to adopt the changes, exit the 

window with OK; otherwise click Cancel.

From the lower pane of the window, you can select between the parameters of your existing scale 

and those of the scale selected in the Scale Window.
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Mode and Tuning: you can adopt either the parameters of your existing scale (on the left) or of 

the scale currently selected in the Scale Window (on the right).

Tonic: you can choose between the selected tonic or the tonic from the preset.

Pitch: here you can choose between current tuning, the pitch from the preset or various 

standard tunings.

Stretching: here you can select whether or not stretched tuning should be applied to the scale.

External Scales Folder...: this button allows you to open a folder containing scale definitions in 

Scala format (filename extension “.scl”) which will then appear as an additional category in the 

Scale Window.

On the Internet, you will find at http://www.huygens-fokker.org/microtonality/scales.html a collection of 

over 4,000 Scala files that you can copy to any part of your hard disk and audition and try out in this 

way using Melodyne.

You can also load scale definitions created in Melodyne studio (filename extension ‘.mts’) with this 

button.

Saving a scale

The Scale Window allows you to experiment swiftly and easily with a large number of scales as well 

as combine elements of your existing scale with those of the presets in the Scale Window. In the 

process, you are bound to hit upon interesting combinations that you will want to save and use again 

later. The command “Save Scale As...” allows you to do just that: store your own scale presets so that 

you can access them later in the Scale Window. For this purpose, it opens a window that looks very 

like that of the Scale Window and offers you the following options.

Name: here you can enter a name for your scale.

Category: select the category under which you wish the scale to be filed. Click New Folder to 

create a new category.

In the text field below, you can enter a comment to be stored along with the scale.

In the lower part of the window, you can assign names to the mode and tuning. All aspects of a 

scale are invariably stored along with it. By placing ticks (checkmarks) here, however, you can 

specify which aspects of the scale are considered relevant when it is opened subsequently.
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Editing scales

In the extended scale area, which opens to the left of the Pitch Ruler, you will find the functions for 

the editing of scales and creation of new scales.

Displaying the extended scale area

Click on the tuning fork icon beneath the Pitch Ruler to open the extended scale area. To the left of 

the Scale and Reference Pitch Rulers, two further rulers will appear: the Mode Ruler and the Tuning 

Ruler.

Editing modes

The Mode Ruler allows you to define the degrees of your scale – the mode degrees – and their use. 

When you right-click on a degree in the Mode Ruler, a context menu appears, allowing you to assign 

to the degree in question any of the following designations:
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Primary Degree: a degree always used in the scale.

Secondary Degree: a degree that can be, but is not necessarily, used in the scale.

Ascending Degree: a degree only used when ascending the scale.

Descending Degree: a degree only used when descending the scale. A simple example of a 

scale in which different notes are used depending upon whether you are ascending or 

descending is the melodic minor.

Non-Scale Degree: a degree made available by the tuning system but not employed by the 

scale. Non-scale degrees are grayed out in the ruler.

Set as Tonic: tells Melodyne to regard the selected note as the first note (or “tonic”) of the 

scale. The tonic is indicated by a black outline.

Set Mode Degree Names: allows you to choose whether the degrees of the scale are indicated 

by Roman numerals, solmization or their Indian designations. After double-clicking on a 

degree, however, you can type in any designation you prefer.

Lock Tuning and Mode: By placing the mouse pointer alongside the degree indicator in the 

mode menu and dragging upwards or downwards, you can transpose the mode. Normally the 

transposition is performed without regard to the tuning of the mode.
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In the case of a scale exhibiting unequal temperament – one, in other words in which adjacent 

degrees are separated by varying numbers of cents – a crude transposition of the mode, however, 

would disturb the ratios between the various degrees of the scale. Whenever this outcome is 

threatened, the “Lock Tuning and Mode” function is activated automatically so that the degrees of the 

scale move  and the intervals between the degrees are preserved. If you prefer, however, you en bloc

can activate or deactivate this function manually.

The text box at the top of the Mode Ruler (below the word “Mode”) allows you to assign a name to 

your scale.
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Editing intervals

The degrees of a scale are defined by a tuning system whereby each degree is a specific distance 

from the tuning root. This distance is described as an “interval”. The tuning therefore says nothing 

about the absolute pitch but simply expresses the ratios between the various degrees of the scale.

In the Tuning Ruler, you can see these intervals displayed in cents and can edit them. Just drag an 

interval upwards or downwards with the mouse to alter its tuning.

Intervals displayed as frequency ratios

Alternatively, you can define an interval as a frequency ratio. The interval of an octave, for example, 

is formed by the ratio 1:2. This is the function of the Ratio Ruler, which appears at the bottom of the 

screen when you click on an interval. Melodyne displays there the frequency ratios that are most 

relevant: i.e. the ones lying closest to the selected interval.

The brighter the highlighting, the closer the ratio to the selected interval. If you double-click on one of 

the ratios suggested, the Ratio Ruler engages and the cent display of the interval in question is 

updated to reflect your choice.

By dragging the upper half of the ruler, you can set any ratio you want. To move the entire ruler, drag 

the lower half. If you check the box marked “All” in the Ratio Ruler, Melodyne will no longer preselect 

ratios for you but simply display all possible ratios that approximate to the current interval.

Defining intervals

Right-clicking on any interval in the Tuning Ruler opens the following context menu:
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Insert Interval Above Selection: inserts an interval above the interval selected.

Remove Interval: removes the selected interval.

Insert Chromatic Intervals: supplements the existing intervals chromatically through the 

addition of further intervals.

Remove Non-Scale Intervals: removes all intervals foreign to the scale.

Set as Tuning Root: makes the selected interval the point from which the intervals are 

calculated.

Assigned Note Name: any new interval initially takes the name of the nearest note. Musically, 

however, it may be preferable to assign the name of the note above or below it, so this entry 

allows you to select an alternative name.

Round Tuning to Equal Temperament: rounds all intervals to comply with equal temperament.

Stretch Tuning: opens a window that allows you to apply stretched tuning to your scale (more 

on this below).

Create New Scale Based On ...: opens a window that allows you to create from scratch a new 

scale (more on this below).

Interval Display: This allows you to make the selected interval the display reference for your 

tuning system, deactivate the cyclic interval display, and select between cents, hertz and 

Turkish commas (=1/53 octave) as display units. These options only affect the display of the 

intervals and have no effect on their tuning.

Interval Monitoring: if this option is checked, as you alter an interval you can hear the results.

The text box at the top of the Tuning Ruler (below the word “Tuning”) allows you to enter a name for 

the tuning system of your scale.
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Tip: If you hold down the Shift key and click between two intervals, you can insert a new interval at 

the position of the mouse cursor. Hold down the Shift key and double-click on an existing interval to 

delete it.

Creating your own scales

To create a scale from scratch, right-click on an interval in the Tuning Ruler and select “Create New 

Scale Based on ...” from the context menu. A new window opens offering you the choice initially 

between a cyclic and non-cyclic scale.

Cyclic Scale: If you opt for a cyclic scale, you can specify the size in cents of the cycle and the 

number of degrees of which it is composed. For a scale that repeats every octave, for 

example, the cycle size would be 1200 cents. Tip: you can also enter the cycle size as a ratio: 

e.g. “2/1” for an octave cycle.

Non-Cyclic Scale: Enter the size of the intervals between adjacent notes and the number of 

degrees above and below the selected tonic.

Scale Name: Enter the name of your scale in the text box provided.

If you exit with OK, Melodyne will generate a scale in accordance with your specifications and 

this will become the new scale grid for the current document. Exit with Cancel to revert to the 

current scale.
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Working with stretch tuning

On upright and grand pianos, the higher registers are generally sharpened slightly and the lower 

registers flattened; the tuning, in other words, is “stretched”. If you were now to work in Melodyne with 

equal temperament, the desired stretch tuning would be lost. To avoid this, select Stretch Tuning ... 

from the context menu of the Tuning Ruler and a window will open allowing you to define the stretch 

curve.

By double-clicking on the graph, you can create handles with which you can drag the curve to obtain 

the desired characteristic. Double-click on a handle to remove it.

Standard Stretching: if you click this button, Melodyne will generate a typical stretch curve, 

which you can then further adjust should you so desire.

Reset Stretching: restores the curve to its starting position.

Pitch Range: defines the maximum deviation and therefore the vertical range of the curve.

Exit with OK to implement the stretch curve you have defined or with Cancel to discard your 

changes.
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Identifying scales

The Scale Detective analyzes the intervals found in the audio material and their implications for the 

mode of the scale. The result is a scale grid that reflects the music analyzed. You can edit, save and 

apply the extracted scale to other material, and in this way transmit the special character of one 

recording to another.
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Showing the Scale Detective and adjusting its sensitivity

Click on the leftmost of the three icons beneath the Pitch Ruler. The “drawer” to the left of the Pitch 

Ruler is now fully open.

A new column headed “Detective” appears at the extreme left of the screen displaying the results of 

the analysis. The “mountains” lying on their sides in the Scale Detective represent the intervals 

detected: the higher the mountain, the more importance is attached by Melodyne to the role of the 

interval in question in the mode of the scale.

The slider at the top of the Scale Detective governs the sensitivity of the analysis and, with it, the 

number of intervals detected and displayed. The intervals displayed should correspond as closely as 

possible to the intervals actually played. Adjust the sensitivity until only as many intervals are 

displayed as the scale in your view contains.

The analysis will take into consideration only the notes selected, unless no notes are selected, in 

which case all will be considered.
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Scale detection options

A right-click in the Scale Detective opens the following context menu:

Reanalyze Scale: This command requires the Scale Detective to conduct a fresh analysis of 

the scale. The analysis will take into consideration only the notes selected, unless no notes are 

selected, in which case all will be considered.

Apply Analysis: If this option is selected, the results of the analysis will invariably be applied 

directly to the current scale grid.

Analysis Inserts Chromatic Intervals: If this option is selected, the intervals analyzed are 

supplemented chromatically by others, which are then regarded as intervals foreign to the 

scale (or “non-scale degrees”).

Keep ... as Tonic: If you click and drag the Scale Detective vertically, you can alter the tonic 

upon which the analysis of the audio material is based. When you do so, this option is selected 

automatically. The next analysis will then be based upon the tonic you have selected rather 

than the one indicated by Melodyne’s current analysis of the material.

Scale Cycle: opens a dialog box that allows you to choose between a cyclic or non-cyclic 

analysis.
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Cyclic Scale: selects a cyclical scale analysis. You can enter the size of the cycle in cents or 

as a ratio: e.g. “2/1” for a scale that repeats every octave.

Non-Cyclic Scale: selects a non-cyclic scale analysis the upper and lower limits of which in 

hertz (Hz) you are free to choose. The analysis will then consider only notes lying within the 

range specified.

When you exit the Scale Cycle dialog with OK, a fresh analysis of the material will be 

conducted at once, based upon your new settings. If, on the other hand, you select Cancel, 

Melodyne will revert to the existing analysis.

Applying the detected scale.

To apply the detected scale to the current scale grid, check the option Apply Analysis in the context 

menu of the Scale Detective. You can then edit, save and apply to other material your new scale just 

like any other.
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Selecting notes

In this tour, you will learn which techniques you can use to select notes in Melodyne prior to editing 

them.

Standard selection techniques

Click a note in the Note Editor to select it. Selected notes are more boldly colored.

[Command]-click additional notes to add them to the selection.

[Command]-clicking a selected note removes it from the selection.

 

Another way of selecting multiple blobs is to lasso them by clicking the background in one corner of 

the desired selection and then dragging the pointer to the corner diagonally opposite. This is 

sometimes called rubber-banding. If you hold down the [Command] key, you can add a further rubber-

band selection to the existing one. You can also add individual notes to the selection (or remove them 

from it) by [Command]-clicking.

To select a passage (i.e. a series of notes), click the first note of the series and then [Shift]-click the 

last (or vice versa).
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Snake selection

If you press the [Shift] key, click a note and then move the mouse pointer away, Melodyne’s snake 

selection mode is activated.  You can now add notes to the selection by painting over them with the 

snake.

If you move the mouse (and thereby the snake) backwards again, you can remove notes previously 

painted over from the selection.

http://helpcenter.celemony.com/M5/?lang=en&startPageEdition=melodyne-studio
http://www.celemony.com


Melodyne 5 studio - Live 12.0

   © Celemony Software GmbH 2024 • Last updated on 06/19/2024 • Help Center • www.celemony.com 142

Selection using the Pitch Ruler

Click a note in the Pitch Ruler to select notes of the corresponding pitch.

If cycle mode is active, the selection only affects such notes if they lie within the cycle range.

By [Command]-clicking other notes in the Pitch Ruler, you can add them to the selection and later 

remove them by the same means.

If you double-click, as opposed to single-clicking, a note in the Pitch Ruler, you will select the same 

note in all octaves rather than simply that single instance of the note.

Click and drag in the Pitch Ruler to select a range of notes.

By using the [Command] key in the Pitch Ruler, you can remove from the selection a range of notes 

or individual notes. Here too, if a cycle is active, only notes within the cycle range will be selected.
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Selection commands in the menu

In the Edit menu and the context menu of the Note Editor, you will find the command Select All and 

the Select Special sub-menu, which contains a number of more sophisticated options.

The command Restore Last Selection reverses the last selection step, thereby restoring the selection 

that was active beforehand. This is useful if you are in the process of performing a complex selection 

and accidentally shoot astray, causing the selection to disappear. By clicking Restore Last Selection, 

you can retrieve it.

The command Invert Note Selection deselects all selected notes and selects all notes that were 

previously not selected. The commands that follow are similarly self-explanatory, allowing you to 

select all the notes that follow, all notes of the same pitch, all notes of the same pitch in all octaves, 

and so on.

The command Select Fifths Above and Below in All Octaves selects tones a fifth above and below the 

selected tones in all octaves. All the Select commands in the second subdivision of the menu operate 

on the cycle zone only if cycle mode is active.

The two commands that follow, Select Same Beat in All Bars and Select Notes Between Locators, are 

also self-explanatory. The last command in the list, Rotate and Select Hidden Notes is designed to 

help out when you have notes that overlap or completely cover others. It does so by switching the 

display from layer to layer, selecting at each successive layer the newly revealed note, so that you 

can see it more easily and drag it.
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Correct Pitch Macro

The Correct Pitch Macro is used to rectify poor intonation quickly and intelligently and rein in any 

undue wavering in pitch. 

Opening and using the macro

Select the notes you wish to edit. If no notes are selected, macro editing will by default affect all notes.

To open the macro, choose Edit > Quantization Macros > Correct Pitch or click on this button at the 

top of the Note Editor.

Here, with the upper slider, you can apply a degree of correction ranging in intensity from 0% (no 

influence) to 100% (full power) to the pitch center of the notes selected. By default, such notes are 

moved towards, or to, the nearest semitone:

If you prefer, however, you can have the notes snap to the nearest degree of the current scale or (if 

chords have already been defined) to the nearest member of the current chord; in either of these 

cases, check the option “Snap to Chord Scale”.

Depending upon the position of the intensity slider, the notes will then snap all, or part of, the way to 

the corresponding pitches.

The macro works in a musically intelligent manner: At lower settings it affects only those notes that 

are wildly out of tune, leaving untouched those that are already quite close to the intended pitch. As 

the slider is moved further towards the right, however, even those notes are influenced, and to an 

increasing degree, until at 100% all the selected notes are exactly in tune.

The pitch center, which the macro adjusts automatically, is the same parameter that is modified when 

pitch correction is performed manually using the Pitch Tool.
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With the lower slider, you can progressively reduce the amount of pitch drift exhibited by the notes in 

question. By “pitch drift”, we mean the kind of slow wavering in pitch that is symptomatic of poor 

technique. More rapid fluctuations in pitch, such as pitch modulation or vibrato, remain unaffected.

You can modify both correction parameters in real time as the audio plays back; and hear, but also 

see (by the movement of the blobs in the Note Editor, the effect of different settings.

If you have already fine-tuned some notes using the Pitch Tool, Melodyne will assume you 

are satisfied with the results; this means that, by default, if you now open the Correct Pitch Macro with 

no notes selected and begin making changes, only the other notes will be affected. By default, in 

other words, notes that have been tuned manually are not affected by the macro. If you wish the pitch 

of these too to be affected by the macro, check ‘Include notes fine-tuned manually’. The option is 

grayed out, of course, as being of no relevance, if no manual editing of intonation has been 

performed.

Closing the macro and correction values when it is reopened

Exit with OK to keep your changes or Cancel to discard them. Naturally the fact that you have used 

the Correct Pitch Macro in no way precludes your fine-tuning notes at any time subsequently by hand.

If you select a note that has already been edited using the macro and then open the macro again, the 

settings previously applied to it will be displayed; the macro remembers, in other words, the 

parameters previously applied to each note. If the current selection includes notes to which different 

settings have been applied, when it is opened the minimum and maximum values for each parameter 

will be displayed.

Even after exiting with OK, you can still reverse the effects of the macro editing by using the undo 

function. 
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The Correct Pitch macro and sibilants

When the algorithm Melodic (the usual choice for vocals) is selected, Melodyne detects and marks 

what it defines broadly as “sibilants”. In the case of vocals, these include not only fricative consonants 

and digraphs such as “s”, “z”, “ch” and “zh”, but also word fragments like “k” and “t”, as well as the 

sound of the vocalist inhaling or exhaling between words. Whilst such sibilants do move upwards or 

downwards in the display under the effects of the macro, acoustically they remain unaltered.

By transposing only the pitched components of the sound in this way, the macro is able to maintain 

optimum sound quality throughout; to alter the frequency of sibilants would sound unnatural. But if, as 

a special effect, you ever do wish to apply pitch shifting to sibilants, this can be done manually using 

the Pitch Tool, as is described in detail .here
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Quantize Time Macro

In this tour, you will learn how to work with the Quantize Time Macro, which makes it possible to 

correct the timing of notes swiftly and effortlessly.

Quantizing timing: What is moved and where to?

Before examining the operation of the Quantize Time Macro, we should clarify a few basic concepts 

and relationships.

To understand these better, let’s begin by selecting the Time Tool. When this is active, a note 

separation (indicated by a vertical dash) or the musical starting point of the note (indicated by a 

vertical dash with a triangle) appears near the start of each blob.

Now check Show Intended Notes in the Options > Note Editor sub-menu, which can also be 

accessed via the cog icon in the top right-hand corner of the Note Editor.

Gray boxes now enclose each blob.

When it first analyzes the material, Melodyne calculates for each note two parameters of relevance to 

the process of time correction.

The first is the intended musical beat of the note; this is indicated by the start of the gray frame 

enclosing the blob. As you can see, the start of the frame invariably coincides with a grid line.
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The second is either the beginning or the musical starting point of the note, represented, respectively, 

by a note separation or a vertical dash with a triangle. The latter will not necessarily be aligned with 

the left-hand extremity of the blob. Think of a brass instrument, for example, where each actual note 

is often heralded by a certain amount of wind noise. Admittedly this noise belongs to the note, but 

from the standpoint of timing what is of relevance is the moment the sound really unfolds and the 

pitch first becomes discernible; that is the timing-critical moment.

If you quantize notes with the Quantize Time Macro, the musical starting point of each note (if one 

has been determined; if not, the beginning of the note) will move towards the left-hand side of its gray 

frame. The quantization intensity slider determines whether it goes all of the way, or only part of the 

way, to the beat assigned it.

There are also notes for which no starting point is displayed. Such is the case with notes – and not 

only the human voice but almost all instruments too are capable of producing them – with an attack 

so drawn out that it is impossible to find an instant of which you can say with any confidence “this is 

where the note really begins”. It still begins somewhere, of course, so Melodyne treats the onset of 

the sound – the start of the long attack phase, in other words – as the musical starting point and 

moves that to (or towards) the quantization target – i.e. the beginning of the frame.

In determining, or seeking to determine, the musical starting point of each note, Melodyne conducts a 

careful analysis of the audio material and in most cases its determination is musically correct. Any 

time you disagree, though, you can enter Note Assignment Mode and define some other instant 

within the life of the note as its musical starting point.

The Melodic algorithm requires separate mention because when it is active, Melodyne locates and 

marks what it calls “sibilants”. In the term “sibilants”, Melodyne includes not only fricative consonants 

and digraphs such as “s”, “z”, “ch” and “zh”, but also word fragments like “k” and “t” as well as the 

sound of the vocalist inhaling or exhaling between words. Whenever such a sound coincides with the 

start of a blob, the musical starting point identified by Melodyne always comes later. This produces 

more sensible results when quantization is applied than would be the case if the sibilant itself were 

regarded as the musical starting point of the note.

Another way of changing the way sibilants are handled by the Quantize Time macro is to use the 

Separation Tool to slice the note in two at the point where the sibilant ends; so an “s”, for example, at 

the beginning of a word, would get a blob all to itself. Since an unvoiced “s” can have no musical 

starting point, the left-hand extent of this blob (i.e. the onset of the sound itself) would then be 

regarded as the critical moment for the purposes of quantization.
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A note about time quantization in polyphonic audio material: With polyphonic material, as well as 

anchors with triangles, there are anchors without them. Notes the anchors of which have no triangle 

are in a temporal relationship with another note with a triangle and are therefore treated differently 

during quantization. If you play a C on the piano and immediately afterwards an E, the C can also 

contain starting transients belonging to the E. The C here gets a marker with a triangle; the E, one 

without. To move these two notes for no good reason by different amounts during quantization might 

not make much sense musically and could even produce tonal artifacts.

The following rules therefore apply: If during quantization both notes are selected, the note with the 

triangle and that without it will move towards the marker by exactly the same amount. There is here, 

in other words, a master-slave relationship. If you have only selected the note with the triangle 

marker, only this will be quantized. If you have only selected the note without the triangle marker, no 

quantization will take place. The same goes for a multiple selection. Naturally, you can move all and 

any of the notes manually if you are not satisfied with the way they sound together.

In the case of chords, it is the selection that determines the quantization behavior: If the Notes of the 

chord are selected individually, one after the other, and quantized, they behave as described above, 

moving individually towards the grid lines. In this way, for instance, you can ensure that the notes of a 

strummed chord on the guitar (which sound in quick succession) end up sounding simultaneously – 

an effect impossible technically for a player to realize but one that might be musically desirable.

If, on the other, prior to quantization, you select all the notes of the chord, each will travel the same 

distance. The internal timing of the chord – in our guitar example, the intervals of time separating the 

start of successive notes, and therefore the authenticity of the effect – will be preserved. The chord, 

after quantization, will sound exactly as it did before; the difference being, of course, that it will no 

longer sound ‘too soon’ or ‘too late’.

The value by which all the notes are moved forward or backwards in time is determined by the note 

lying closest to the mathematical mean between the first and last note of the chord. In the case of a 

six-string guitar chord, this is generally the note sounding on the third or fourth string. If you want the 

sounding of some other string to coincide with the grid line, of course, you can always give the whole 

chord a little shove.
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Opening the Quantize Time Macro and setting the parameters

Select the notes you wish to edit. If no notes are selected, macro editing will by default affect all 

notes. 

To open the Quantize Time Macro, choose Edit > Quantization Macros > Quantize Time or click the 

Quantize Time icon (illustrated here) to the right of the toolbar in the Note Editor.

First, the Groove Reference (if any) that will govern the time correction must be selected.

If Auto is selected, the target (or ultimate destination) of any quantization will be the left-hand edge of 

the gray frame, as already described. This is invariably aligned with the grid line that represents the 

beat to which Melodyne, in the course of its analysis, assigned the note. (On the whole, the system 

functions very well; but it can happen that Melodyne gets it wrong, and that after 

quantization you have to move the note manually to the preceding or following beat.) By selecting 

Auto, in other words, you are telling the Quantize Time Macro to move notes to (or towards) the beats 

assigned them by Melodyne based on its own analysis of the material.
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If you choose Track, you can use another track or instance of Melodyne Plugin as a quantization 

reference. Select the desired track or instance in the flip menu above the buttons. The notes of the 

selected track will then supply the grid to which the notes or the track currently being edited will be 

quantized; or, to be more precise, the quantization targets would be determined by the grey frames of 

the reference track. With the other buttons, you can select the target grid for the quantization. The ‘T’ 

next to the note values stands for the corresponding triplet. If you select 1/4 as the Groove 

Reference, to give one example, the grey frames will move to the nearest quarter-note (or ‘crotchet’) 

and this will then become the ultimate destination for any quantization.

Note that the time correction macro works differently from, and in a more musical fashion than, the 

quantization typically offered by MIDI sequencers. Instead of simply causing all notes to snap to the 

selected grid, it edits the points of rhythmic emphasis of the selected notes. If, for example, you take 

a passage containing successions of sixteenth notes (semiquavers) and quantize it to quarter notes

(crotchets), the beginning of each succession of sixteenth notes will be moved to the nearest quarter 

note. The timing of the semiquavers within the sequence, however, remains unaltered. If you wish to 

tidy that up as well, you can do so in a second pass, taking each semiquaver sequence in turn and 

using sixteenth notes as the quantization factor.

The Intensity slider determines what percentage of the distance to this ultimate destination the notes 

will travel in the course of quantization. If you select 0%, for example, they’ll not budge; 50%, and 

they’ll go half way; 100%, and they’ll travel the full distance, ending up precisely on the beat. You can 

modify both the Groove Reference and the Intensity of the quantization in real time as the audio plays 

back; and hear, but also see (from the movement of the blobs in the Note Editor), the effect of 

different settings.

If you have already finely adjusted the position of notes using the Timing Tool, Melodyne will assume 

you are satisfied with the results; this means that, by default, if you now open the Quantize Time 

Macro with no notes selected and begin making changes, all notes will be affected except these. If 

you wish the position of these too to be affected by the macro, check ‘Include notes fine-tuned 

manually’. The option is grayed out, of course, as being of no relevance, if no manual editing of note 

positions has been performed.

Closing the macro and correction values on reopening

Exit with OK to keep your changes or Cancel to discard them. Naturally, the fact that you have used 

the Quantize Time Macro in no way precludes your moving notes at any time subsequently by hand.

If you select a note that has already been edited using the macro and then open the macro again, the 

settings previously applied to it will be displayed; the macro remembers, in other words, the 

parameters previously applied to each note. If the current selection includes notes to which different 

settings have been applied, a mean value for each parameter will be displayed.  Please note: An 

exception to this rule occurs if you have used another track as a groove reference. In that case, when 

you open the macro again, the value displayed for the notes will be ‘0%’. Even after exiting with OK, 

you can still reverse the effects of the macro editing by using the undo function.
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The Leveling Macro

The Leveling Macro serves to reduce or eliminate excessive volume differentials between the notes 

on a track. It can be used to make quiet notes louder, or loud notes quieter, or both – until, in the 

extreme case, no dynamic variation remains.

Opening and setting the Leveling Macro

First select the notes you wish to edit. If no notes are selected, the macro will govern all the notes on 

the track.

Now open the Leveling Macro either from the Edit menu or by clicking on the icon shown here above 

the Note Editor.

The macro offers you two converging sliders. The left-hand slider, as you move it from left to right, 

makes the quiet notes louder; the right-hand slider, as you move it from right to left, makes the loud 

notes quieter.

When you first open the macro, their positions are as follows;

If you apply maximum leveling, they will then look like this:
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The Mean Amplitude

Coming from the left (quiet) and right (loud), the two sliders as they converge shepherd the blobs 

towards the Mean Amplitude in the center. This value is derived from an analysis of the notes you 

selected before opening the macro. It is therefore based upon the musical content and cannot be 

adjusted manually.

When you use the macro, you will notice that any given note will respond either to one slider or to the 

other. The reason is obvious: a given note’s amplitude in the original audio file cannot be less  and

greater than the Mean Amplitude. Note also that since the ultimate extent of each slider is the Mean 

Amplitude (a line that neither can cross), a note that was originally quieter than the Mean Amplitude 

can never pass above it; and a note that was originally louder than the Mean Amplitude can never 

pass below it.

A further observation: You may notice that certain blobs, representing very quiet sounds that are also 

of very short duration, do not respond to the macro at all. This is deliberate, as Melodyne initially 

assumes the blobs in question represent (extraneous) noise, which if boosted by the left-hand slider 

of the macro would become even more obtrusive. Naturally, you can edit such sounds freely by hand 

using the Amplitude Tool.

If you have adjusted the volume of any of the selected notes manually using the Amplitude Tool 

before opening the macro, it is the adjusted rather than the original values that will be considered 

when calculating the mean amplitude. It is from the most recently set amplitude of the manually 

adjusted notes that any movement towards the centre will begin as the leveling takes effect. If you do 

not wish a manually adjusted note to be affected by the leveling, simply exclude it from the selection 

before opening the macro.

Of course, if you only select one note prior to opening the macro, neither slider will have any effect, 

as in that case the mean amplitude of the selection and the amplitude of the selected note will be 

identical.
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Closing the macro and correction values when it is subsequently re-opened

Exit the macro with “OK” to keep your work or with “Cancel” to return to the status quo ante. 

Obviously, you can apply further adjustments later to the volume of the notes in question with the 

Amplitude Tool whether you exit with “OK” or “Cancel”.

Furthermore, even if you exit with “OK”, you can still use the Undo function to nullify the effects of the 

macro. Another way of doing this is to right-click (with the Amplitude Tool selected) and choose 

“Reset Amplitudes” from the context menu.

If you select a note the amplitude of which has already been affected by the macro and then open the 

macro again, the percentage shown in the macro window may differ from that displayed on the 

previous occasion. This is likely to be the case if the other notes selected are different on each 

occasion, as the mean amplitudes of the two selections will almost certainly differ and, with them, the 

percentage values displayed.
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Main Tool

Melodyne’s Main Tool is context-sensitive, its exact function at any given moment depending upon its 

position relative to the selected blob. It has no unique functions but simply offers a different mode of 

access to functions it shares with the more specialized tools for editing pitch, timing and note 

separations, combining them in such a way that you can perform the most essential editing tasks 

without ever having to change tools.

Modifying the pitch and timing of notes

Select the Main Tool (denoted by an arrow) from either the toolbox or the context menu of the Note 

Editor or by pressing the [F1] key of your computer keyboard. (If you wish to assign a different 

shortcut to this tool, you may do so after choosing Melodyne > Preferences > Shortcuts > Editing 

Tools from the main menu.)

With the Main Tool, move the arrow to a point near the center of a blob and press and hold the 

mouse button as you drag it upwards or downwards (to alter its pitch) or left or right (to move it 

forwards or backwards in time). It is the initial movement (whether vertical or horizontal) that decides 

whether the pitch or timing of the note is altered. Before changing axis, you must first release the 

note. If you hold down the [Alt] key as you drag the note, the Pitch Grid or Time Grid, even if active, 

will temporarily be ignored, allowing you to position the note exactly where you want it.

While you are dragging a note up or down, you will hear the frozen sound of the note at the point 

where you clicked. If, whilst dragging, you move the mouse to the right or left, you can put other parts 

of the note under the acoustic microscope. If you do not wish to monitor pitch changes in this way, 

uncheck the option Monitor When Editing Blobs in the Options > Note Editor sub-menu, which can 

also be accessed via the cog icon in the top right-hand corner of the Note Editor.
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If you double-click with the Main Tool on the middle part of a note (or one of a selection of notes), you 

quantize the note(s) in question to the nearest pitch allowed by the current Pitch Grid.

The blob not only jumps to a different note altogether (e.g. from E to F, if E is not allowed by the 

active Pitch Grid), but also loses any fine offset it may have had from its previous pitch. In other 

words, it snaps precisely to the target pitch, the offset being then 0 cents.

This gives you a quick and easy way of correcting the intonation.

However, if correcting the intonation is not what interest you here and your aim is simply to make the 

notes fit new chords, hold down the [Alt] key as you double-click. Then the note will jump, as you 

intend, to the nearest note in the chord, but retain its previous offset, creating interference effects that 

are sometimes desirable.
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Modifying note lengths

Open the Note Editor Options menu and check Show Blob Info. Zoom in on a few individual blobs, so 

that you can study them more closely. Now, as you move the mouse pointer over a blob, thin lines 

appear indicating the zones in which the Main Tool performs particular functions. For illustrative 

purposes, the lines here have been drawn more boldly than in the program itself. The central area 

you already know about. This has to be distinguished from the front, back and upper regions of the 

blob. As you move the mouse pointer from one of these regions to another, it changes its appearance 

to emulate whichever of the more specialized tools is most appropriate to that zone – adopting its 

functions at the same time.

Drag the front part of a note to the right or left. Hold down the [Alt] key as you do so if you wish to 

override an active time grid. Now only the beginning of the note moves; the end remains anchored, so 

the note is either being stretched or compressed.

In the same way, you can move only the rightmost part of the blob (corresponding to the end of the 

note).

Notice that as you move the beginning or end of a note in this way, the preceding or following note, if 

adjacent, is also either stretched or compressed by the same amount to avoid either the two notes 

overlapping or white space (silence) appearing between them. This type of relationship exists 

whenever a pitch transition between consecutive notes has been detected. By moving the adjacent 

note as well, Melodyne ensures that discontinuities are avoided and the musicality of the phrasing is 

preserved.
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If this behavior is not what you want, you can change the ‘soft’ separation between the notes into a 

‘hard’ one using the Separation Type Tool. Instead of the separation line, a bracket will then appear 

between the two notes to indicate that no further connection exists between them. You will find the 

Separation Type Tool beneath the Note Separation Tool in the toolbar.

Editing note separations

If you move the mouse pointer to the upper part of a note (above the horizontal line), the Main Tool 

adopts the appearance, and emulates the functions, of the Note Separation Tool. If you double-click 

now, you can create a note separation – i.e. slice the note in two.

Don’t be surprised if the two notes that result move apart in pitch: this is because a new tonal center 

is calculated for each of the newly created notes, and that may differ from the tonal center they 

shared when they were one note. In such cases, each therefore moves to a new vertical position 

based on its newly calculated pitch center.

You can move an existing note separation horizontally with the Note Separation Tool. Before you 

begin, choose Options > Note Editor Options and check Show Note Separations.

You can double-click a note separation to remove it.

If you select several notes and move a note separation, the note separations of the other selected 

notes will also be moved. If you double-click one of the note separations to remove it, those of the 

other selected notes will also be removed.

If you have selected several notes that overlap, you can simultaneously insert a note separation at 

the same point in all of them, as well as move or remove one.
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Pitch Tool

The Pitch Tool edits the central emphasis of the pitch of each note. This is the ‘pitch center’ note 

parameter that can also be edited using Melodyne’s Main Tool.

Shifting the pitch center

Select the Pitch Tool from either the toolbox or the context menu of the Note Editor or by pressing the 

[F2] key of your computer keyboard. (If you wish to assign a different shortcut to this tool, you may do 

so after choosing Melodyne > Preferences > Shortcuts > Editing Tools from the main menu.)

The Pitch Tool is the topmost of the three pitch editing tools. It is responsible for the pitch center of 

each note, which can be thought of as its center of gravity. Melodyne allows you to edit the pitch 

center of notes independently of any modulation or drifting in pitch they exhibit. Press the [F2] key 

twice and three times in quick succession to select, respectively, the first and second sub-tools of the 

Pitch Tool. From the Preferences dialog, you can also, if you wish, define separate keyboard 

shortcuts for all three tools.

Drag a note up or down with the Pitch Tool to alter its pitch. If the note is one of several selected, all 

the notes in the selection will move up or down en bloc.

Depending whether No Snap, Chromatic Snap, Key Snap or Chord Snap is selected for the Pitch 

Grid, notes can either be moved freely or will snap to the nearest semitone, the nearest note of the 

selected scale or the nearest note of the prevailing chord.

Hold down the [Alt] key as you move notes if you wish the selected grid to be ignored; this will allow 

you to position the note freely.
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Monitoring pitch shifts

As you move a note in pitch, you will hear the “frozen” sound of the note at the position clicked. By 

moving the mouse to the left or right while doing so, you can put other parts of the note under the 

acoustic microscope. If you do not wish to monitor pitch changes in this way, clear the option Monitor 

When Editing Blobs in the Options > Note Editor sub-menu, which can also be accessed via the cog 

icon in the top right-hand corner of the Note Editor.

If the note in question is part of a chord, you have the additional option of hearing the entire chord – 

and, with it, the changing harmonic context – as you drag the note up or down. To do this, once you 

have begun dragging the note, press and hold down the [Cmd] key. This is useful when you are 

creating or improving vocal harmonies by pitch-shifting notes within multiple tracks, as it allows you to 

hear and evaluate each new chord as it is created.

Editing pitch with the inspectors

As an alternative to editing the selected notes with the Pitch Tool, you can enter the desired value for 

the note and the deviation in cents from equal temperament in the inspector near the toolbar or the 

Note Inspector. The Note Inspector also allows you to determine the frequency in hertz of the note or 

notes selected. In each case you can increase or decrease the current value by clicking in the 

relevant box and dragging the arrow upwards or downwards.

When typing values into the Pitch field, you can enter either absolute values (C3, D4 etc.) or relative 

ones (+2, -1, etc.).

If you have selected several notes that differ in pitch, three hyphens are displayed in the boxes – 

followed, as you click in the box and drag, by values describing the extent of the relative change.
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Correcting pitch with a double click

You can tell that a note is sharp or flat from the fact that it doesn’t lie plumb in the middle of any of the 

horizontal lanes in the editing display. These represent the notes of the chromatic scale, the note in 

question, in each case, being indicated by the vertical Pitch Ruler to the left of the Note Editor. If, with 

Chromatic Snap activated, you double-click the offending note with the Pitch Tool or Main Tool, it – 

and any other notes selected at the same time – will “snap to the grid”, which means they will move 

instantly to the very center of their respective lanes. The “fine offset” of the notes in question will then 

be 0 cents; in other words, they will be perfectly in tune.

If, however, instead of Chromatic Snap, Scale Snap or Chord Snap are activated, as well as setting 

their fine offsets to zero, a double-click may actually cause the notes in question to change lanes.

If, for example, as is shown here, Chord Snap is active and you double-click on an E, it could move to 

F if there is no E in the prevailing chord, as would be the case, for example, if that chord were F 

minor. In addition, the offset from the target note (in this case F) would be 0 cents, so the new note 

would be perfectly in tune.

If you are not interested in correcting the intonation, however, but simply in eliminating a clash 

between the note in question and the chosen chord, hold down the [Alt] key as you double-click. It will 

then snap to the nearest chord tone, as is your intention, but its offset from the destination pitch will 

be the same is its offset from the pitch it came from; this is sometimes desirable, as minor 

imperfections of this kind can contribute towards the creation of rich and vibrant chorus effects.

When you are editing pitch, the blob simply serves as a “handle”; what you should concentrate on is 

the Pitch Curve within the blob. For the auditory impression – if what you are seeking to avoid is the 

jarring effect of poor intonation – what is essential is for the “right” part of each note to reside at the 

“right” pitch.

The fine offset displayed in the Note Inspector, which serves as the basis for any intonation correction 

resulting from a double click, is based on the path traced by the Pitch Curve throughout the entire 

duration of the note. Here Melodyne takes a great many musical criteria into consideration – among 

them, the fact that the central part of a note, as a rule, plays a more decisive role in the listener’s 

perception of pitch than its beginning or end. The Inspector is, in effect, offering a recommendation, 

which you accept whenever you drag a note with the [Alt] key pressed or double-click on it.

In principle, you can rely on this; once you’ve double-clicked on a note, it will be in tune.
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In addition – and this depends ultimately upon genre-determined listening habits or perhaps simply 

your own taste – you may wish to slice up a problematic note by inserting additional note separations 

and then double-click on the newly created note fragments. The smaller the fragments, the closer you 

will get to intonational perfection, though the emotional impact of the performance may suffer in 

consequence.

To learn more about the various tuning strategies available – and their application to vocal tracks in 

particular – and for suggestions as to how the sometimes conflicting demands of perfect intonation 

and emotional richness can best be reconciled, visit the “Training” section in our Help Center.

Pitch transitions

When one note follows another and a tonal relationship between the pair has been detected, the pitch 

curve is drawn through them, and in the area between them a thick orange line is displayed that 

represents the pitch transition.

If you position the Pitch Tool over the rear part of a note, click and drag vertically, you can make the 

pitch transition steeper or less steep.

Pitch transitions only exist between adjacent notes between which there is a soft separation. By 

clicking on a soft separation with the Separation Type Tool (the sub-tool of the Note Separation Tool), 

you can transform it into a hard separation, thereby deactivating all association between the two 

notes and with it the pitch transition.
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Resetting individual edits and introducing random deviations

In the Edit > Reset Individual Edits > Pitch cascading menu, you will find a variety of commands that 

can be used to reverse the effects of particular types of pitch editing, thereby restoring specific 

aspects of the notes selected to their original state. The commands apply only to the current selection 

and are grayed out whenever no editing of the type in question has yet been applied to the notes 

concerned. Note that these commands operate entirely independently of the normal undo function!

With the commands in the Edit > Add Random Deviations sub-menu, you can randomly alter the pitch 

of the notes currently selected – introducing either slight, moderate or drastic deviations from the 

original intonation. You can also employ the commands several times in succession to intensify the 

effect. These commands are useful when, for example, you’ve doubled a track in order to obtain a 

fuller or ‘fatter’ sound. By introducing random deviations, so that the copy is no longer identical to the 

original, you can simulate more realistically the effect of two performers playing or singing in unison. 

All these commands affect only the selected notes and are therefore grayed out if no notes are 

selected.
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Pitch modulation and drift

The term ‘pitch modulation’ covers rapid and usually intentional variations in pitch such as trills or 

vibrato. ‘Pitch drift’ is our term for slow fluctuations in pitch of the kind that are usually unintentional 

and symptomatic of poor technique. You will find the tools for editing these parameters beneath the 

Pitch Tool in the toolbar.
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Editing pitch modulation and drift

Select the Pitch Modulation or the Pitch Drift Tool from either the toolbox or the context menu of the 

Note Editor or by pressing the [F2] key of your computer keyboard.

The Pitch Modulation Tool is the first, and the Pitch Drift Tool the second, sub-tool of the Pitch Tool. 

Press the [F2] key twice in quick succession to select the former and three times in quick succession 

for the latter. (If you wish to assign a different shortcut to this tool, you may do so after choosing 

Melodyne > Preferences > Shortcuts > Editing Tools from the main menu.) There, if you wish, you 

can also define separate keyboard shortcuts for all three tools.

With the tool selected, click on a note and – without releasing the mouse button – drag up or down. 

The note edited could be part of a multiple selection, in which case you will be editing all the selected 

notes simultaneously. Watch as the pitch curve changes shape.

Drag far enough downwards and the modulation or drift are reduced to zero and then inverted.

If you double-click a note with the Pitch Modulation Tool or the Pitch Drift Tool, you will restore the 

pitch modulation or drift of the original recording, assuming you’ve changed it, otherwise eliminate it 

altogether. Subsequent double-clicking toggles between the original modulation or drift and none. If 

you eliminate altogether both the modulation and the drift, you will get an unnaturally flat monotone 

that can be suitable for effects.
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The inspector for pitch modulation and drift

As an alternative to editing selected notes with these tools, you can enter the desired values in the 

inspector alongside the toolbar or in the Note Inspector. Drag the existing value to change it or double-

click on it and type in the value desired.

With the Pitch Modulation Tool or the Pitch Drift Tool selected, the inspector displays values in 

percentage terms. 100% represents in this case the original modulation or drift, 0% a straight line, 

and -100% the same curve inverted with its axis unchanged. If you have selected several notes with 

different values, a dash is displayed in the box – followed, as you click in the box and drag, by values 

describing the extent of the relative change.

The Reset commands

In the Edit > Reset Individual Edits > Pitch cascading menu, you will find a variety of commands that 

can be used to reverse the effects of particular types of pitch editing, thereby restoring the notes 

selected in specific respects to their original state. These commands relate always to the current 

selection and are grayed out if no editing of the type in question has been applied to the selected 

notes. Note that these commands operate independently of the normal undo function.
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Formant Tool

Formants are areas of emphasis or attenuation in the frequency spectrum of a sound that are 

independent of the pitch of the fundamental note but are found always in the same frequency ranges. 

They are characteristic of the tone color or ‘timbre’ of each sound source, and interesting effects can 

be produced by shifting them, such as making a man’s voice sound like that of a woman, and vice 

versa.

Shifting formants

Select the Formant Tool from either the toolbox or the context menu of the Note Editor or by pressing 

the [F3] key of your computer keyboard. (If you wish to assign a different shortcut to this tool, you 

may do so after choosing Melodyne > Preferences > Shortcuts > Editing Tools from the main menu.) 

A beam appears over the blobs indicating the extent (if any) to which the formants have been 

transposed from their original pitches.

With the tool selected, click on a note and – without releasing the mouse button – drag the mouse up 

or down. As you do so, the formants will be transposed upwards or downwards, the degree and 

direction of the movement being indicated by a corresponding vertical movement of the beam.
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The beams indicate the distance in cents (100 cents = 1 semitone) by which the formants have been 

transposed upwards or downwards. You can shift the formants a few cents (for the finest of nuances) 

or several thousand (for a drastic denaturing of the sound). Double-clicking on a note with the 

Formant Tool restores its formants (as well as those of any other notes selected) to their original 

pitches.

The inspector for the formants

As an alternative to editing selected notes with the tool, you can enter the desired values in the 

inspector, which you will find alongside the toolbox or in the Note Inspector. Drag the existing value to 

change it, or double-click on it and type in the value desired.

If you have selected several notes that differ in the amount of formant shifting that has been applied 

to them, a dash is displayed – followed, as you click in the box and drag, by values describing the 

extent of the relative change.
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Formant transitions

A thick orange line appears between the formant beams of adjacent notes as soon as you shift the 

formants of one note more, or in a different direction, than those of the other. This line represents the 

formant transition between the two notes.

If you move the Formant Tool to the end of the first note, it changes into the Formant Transitions 

Tool. Dragging vertically with this tool governs the speed of the formant transition, which is indicated 

by the steepness of the connecting line.

Formant transitions only exist in the case of adjacent notes between which there is a soft note 

separation. If you transform this into a hard note separation by double-clicking with the Note 

Separation Type Tool (the sub-tool of the Note Separation Tool), all association between the notes 

will be severed and the formant transition between them deactivated.

The Reset commands

In the Edit > Reset Individual Edits > Formants cascading menu, you will find a pair of commands that 

can be used to reverse the effects of any shifting of formants or editing of formant transitions you may 

have performed, thereby restoring the notes selected in these respects to their original state. These 

commands relate always to the current selection and are grayed out if no editing of the type in 

question has been applied to the selected notes. Note that these commands operate independently of 

the normal undo function!
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Amplitude Tool

The Amplitude Tool allows you to adjust the amplitude (i.e. volume) of the selected notes, edit the 

amplitude transitions between them, and mute them.

Editing amplitude

Select the Amplitude Tool from either the toolbox or the context menu of the Note Editor or by 

pressing the [F4] key of your computer keyboard. (If you wish to assign a different shortcut to this 

tool, you may do so after choosing Melodyne > Preferences > Shortcuts > Editing Tools from the 

main menu.)

With the tool selected, click on a note (or one of several notes selected) and – without releasing the 

button – drag the mouse up or down. The vertical depth of the blobs will increase or decease as the 

notes they represent get louder or softer.

The gearing of the amplitude adjustment is dependent upon the vertical zoom resolution. Press and 

hold the [Alt] key, to switch to smaller increments for finer adjustment.
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Editing amplitude using the inspectors

As an alternative to editing selected notes with the Amplitude Tool, you can enter the desired values 

in the inspector to the right of the toolbar or the Note Inspector. Drag the existing value to change it or 

double-click on it and type in the value desired. Press and hold the [Alt] key, to switch to smaller 

increments for finer adjustment.

If you have selected several notes to which different amplitude adjustment has been applied, a dash 

is displayed in the box – followed, as you click in the box and drag, by values describing the extent of 

the relative change.

Amplitude transitions

A thick orange line appears between connected notes as soon as you change the amplitude of one 

note more, or in a different direction, than that of the other. This line represents the amplitude 

transition between the two notes. If you move the Amplitude Tool to the end of the first note, it 

changes into the Amplitude Transitions Tool. Dragging vertically with this tool governs the speed of 

the amplitude transition, which is indicated by the steepness of the connecting line.

Amplitude transitions only exist in the case of connected notes between which there is a soft note 

separation. If you double-click on the separation with the Separation Type Tool (which you will find 

beneath the Note Separation Tool in the toolbar), you turn the soft note separation into a hard one, 

thereby disconnecting the two notes and deactivating the amplitude transition.
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Muting notes

Double-clicking with the Amplitude Tool on one or more selected notes mutes them. Only the outline 

of the blobs is now shown, to indicate that the notes in question have been muted, but you can still 

select and edit them. A further double-click unmutes the muted notes.

In the Note Inspector, you will find a button marked Note Off for this function. Click once on the button 

to mute the selected notes. Clicking them a second time unmutes them.

The reset commands

In the Edit > Reset Individual Edits > Amplitude cascading menu, you will find two commands that can 

be used to reverse the effects of the two types of amplitude editing we have just described (thereby 

restoring the notes selected in certain respects to their original state) as well as the Unmute 

command, which is self-explanatory. These commands relate always to the current selection and are 

grayed out if no editing of the type in question has been applied to the selected notes. Note that these 

commands operate independently of the normal undo function.
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Tools for fades and sibilant balance

Beneath the Amplitude Tool, there are further tools offering still greater control over volume ratios 

within a track.

The Fade Tool: Fade-in and fade-out on notes

Activate the Fade Tool from either the toolbar or the context menu of the Note Editor or by pressing 

the [F4] key on your computer keyboard twice in quick succession. If you would prefer to use some 

other keyboard combination to activate this tool, you can easily define an alternative from the 

Shortcuts page of the Preferences dialog.

Using the Fade Tool, you can implement a fade-in at the beginning of a note and – quite 

independently – a fade-out at the end.

For the former, click with the tool at the left-hand end of a note, hold the mouse button and drag to the 

left or right. As you do this, a triangular handle will appear, the length of which changes as you move 

the mouse.

At the same time, the shape of the blob will change, indicating a corresponding change in its 

loudness contour.
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As an alternative to clicking, holding the mouse button and dragging, you can create a new fade by 

double-clicking. If you double-click on the first half of a note, you will create a fade-in. To create a 

fade-out, double-click on the second half of the note.

As soon as a fade-in is created, any soft separation between the note in question and the preceding 

note will be replaced by a hard separation. With a fade-out, a hard separation will be inserted 

between the note that fades out and the one that follows.

If you double-click on a fade, it is removed and the blob regains its original dynamic contour. An 

alternative method of restoring the original dynamic contour of a note is by a right-clicking and 

choosing “Discard Fades” from the context menu. Whichever method you choose, please note that 

whilst this removes the fade, the hard separation remains in place. To replace this with the original 

soft separation, you must use the Separation Type Tool.

You can also select and apply fades to multiple notes simultaneously and adjust them simultaneously 

as well.

To change the length or curve of a fade, proceed as follows:

To change the length, click on the fade in question and drag to the left or right.

To change the curve, click on the curve and drag upwards or downwards.

If you drag the end of a fade-in so far to the right that you reach the start of any fade-out that may 

have been applied to the note, you can still carry on dragging; all that will happen is that the fade-in 

will be extended and the fade-out shortened accordingly. 

You can also make a fade-out longer by extending it leftwards, but in this case no further than the 

point where it meets any fade-in that may be present.

It is not possible for a fade-in and a fade-out to overlap.
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Fades in conjunction with other tools

The length of a fade is not defined in milliseconds but tied to the position (set by you) within the note. 

So if, for example, a note with a fade-out is later lengthened using the Time Tool, the fade-out will be 

lengthened by the same amount. This gives rise to considerably more musical possibilities – 

particularly in combination with the other tools – than those afforded by the fixed fades offered by 

DAWs for regions or clips.

A further example: fade-outs continue, naturally, until the end of the note. If, however, towards the 

end of a note there is some unwelcome noise on the track, and you wish the fade out to end before 

this, you can split the note using the Note Separation Tool, delete (or mute) the part of the note to the 

right of the separation and then apply a new fade out to the part of the note that remains.

As a result of the placing of a fade, a hard separation will automatically be inserted between the note 

in question and the one that follows. It is therefore easy to create an overlap with the Time Tool 

between previously adjacent notes and then – using the Fade Tool – create a very musical crossfade 

between them.

The Sibilant Balance Tool: The management of sibilants and breath noise

Select the Sibilant Balance Tool from either the tool bar or the context menu of the Note Editor or by 

pressing the [F4] key on your computer keyboard three times in quick succession. If you would prefer 

to use some other keyboard combination to activate this tool, you can easily define an alternative 

from the Shortcuts page of the Preferences dialog.
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With the Sibilant Balance Tool, you can control the loudness of the sibilants relative to the other 

components of the sound. It is only available with the algorithms Melodic or Percussive Pitched; with 

all other algorithms it is grayed out.

In the case of vocal tracks, Melodyne regards as sibilants not only “s” and “ch” sounds, but also 

certain other word fragments such as “k” and “t” as well as the sound of the singer inhaling or 

exhaling between words: those components of the sound, in other words, that lack a definite pitch. 

Broadly speaking, and if we include instrument tracks, Melodyne regards as sibilants all parts of the 

signal that consist essentially of noise.

If you drag upwards (positive values) from a note or selection of notes with the Sibilant Balance Tool, 

you reduce the volume of the pitched components of the sound. If you drag downwards (negative 

values), it is the sibilants that become quieter.

At the two extreme settings in the case of vocals, you will either hear sibilants and breath noise only 

(if you drag upwards) or only the pitched components of the sound (if you drag in the other direction). 

This would admittedly create the impression of a pronounced lisp, but there are certain applications in 

which such extreme settings make sense (see below).

Double-clicking with the Sibilant Balance Tool sets the parameter to -100%, which is equivalent to 

maximum attenuation (i.e. muting) of the sibilants; a second double-click, resets the parameter to 0%, 

thereby restoring the note to its original state.
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Please note that in speech or singing it is not the case – from a technical standpoint – that the sound 

at any given instant is invariably  sibilant  pitched; sometimes it is a little of both – i.e. the either or

overall sound is a blend of pitched and unpitched components. Fortunately, the Sibilant Balance Tool 

operates in a way that takes this into account, governing only the noise components of the sound. 

Such an approach makes eminently good sense musically – fortunately  compromising the without

intuitiveness of the software, as you still see only one blob per note, not two.
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Uses for the Sibilant Balance Tool

When individual sibilants become obtrusive (which is more often a problem with some singers than 

with others – though a poorly designed or adjusted signal chain at the recording stage could be the 

real culprit), you would ordinarily turn to a de-esser. But adjusting the controls of a de-esser can be 

tricky, as de-essers invariably act upon the entire signal. This can have a negative influence even 

upon sibilants that were perfectly OK; furthermore, the pitched components of the sound necessarily 

feel their influence as well. The Sibilant Balance Tool (with values somewhere between -40% and 

-10%) takes considerably less time to set up, operates with far greater precision, and also, at the end 

of the day, delivers acoustically superior results.

In the case of backing vocals or when double-tracking, you could even use settings of around -80%. 

Heard on their own, the voices affected might appear to lisp, but when the lead vocals are restored to 

the mix, the overall result is a much tidier sonic image in which – at the ends of words in particular – 

there is far less of the usual fluttering. This fluttering is most often the main problem with double-

tracking, and it becomes even more obtrusive when you apply delays and reverb to the various 

voices – as you must, in fact, to ensure they sit right in the mix. Very few mouse-clicks are now 

needed to bring these commonly encountered mixing problems under control; all you have to do, 

basically, is select all the notes of the backing vocals, then set the sibilant balance to somewhere like 

-80%.

And a further tip for sound design and mixing: Begin by duplicating the vocal track. On one track, set 

the sibilant balance to -100% (in which case you will no longer hear any sibilants or breath noise) and 

on the other track, set the same parameter to +100% (so, on this track, only the sibilants and breath 

noise will be audible). Now set the same volume level for both tracks in the mixer, so initially you have 

exactly the same signal as before – only split between two tracks. This leaves you free to make 

intensive use of the effects chain (delays, reverbs etc.) on the sibilant-free track, and only sparing use 

– or none whatsoever – on the track containing the sibilants.

Note: Melodyne detects automatically the exact location and length of each sibilant. This means that 

with the vast majority of vocal tracks, you will no longer need to give the matter any thought; your only 

concern now will be to find the ideal balance between the pitched and unpitched components of the 

sound using the Sibilant Balance Tool. Nonetheless, in exceptional cases or for experiments in sound 

design (and not only with vocals), you may wish, on occasion, to adjust the results of the sibilant 

detection. To do this, enter Note Assignment Mode and select the Sibilant Range Tool, the use of 

which is described in detail .here
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Timing Tool

The Timing Tool allows you to edit the horizontal position and length of notes with or without 

quantization.
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Modifying the position and length of notes

Select the Time Tool from either the toolbox or the context menu of the Note Editor or by pressing the 

[F5] key of your computer keyboard. Press the [F5] key twice or three times in quick succession to 

select, respectively, the first or second sub-tools of the Time Tool. (If you wish to assign a different 

shortcut to this tool, you may do so after choosing Melodyne > Preferences > Shortcuts > Editing 

Tools from the main menu.) There, if you wish, you can also define separate keyboard shortcuts for 

all three tools.

Click the center of a note (or of one of a number of selected notes) and drag it to the left or right to 

move the entire note (or notes) horizontally. Press and hold the [Alt] key during the movement if you 

wish the time grid to be temporarily ignored to permit finer adjustment.

If you only wish to move the beginning of a note but not the end, click on the front part of the note and 

drag. Depending on the direction of movement, the note will be time-stretched or -compressed. Press 

and hold the [Alt] key if you wish the Time Grid to be ignored when editing. Stretching and squeezing 

also acts upon either a single note or a multiple selection of notes according to choice.

In the same way, you can move only the rightmost part of the blob (which corresponds to the end of 

the note) or selection of blobs to stretch or squeeze the corresponding note or notes.
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Timing changes in the case of connected notes

Notice that as you move the beginning or end of a note in this way, the preceding or following note, if 

adjacent, is either stretched or compressed by the same amount to avoid either the two notes 

overlapping or white space (silence) appearing between them. This is invariably the case when one 

note follows directly on from another and there is a soft note separation between them. By moving the 

adjacent note as well in this way, Melodyne prevents discontinuities occurring and preserves the 

musicality of the phrasing.

You can, if you wish, deactivate the connection between consecutive notes by transforming the soft 

note separation between them into a hard separation. This is done by clicking on it with the 

Separation Type Tool (which is a sub-tool of the Note Separation Tool).

All connection between the two notes will also be forcibly severed if you cut one of the notes and 

paste it into a different location.

In both cases, when the note separation line between the two notes is replaced by a square bracket, 

it means that the notes are no longer connected.

If you move one of the two notes far enough from the other using the Timing Tool, the link between 

them will also “snap”. In this case, however, if you move it back, the original link will be restored – 

provided the position of the other note has not been moved in the meantime.
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Correcting timing with a double-click

If you double-click with the Time Tool on a note (or one of several selected notes), you quantize this 

(or these) to what Melodyne, in the course of the detection, considered to be the ‘intended’ note (or 

notes). To see these (displayed as little gray frames beneath the blobs), choose “Options > Note 

Editor > Show Intended Notes”.

The gray frames are not necessarily (all) aligned with the grid selected in the Bar Ruler. One intended 

note, for example, might coincide with a line belonging to the 16th note grid, another with one 

belonging to an 8th note triplet grid, and so on. The result of double-clicking is therefore more 

‘intelligent’ musically (and thus, in practice, more suitable) than simple quantization, say, to 8th notes, 

with which, if you use a MIDI sequencer, you are perhaps more familiar.

There may be applications, however, in which you might actually prefer rigid quantization to a 

particular uniform grid. In that case, you can achieve the desired result with the Quantize Time macro, 

the use of which is described in detail . You will also learn there how note lengths are in this tour

adjusted during quantization as well as what options exist for the quantization of chords.
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Adding random deviations

With the commands in the Edit > Add Random Deviations sub-menu, you can randomly alter the 

timing of the notes currently selected – introducing either slight, moderate or drastic deviations from 

the original timing. You can also employ the commands several times in succession to intensify the 

effect. These commands are useful when, for example, you’ve doubled a track in order to obtain a 

fuller or ‘fatter’ sound. By introducing random deviations, so that the copy is no longer identical to the 

original, you can simulate more realistically the effect of two performers playing or singing in unison. 

All these commands affect only the selected notes and are therefore grayed out if no notes are 

selected.

The reset commands

In the Edit > Reset Individual Edits > Time sub-menu, you will find a number of commands that can 

be used to reverse the effects of whatever editing has been performed on the timing. These 

commands apply always to the current selection and are grayed out if no editing of the type in 

question has been performed on the notes selected. Note that these reset commands work quite 

independently of the normal Undo command.
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Time Handles and Attack Speed

The Time Handle Tool and the Attack Speed Tool are found below the Timing Tool in the toolbar. 

Their purpose is to allow you to adjust the internal time path and envelope of notes.

How time handles and the Attack Speed Tool work

Time handles are handles you can affix to particular stages in the evolution of a note and drag 

sideways in order to advance or retard their attainment. In this way, you can accelerate or slow down 

particular phases of a note’s development in order to fine-tune the musical phrasing.

The Attack Speed Tool also affects the speed at which a note evolves: either by stretching and 

slowing down its early development phase and thereby accelerating its later development, or vice 

versa.

The result is either a slower, softer attack or a faster, harder one. The ‘perceived’ musical starting 

point of the note, however, remains unchanged.

Modifying the evolution of notes using time handles

The Time Handle Tool is the first of the two sub-tools of the Time Tool. To select it, press the [F5] key 

twice in quick succession. (If you wish to assign a different shortcut to this tool, you may do so after 

choosing Melodyne > Preferences > Shortcuts > Editing Tools from the main menu.) There, if you 

wish, you can also define separate keyboard shortcuts for all three time tools.

Zoom in on the note you wish to edit, so that you can see it clearly and position the time handles 

more precisely. Now double-click the point in the note’s evolution that you wish to advance or retard. 

A time handle will appear that you can move forwards or backwards in time by dragging the tool 

respectively upwards or downwards. Since the overall length of the note remains unchanged, the 

result is to shorten and accelerate the phase of the note’s development lying to one side of the time 

handle while lengthening and slowing down the phase the other side.

http://helpcenter.celemony.com/M5/?lang=en&startPageEdition=melodyne-studio
http://www.celemony.com


Melodyne 5 studio - Live 12.0

   © Celemony Software GmbH 2024 • Last updated on 06/19/2024 • Help Center • www.celemony.com 185

You can attach multiple time handles to a single note, moving each one individually, thereby 

influencing fine details of the note’s evolution. There is no limit to the number of time handles that can 

be attached to a single note. Melodyne does, however, impose constraints as to how close to one 

another the handles can be placed. If ever you find you cannot place a time handle exactly where you 

want it, try a little further along.

If you select multiple time handles using the usual selection techniques, you can move them all en 

bloc.

Double-clicking on a time handle or a selection of time handles removes them, thereby causing the 

affected phases of the note to evolve at their original speeds.

By choosing Edit > Reset Individual Edits > Time > Remove Time Handles from the main menu, you 

can remove the time handles from all the selected notes.
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Changing the attack speed of notes

The Attack Speed Tool is the second sub-tool of the Time Tool. To select it, press the [F5] key three 

times in quick succession. From the Preferences dialog, you can also, if you wish, define a separate 

keyboard shortcut for this tool.

Please note that this tool has no function when the Universal algorithm is selected. You will notice 

therefore that the corresponding blobs lack handles and that the Attack Speed field in the Note 

Inspector for these blobs is grayed out.

When you select the Attack Speed Tool, a white dot appears at the start of every note. If you now 

place the tool anywhere on a note (not necessarily on the dot) and drag vertically, the dot will move 

up or down.

If you move it upwards, the attack phase of the note will be compressed and play back faster, but the 

rest of the note correspondingly more slowly. The note will therefore have a harder attack; its peak 

amplitude will be reached more swiftly.

If you move the point downwards, the opposite will occur. The beginning of the note will be stretched 

– even beyond its visible starting point – and will play back more slowly, the rest, however, 

increasingly rapidly. The attack will therefore be softer. Note that the position of the musical start of 

the note indicated by the orange anchor is not affected by changes in attack speed. The ‘perceived’ 

start of the note is therefore independent of the attack speed. The end of the note is in all cases 

unaffected.
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You can vary the attack speed of notes individually, in order to accentuate them. You can also, 

however, select and modify the attack speeds of multiple notes simultaneously and thereby alter the 

timbre of an entire phrase.

If you double-click on a note or one of a selection of notes with the Attack Speed Tool, the 

corresponding parameter will return to its neutral (central) position. The same result can be achieved 

by choosing Edit > Reset Individual Edits > Time > Reset Attack Speed from the main menu.

Combining time handles with the Attack Speed Tool

You can combine the use of time handles with that of the Attack Speed Tool. Altering the attack 

speed in this case will cause the time handles to move, functioning as a kind of timing master. You 

can therefore shape the evolution of the note to enhance the phrasing before adjusting the overall 

timing (so that the note starts faster or more slowly) with the Attack Speed Tool.
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Note separation tools

With the Note Separation Tool, you can cut notes as well as removing and moving note separations. 

With the Separation Type Tool, you can switch between hard and soft separations.

Inserting, moving and removing note separations

Select the Note Separation Tool from either the toolbox or the context menu of the Note Editor or by 

pressing the [F6] key of your computer keyboard. (If you wish to assign a different shortcut to this 

tool, you may do so after choosing Melodyne > Preferences > Shortcuts > Editing Tools from the 

main menu.)

By double-clicking within a note with the Note Separation Tool, you can introduce a note separation 

and thereby slice the note in two.

Don’t be surprised if the resulting pair of notes move apart in pitch; this is because as soon as the 

fission occurs a new tonal center is calculated for each of the newly created notes, and their 

respective tonal centers may differ from the tonal center the notes shared when they were one. In 

such cases, each therefore moves to a new vertical position based on its newly calculated pitch 

center.

You can move an existing note separation horizontally simply by dragging it with the Note Separation 

Tool.

You can double-click a note separation to remove it.
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Editing note separations with multiple notes selected

If you select several notes and move a note separation, the note separations of the other selected 

notes will also be moved. If you double-click one of the note separations to remove it, the note 

separations of the other selected notes will also be removed.

If you have selected several notes that overlap, you can insert a note separation in the same place in 

all of them simultaneously as well as move or remove one.

Soft and hard note separations

Depending upon the audio material and the algorithm selected, Melodyne places either soft or hard 

separations between notes. Soft separations only occur between consecutive notes and provide a 

link between the notes: if the end of the first note is moved, the beginning of the second note moves 

along with it, to ensure that no gap opens between them. This helps you preserve phrasing when 

editing.

The connection between notes also plays a role in the pitch, formant and amplitude transitions 

between notes: such transitions are only possible in the case of connected notes between which a 

soft separation exists.

In the case of a hard separation, consecutive notes are independent of one another. This means that 

changing the length of the first note has no affect upon the position of the second. It also means there 

are no pitch, formant or amplitude transitions between the two notes.

Soft separations are indicated by a thin vertical line between notes, whereas hard separations are 

denoted by a bracket.
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Switching between hard and soft separations with the Separation Type Tool

The Separation Type Tool is the sub-tool of the Note Separation Tool. It allows you to toggle between 

hard and soft separations. To select it, press the [F6] key (assigned by default to the note separation 

tools) twice in quick succession. If you would prefer to use some other key combination, choose 

Preferences -> Shortcuts -> Editing Tools -> Note Separation Tools and press the keys of your 

choice. If you wish, you can define separate keyboard shortcuts for each of the two tools.

Double-click on a separation with this tool in order to change its type.

Please note that it is only with certain separations that the option of switching freely between ‘soft’ 

and ‘hard’ exists.

Soft separations can always be turned into hard ones.

Hard separations, however, can only be turned into soft ones if they were soft to begin with 

and their type has subsequently been changed. An exception to this rule is material detected 

using the Percussive algorithm; in this case, all separations are initially hard but can be turned 

into soft ones.

In the context menu: Separate Note

This command separates notes automatically at a point determined by Melodyne. It can be used, for 

example, to slice up a vocal passage into small segments in order to prepare the way for extremely 

detailed editing using the tools.

You will find the “Separate Note” command in the context menu of the Note Separation Tool and on 

the “Shortcuts” page of the Preferences property sheet, where you can assign a keyboard shortcut to 

it.
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In the context menu: Separate Notes as Trills

When the Note Separation Tool is selected, you will find the command “Separate Notes as Trills” in 

the Note Editor’s context menu. The effect of this is to slice a selection of one or more notes into 

smaller segments determined by the instantaneous pitch of each note. This is done by inserting note 

separations into the slopes of the pitch curve as it rises and falls, thereby turning each ‘hill’ and each 

‘valley’ of a vibrato into a separate note.

The use of this command allows you, for example, to improve the intonation of a trill, by tuning the 

notes more closely to their intended pitches, or to rein in an unruly vibrato, by applying the Correct 

Pitch Macro to its upper and lower extents.

Please note that the fluctuations in the Pitch Curve must be fairly pronounced for the “Separate Notes 

as Trills” function to have any effect and that it is only available when the Melodic algorithm is active, 

being grayed out in every other case. If you wish to assign a shortcut to the command “Separate 

Notes as Trills”, this can be done using the Preferences dialog.

In the context menu: Merge notes

This command is used to merge a  note with the one that follows by removing the separation at single

the end of the note selected.

If more than one note is selected, the command is grayed out.
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The Note Inspector

The Note Inspector in the info pane offers you an overview of the parameters of the selected note(s) 

and allows you to alter the values.
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The parameters of the Note Inspector

The Note Inspector brings together the inspector fields that are usually displayed near the toolbar 

when the various tools are in use. It allows you to see all the most important parameters at a glance 

and even edit them without having to change tools.

In addition to the data included in the inspector fields, the Note Inspector displays the frequency in 

hertz as well as a button for the muting of notes.

The editable parameters displayed in the Note Inspector are (from top to bottom):

the pitch of the selected note in semitones, cents and hertz

the pitch modulation expressed as a percentage

the pitch drift expressed as a percentage

the formant shift in cents

the amplitude in decibels

the button for muting and unmuting notes

the attack speed expressed as a percentage

the sibilant balance

Lower down in the inspector, you can see to which audio file the selected note belongs and which 

algorithm was used for the detection.
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Entering values and handling multiple selected notes

When only one note is selected in the Note Editor, the Note Inspector displays the concrete values for 

that note.

As a general rule, you can modify all values either by clicking in their respective fields and dragging 

the mouse pointer upwards or downwards or by double-clicking in the field and typing in a new value.

In the case of the Pitch field, you can enter either an absolute (C3, D4 etc.) or a relative (+2, -1, etc.) 

value. In the other fields, it is always the absolute value that is adopted.

If you have selected multiple notes, the Note Inspector will only displays concrete values for 

parameters if these are shared by all the selected notes. Where values differ, a dash “–” is displayed 

in the relevant field.

If a dash is displayed, by clicking on it and dragging, you can alter the individual values of all the 

notes selected by the same amount; in this way, for example, you could transpose an entire selection 

up two semitones. The Scale Snap function, of course, if activated, will govern the eventual 

destination of the various notes.

As you drag the values, Melodyne remembers the difference between them. This is even true when 

certain parameters ‘collide’ with their maximum or minimum values; provided you keep the mouse 

button pressed and drag then in the opposite direction, the initial difference will be restored. Only if 

you release the mouse button at the point of collision will the initial difference be forgotten.

Alternatively, with multiple notes selected, you can type in a value that will then be assigned to, and 

thereafter shared by, all the selected notes (whereupon the dash, of course, will disappear).

An exception here is the pitch, as, if you type in the value “2”, for example, all the selected notes are 

shifted two semitones upwards. If you wish to assign the same pitch to all the selected notes, type in 

an absolute value, such as “C2”. If the Percussive or Universal algorithms are selected, of course, this 

has no effect, as these algorithms only know relative pitch.
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Copying notes

To copy notes in Melodyne, first select the desired notes, then choose Copy from the Edit menu or 

the context menu of the Note Editor. To insert them, use the Paste command. The following points 

here need to be noted.

The selection, cursor and grid when copying

When you copy notes to the clipboard using the Copy command, you will notice that the cursor 

moves to the start of the selection, or, to be more precise, to the quarter-note (crotchet) on the Time 

Grid closest to the first note of the selection.

If, with the notes still selected, you use the Paste command, all that appears to happen is that the 

notes that were selected prior to the paste are now no longer selected and the cursor is now located 

just after the last of them.

In fact, however, the notes previously selected have been replaced by those on the clipboard. In other 

words, the notes have been copied onto themselves, with the copies replacing the originals. 

Admittedly, this may not sound particularly useful, but look at the position of the cursor: it is now 

aligned with the quarter-note on the Time Grid closest to the last copied note.

If you now execute a further Paste, the notes on the clipboard will be pasted a second time. This time, 

however, since no notes were selected, nothing will be replaced. Instead, the newly pasted notes will 

end up just after those that replaced the originals the first time round.

Their position is now determined by the cursor. And since, after the first paste, this was aligned with a 

quarter-note on the Time Grid (the first quarter-note after the pasted notes, to be specific), the effect 

of the second paste is that the original alignment of the notes relative to the gridlines is reproduced 

exactly, only further along the timeline. This behavior allows you to string together a succession of 

copies of the same passage, quickly and accurately – in order, for example, to create multiple 

iterations of a drum loop.
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Based on what we have just seen, we can formulate the following rules:

If any notes are selected when the Paste command is executed, these are replaced by the 

contents of the clipboard. The pasted notes are stretched or squeezed until they fit exactly the 

range from the beginning of the first to the end of the last note of the selection. This is 

illustrated here: on the left are the notes to be copied; in the centre, a single selected note, 

which serves as the destination of the copy; on the right is the result after the paste is 

performed: The selected destination note has been replaced and the pasted notes squeezed 

just enough for them to fit exactly the space it occupied.
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If when the Paste is executed no notes are selected, the cursor determines the point at which 

the pasted passage begins. The grid settings here play an important role: when copying notes 

to the clipboard, Melodyne remembers the distance between the first of the copied notes and 

the nearest grid line. When the paste is repeated at the new cursor position, the offset of the 

first pasted note to the gridline nearest to  will be exactly the same.it

In other words, notes in Melodyne are not copied in such a way that they necessarily coincide with 

gridlines, because then the subtleties of expression would be lost. Instead, the notes copied retain 

their respective offsets to the grid. There is an exception, however, to this rule: if, instead of being 

calibrated in beats, the grid is calibrated in seconds (i.e. if you have selected “Sec” from the Time 

Grid Settings drop-down menu to the right of the Time Ruler), then the note (or first of a series of 

copied notes) will begin exactly at the cursor position, with no offset.

After each paste, the cursor is moved to the first quarter-note following the most recent paste, 

making it easy to string together multiple iterations of the same passage. Obviously, if you 

wish, you can move the cursor by hand to some other point on the Time Ruler and make that, 

rather than the automatically selected quarter-note, the reference point for the next paste. You 

might want to do this, for instance, to introduce a pause between iterations.

The pitch of the copied notes is always the same as that of the originals. This is even true 

when notes are selected, and therefore replaced, when the paste is performed. The length of 

the passage selected, in this case, is retained but the original pitch of the notes it contained is 

not. Of course, after performing the paste you can move the notes by hand to any pitches you 

like.
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Tempo adjustment when copying: the Auto Stretch Switch

If notes are selected when the paste is performed, the inserted passage will be stretched or squeezed 

to fill the available space (i.e. that between the beginning of the first selected note and the end of the 

last) as we have already seen. But how is the tempo of the copied passage treated when the position 

of the paste is determined instead by the cursor?

If the tempo at the destination of the paste is different from that of the passage from which the notes 

were copied, it is the status of the Auto Stretch Switch that determines whether the pasted notes 

adjust to the tempo of the destination or retain their original tempo. If the Auto Stretch Switch is on, 

they adjust; if it is off, they do not. So unless you want to change the tempo at the cursor position, you 

should switch Auto Stretch on before performing the paste.

If the tempo of the source is different from that of destination, and the material on the clipboard is 

adjusted to the new tempo, the pasted version will obviously sound different to the original. If you 

want to avoid this happening, however, in the stand-alone implementation of Melodyne, you can copy 

not only the notes but also the tempo (including any sudden or gradual tempo changes within it) from 

the source to the destination. In this case, it makes no difference which you copy first: the notes or 

the tempo.
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Copying in a multi-track context (without ARA)

In Melodyne studio you can see, select and edit notes from different tracks at the same time in the 

Note Editor – and even copy them. Provided after selecting the notes and executing the Copy 

command, you do not exit the Note Editor before performing the paste, the track assignments of the 

notes selected will be preserved. If, for example, you select a bar from the bass guitar track and a bar 

from the lead vocal track and then paste them simultaneously to a different point on the Time Ruler, 

the notes copied from the bass track will be pasted into the bass track, and those copied from the 

vocal track will be pasted into the vocal track.

If you wish to paste the copied notes into tracks other than the original ones, before performing the 

paste you must select the desired destination tracks by clicking the relevant track headers, holding 

the [Shift] and/or [Command] keys where necessary.

Here, the following rules apply:

If there are the same number of destination tracks as source tracks, the notes will be copied 

accordingly; if the source tracks, for example, are numbered 1, 2 and 3 and the destination 

tracks 4, 5 and 6, the material copied from Track 1 will be pasted into Track 4, that from Track 

2 into Track 5 and that from Track 3 into Track 6, as you would expect.

If the material on the clipboard has been copied from multiple tracks but a single track has 

been selected as the destination, all the material will be pasted into that one track.

If the material on the clipboard has been copied from a single track but multiple tracks have 

been selected as destinations, the same notes will be copied into  the destination tracks all

(duplicating the material, in other words).

If no sensible correlation can be established between source and destination track(s), the 

Paste command will be grayed out.

The same rules apply if, instead of choosing Copy after making the selection, you choose Cut.
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The Edit menu

Melodyne’s Edit menu includes items that allow you to undo entirely the effects of various types of 

editing and others that add random deviations to the audio material.

Restore Original

The “Restore Original” sub-menu contains commands that nullify entirely the effects of various types 

of editing.

You will also find in the context menu of the Note Editor whichever of these commands are relevant to 

the tool you are using at the time.

All the commands (except the last one) apply  and are grayed out only to the notes currently selected

if no editing of the type in question has yet been applied to them. Bear in mind that these commands 

work independently of the normal “Undo” function.

The effect of the following types of editing can be undone entirely via the Restore Original sub-menu:

Pitch

the editing of pitch

the editing of pitch centers

the editing of pitch modulation

the editing of pitch drift

the editing of pitch transitions

Formants

the editing of formants

the editing of formant transitions

Amplitude

http://helpcenter.celemony.com/M5/?lang=en&startPageEdition=melodyne-studio
http://www.celemony.com


Melodyne 5 studio - Live 12.0

   © Celemony Software GmbH 2024 • Last updated on 06/19/2024 • Help Center • www.celemony.com 201

the editing of amplitude

the editing of amplitude transitions

the application of fades

adjustments to the sibilant balance

the muting of notes

Time

the editing of timing (position/length of notes)

the placing of time handles

the editing of attack speeds

The command “Undo All Changes” undoes entirely the effect of all the types of editing listed above 

but only applies to the notes currently selected.

The final command, “Undo All Changes to Entire File” has the same effect as “Undo All Changes”, 

differing only in that it applies even to notes not included in the current selection, thereby restoring the 

entire file to its original state.
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Adding random deviations

The Add Random Deviations sub-menu varies the pitch or timing of individual notes a) drastically, b) 

by a moderate amount, or c) in a subtle way; within these various limits, the direction and extent of 

the deviation is determined randomly.

These functions introduce random variation to either the pitch (i.e. the vertical position) or the timing (i.

e. the horizontal position) of the selected notes.

This is particularly useful when you have made one or more copies of a single take but do not wish 

them to be identical either to one other or to the original – the object being, perhaps, to make a single 

vocalist sound like a choir. Through the addition of a certain amount of random deviation to each 

copy, you can obtain more natural-sounding results by ensuring that the synchronization of the 

individual voices is never improbably perfect and that no two copies exhibit identical fluctuations in 

pitch.

Macros

The commands in this sub-menu open Melodyne’s various macro dialogs. The same effect can be 

obtained by clicking their respective icons, which are to the right of the toolbar above the Note Editor.

Select Special

The effect of the commands in the “Select Special” sub-menu is described in the  “Selecting Notes”

tour.

Chords and Keys

These commands can be used to trigger an analysis of the chords and keys encountered in the 

material.
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Copy commands for the detection data

The detection of tempo, chords and keys in Melodyne studio is conducted on two levels:

Initially, Melodyne analyses  as it is loaded, to detect and identify the notes and each individual file

tempos it contains; you can then optimize the results of this analysis, which we call the “note 

assignment data”, in Note Assignment Mode. That is the  level. A key (or ‘tonality’) is derived file

automatically from the notes found in the file.

If, however, you import several files into Melodyne simultaneously – the tracks of a multi-track 

recording, for example – then the higher  level comes into play. Here, Melodyne conducts a song

second analysis of the tempo, key and chords, based this time on information derived from all the 

tracks. The drum tracks, for example, will have little to say about the tonality but prove extremely 

useful when it comes to tracking the tempo. With the vocals, on the other hand, it will be the other 

way around. Because all the tracks are considered together, the song-level analysis delivers more 

comprehensive and accurate results.

Now, occasions may arise when you will wish to transfer the results of the more accurate, song-level 

analysis, to file level – for instance, when you are planning to export one track only, the vocals, to 

another song. The more accurate the information provided by the track’s note assignment data 

regarding the tempo and tonality of its musical content, the more successful will be its integration into 

the new song. With the command “Copy Song Data to Note Assignment”, you can improve the 

accuracy of the file’s original note assignment data by sharing with it the conclusions drawn from the 

song-level analysis.

And the opposite case can also arise, when, after satisfying yourself that the file-level analysis is 

perfect, you will want to share its conclusions as to the tonality and tempo with the entire song. This 

can be done by choosing “Copy Note Assignment Data to Song”.

To use either of these commands, first make sure the track in question is in the Note Editor and, if 

more than one track is present there at the time, select one of its notes. Then choose the command 

you want from the menu. A small dialog will appear, inviting you to specify precisely which of the 

three types of data (tempos, keys and chords) you do and do not want copied.
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Audio to MIDI

From this tour, you will learn how to save audio notes in Melodyne as MIDI notes.

About Audio-to-MIDI

Melodyne allows you to export audio notes as MIDI notes, in order, for example, to double your 

vocals with a sound from a software synthesizer.

The MIDI notes are an exact representation of the audio notes in Melodyne. For each audio note, a 

MIDI note is created with the same position, length and pitch. The velocity of each MIDI note is 

derived from the amplitude of the audio note it represents.

That is equally true whichever algorithm is used, with a few algorithm-specific exceptions: In the case 

of vocals, breaths are not exported as MIDI notes; and if you save rhythmic material or material 

edited with the Universal algorithm as MIDI, all the MIDI notes will share the same pitch but take their 

position, length and amplitude from their audio equivalents in the rhythm track. You can use this 

technique, for example, to derive from a drum loop a quantization reference for other MIDI tracks in 

your DAW.

The generation of MIDI notes from audio material offers a wealth of different creative possibilities. Try 

it out for yourself!

Exporting MIDI

Melodyne always exports the notes currently displayed in the Note Editor. By activating the 

corresponding Edit buttons in Melodyne’s track list, you can therefore export a selection of tracks 

simultaneously. In this case, a single shared MIDI file will be created for all the instances, with a 

separate MIDI channel assigned to each instance.

From the “Settings” menu, choose “Save as MIDI…”. In the file selection box that appears next, you 

can enter a name and a storage location for the MIDI file.

Now import this file back into your DAW onto a track with a MIDI or software tone generator.

The exported data comprises that of the entire track, even if this is composed of many different audio 

segments. However the export does not necessarily begin at Bar One but rather, in principle, with the 

first note on the track. Of course, the export range is expanded to ensure that when the file is 

imported into the DAW, you do not have to position it with sample accuracy on the audio, but simply 

align it with the exact beginning of the bar that contains the first note.
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Multitrack editing

In Melodyne studio, you can work with multiple tracks – in both the stand-alone and plug-in 

implementations. You can move from track to track with the utmost ease, and even see and edit 

simultaneously notes belonging to different tracks.

http://helpcenter.celemony.com/M5/?lang=en&startPageEdition=melodyne-studio
http://www.celemony.com


Melodyne 5 studio - Live 12.0

   © Celemony Software GmbH 2024 • Last updated on 06/19/2024 • Help Center • www.celemony.com 207

Multi-tracking in Melodyne

In Melodyne, multi-tracking has a particular meaning, because here you are working not simply with 

audio files but with notes. For this reason, it is in the Note Editor that Melodyne’s multi-tracking comes 

into its own.

Consider the case where you have one track containing vocals and a second track with a guitar 

accompaniment. As soon as you switch the vocal track to edit mode, the notes of which it is 

composed appear in the Note Editor. Now, if you switch the guitar track to reference mode, its notes, 

too, are displayed in the Note Editor. The guitar blobs in this case are gray and can neither be 

selected nor edited. They are simply displayed for the purpose of orientation in the background to the 

vocal notes. This makes following the melody child’s play.

What happens if, while you are editing the vocal track, you notice something on the guitar track that 

you would like to alter? No problem. Just switch the guitar track to edit mode or double-click one of 

the gray blobs and immediately the two tracks will swap roles: it will be the guitar blobs that are 

colored and capable of being edited while the vocal blobs are displayed in gray in the background.

And you can change tracks on the fly like this while working with any number of reference tracks. This 

makes it very easy for you to edit your audio material in the desired context not only acoustically but 

also visually. In this, you are supported by intelligent monitoring that allows you to control the volume 

ratios between the edited track, the reference tracks and all other tracks. Whenever you break off 

editing one track to edit another, the volume mix adjusts automatically.

But these are by no means all Melodyne’s multi-tracking capabilities: If you wish, you can even switch 

several tracks to edit mode at the same time, selecting, editing, deleting and copying notes across 

tracks. This is the case in both the stand-alone and plug-in implementations of Melodyne.

In the following sections, we will set out in detail the concepts underlying multi-tracking in Melodyne 

and show how to take full advantage of the possibilities it affords.
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Differences between the stand-alone and plug-in implementations

When Melodyne is running as a stand-alone application, multiple tracks are displayed in much the 

same way as in most DAWs: There is a list of track headers in the left-hand pane, with the audio files 

belonging to each track to the right of them.

In the plug-in implementation of Melodyne, multi-tracking is implemented as a collaboration between 

the DAW and the various instances of Melodyne. There, too, there is a list of headers on the left. In it, 

you will see which instance of the Melodyne plug-in is currently open, as well as any others inserted 

in the tracks of the current project. The idea behind this is to allow you to work at all times in  one

Melodyne plug-in window only, whilst being able to see and edit the contents of  instances.all

In the plug-in, there is no track pane containing audio material, since the audio material is already 

present on the tracks of the DAW. All you see, then, is the list of instances and the Note Editor.

The track headers

In the stand-alone implementation: Each track header displays the name of the track and a volume 

fader along with mute, solo and record enable buttons. The solo function is only ever active in the 

track whose solo button was clicked most recently. Hold down the [Command] key to solo multiple 

tracks. You can rename the track via the Track menu, the context menu in the track header pane, or 

the Track Inspector, which is described in the next section.
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The colored blob icon in the track header is the edit button, which causes the notes to be displayed in 

the Note Editor. Double-clicking on the contents of a track in the track pane has the same effect. If 

you click the edit button or double-click in the track region of another track, its notes will replace those 

of the first track in the Note Editor.

If you hold down the [Command] key now and click on the edit button of another track, the notes of 

this track too will be displayed as colored blobs in the Note Editor. You will then be able, if you wish, 

to select and edit the notes of  tracks simultaneously. Proceed in the same way to add the both

contents of further tracks to the Note Editor. Clicking on an edit button that it is already active 

removes the contents of the respective track from the Note Editor.

The gray blob icon in the header is the reference button that causes the notes of a track to be 

displayed in the Note Editor for reference purposes only. The resulting gray blobs can neither be 

selected nor edited. They are there in this case solely for purposes of orientation– for instance, to 

facilitate adjustments in pitch or timing. By clicking on further reference buttons, you can add the 

contents of further tracks to the Note Editor – again, purely for reference purposes – and remove 

them in the same way.

If you switch a reference track to edit mode – either by clicking its edit button in the track header or by 

double-clicking one of the gray blobs currently displayed for reference – the gray track will turn 

orange and the track that was previously orange, gray. Putting it another way: the two tracks will swap 

roles.

Right-clicking in the header opens a context menu offering the same commands as the main Track 

menu.

You can change the order in which tracks appear by dragging the track headers upwards or 

downwards as desired.
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In the plug-in: You see a header for every instance of Melodyne that you have opened in your 

project. There are no mute or solo buttons and no volume fader in the header, as these functions are 

already provided by your DAW. Instead you will see a Transfer button for every instance, and you can 

transfer-enable as many instances as you like swiftly from a single plug-in window.

The edit and reference buttons work in exactly the same way as in the stand-alone implementation 

and determine which contents in the Note Editor are available for editing and which displayed purely 

for reference. You can switch freely between the contents of the instances and, as in the stand-alone 

implementation, edit the contents of multiple instances simultaneously – e. g. by selecting and 

copying across tracks. All the time you can be working in the same Melodyne window; there is no 

need to switch to the window of another instance or open a second window. A small star on the left 

near the track title shows you, for the purpose of orientation, to which Melodyne instance the window 

in which you are working at any given moment belongs.

To leave more room for the info pane or Note Editor, you can hide the header pane in the plug-in by 

clicking the corresponding symbol, and show it again in the same way.

In the stand-alone implementation and with certain DAWs, you can rename tracks by right-clicking on 

the track header and choosing Rename Track from the context menu.

You will find this option grayed out, however, if your DAW is one that passes on track names to 

Melodyne, as the correct name will then already be displayed in the track header.

Similarly, with certain DAWS, as in the stand-alone implementation, you can change the order in 

which the tracks are displayed by dragging the track headers upwards or downwards.

This option, again, is grayed out if your DAW has passed on to Melodyne the order of tracks, as they 

will then already be displayed in the correct order.
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The Editing Mix Fader

When you are editing the notes of several tracks simultaneously in the Note Editor, the Editing Mix 

Fader is of great assistance. Our intention here was to provide you with the acoustic equivalent of 

focusing visually on particular blobs: when you are editing a track, you want to be able to concentrate 

entirely upon that track and not be distracted by others. Visually, that is easy to accomplish: You 

simply select one or two tracks to edit, show perhaps two or three others tracks in the Note Editor for 

reference, and hide the rest.

Acoustically, a similar focus is difficult to achieve. Naturally, you could solo the tracks being edited, 

but then you would lose the very reference that could best help you assess the intonation and timing 

of the tracks being edited. Ideally in this situation you would be able to employ an alternative mix: the 

track being edited would be the loudest; the tracks shown as reference would be somewhat quieter, 

and other tracks, quieter still or completely inaudible. You could accomplish this, of course, with the 

volume controls of the individual tracks, but the Editing Mix Fader makes it far easier.

If you move the Editing Mix Fader all the way to the left, you will hear only the track or tracks currently 

activated for editing in the Note Editor – in other words, the ones with the orange blobs. As you move 

the fader button gradually towards the center, the gray blobs displayed for reference will gradually 

become louder, until at the center position the colored and gray blobs will be equally loud. As you 

now move the button from the center position towards the right, the remaining tracks – i. e. those 

included in the arrangement but not displayed in the Note Editor – will gradually fade in.

In this way, you can quickly and easily arrive at the ideal acoustic balance between the notes 

displayed for editing, those displayed for reference, and the rest of the arrangement. 

Please note that the soloing and muting of tracks also effects the mix: Tracks that are displayed for 

reference or editing in the Note Editor but switched to mute (either directly or because another track 

has been soloed) are nonetheless audible when the Editing Mix Fader is between the extreme left 

and the center of its range. However, as the button is moved from the center towards the extreme 

right of its range (causing tracks not displayed in the Note Editor to become audible), the tracks 

switched to mute are faded out, so the soloing of tracks once again functions normally.
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As soon as you shift the focus from the Note Editor to the track pane by clicking in the latter, you will 

hear the entire arrangement once again; this is equivalent to the rightmost setting of the Editing Mix 

Fader. If you then click a further time in the Note Editor, the volume ratios will once again be 

determined by the Editing Mix Fader.

In the plug-in, the fader works on the same principle but with one small difference; If you start the 

DAW playback, the balance between all the tracks will be determined exclusively by the DAW’s own 

mixer. The Editing Mix Fader only intervenes when the DAW is stopped and you start local playback 

in Melodyne.

In this case, again, with the button hard left, only the colored blobs will be heard, the gray ones fading 

in gradually as you move towards the center, and the remaining tracks entering and becoming 

gradually louder as the button moves ever further to the right. The term ‘remaining tracks’ here, 

however, includes only those tracks the contents of which have been transferred to Melodyne. To 

hear literally  the tracks, unless all have been transferred, you must start the playback from within all

DAW.

The Editing Mix Fader is only operative when the focus is in the Note Editor – i. e. when the Note 

Editor is the pane clicked most recently. The pane with focus at any given moment is the one 

delineated by a thin orange frame.

Copying between documents, tracks and instances

You can copy notes in Melodyne freely between documents, tracks and instances. To copy notes 

from a track in the stand-alone implementation of Melodyne or an instance of the plug-in to another 

track or instance respectively, proceed as follows:

Select the desired notes and choose Copy.

Select the destination track or instance respectively by clicking its header.

Position the playback cursor by clicking in the Time Ruler and choose Paste.

To copy notes in the stand-alone implementation from one project to another, proceed as follows:

Select the desired notes and choose Copy.

Switch to the destination project and select the desired track e. g. by clicking in its track 

header.

Position the cursor by clicking in the Time Ruler and choose Paste.

You will find further information about copying in the tour entitled “Copying notes”.
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"Spread Unison Tracks"

When you are displaying several tracks simultaneously in the Note Editor, before long you may find 

certain notes overlapping, making it more difficult to see and edit the material. The switch shown 

here, which you will find near the bottom right-hand corner of the Note Editor, can be of assistance in 

such cases. What it does is separate and spread vertically the various tracks shown in the Note 

Editor – causing them to fan out, in other words – which makes it easier to see and select notes of the 

same pitch on different tracks. This obviously has no effect upon the actual pitch of the notes in 

question; only upon the way they are displayed. Since the Pitch Ruler provides only an approximate 

guide to the pitch of the notes when the tracks are fanned out in this way, the grey and white stripes 

in the background of the Note Editor (imitating the keyboard of a piano) disappear.

The Spread Unison Tracks switch can only be activated when several tracks are being displayed 

simultaneously in the Note Editor and their notes overlap.
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The Sound Editor – Introduction

With Melodyne, you can edit not only the pitch, timing, phrasing and tempo of your recordings in a 

unique manner but also their sound. The bandwidth extends from subtle tonal adjustments and 

coloring to applications of a highly experimental nature. All these possibilities can be found in 

Melodyne’s Sound Editor, which you will get to know in this tour.

The Sound Editor works on the spectral level and offers you extensive access to the overtone 

structure of the notes. In combination with Melodyne’s other functions, you can obtain results with it 

that no other tool offers.

Working with the Sound Editor requires no special knowledge. This tour and a willingness to 

experiment are all you need. If you do wish to learn more about the theoretical basis, however, one 

good place to start might be this article in Wikipedia.
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Opening the Sound Editor

Melodyne’s Sound Editor has its own pane, which you can open by clicking the button shown here or 

by choosing Show Sound Editor from the Options menu.

The Sound Editor can be used for all tracks the contents of which have been detected using the 

Melodic or Polyphonic algorithms. If the Universal or Percussive algorithm was used for the detection 

of your audio material, you will be unable to open it in the Sound Editor without first choosing 

“Melodic” or “Polyphonic” (Sustain or Decay) from the Algorithms menu followed by “Redetect”.

You can apply the same Sound Editor settings to multiple tracks or use different settings for each. 

Under certain circumstances it is also possible to use different settings within the same track – e.g., to 

make the guitar sound different during the intro from the way it sounds during the verse.

What decides which tracks or track segments are affected by which settings is ultimately a 

combination of two things: the notes selected and the recording history. To make all this intuitive, we 

need briefly to explain something of the technical background.
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The Sound Editor and the "audio source"

Suppose, to begin with, you record the bass and guitar simultaneously but on separate tracks; you 

might think of this as a single recording, since both parts were recorded at the same time, but, 

technically, you have created two audio files, not one. If you now do an overdub of the guitar – for 

instance, because you want to improve the first verse – you will end up, technically, with three files 

and, from Melodyne’s point of view, with three “audio sources”: the bass and the original guitar, both 

running the full length of the song, and the guitar overdub, covering the first verse only. (In the 

interests of simplicity, we are assuming you didn’t use multiple microphones to record the guitar, as 

then you would obviously have more than three files).

In the case of the transfer plug-in, the same rules do not necessarily apply; you might, for example, 

have pasted the overdubbed first verse into the guitar part in the DAW  to performing the prior

transfer. In that case, the transfer process would only “see” one guitar (running the entire length of the 

song) and – as a second transfer on the other track – a single full-length bass. You would be dealing, 

then, with two not three audio sources (even though, in fact, there would be five files: the three 

original recordings plus the two transfers).

The plug-in example shows why the terms “audio source” and “audio file” are not necessarily 

synonymous. Nor is there necessarily a one-to-one relationship between audio sources and clips in 

the ARA DAW, as you may have split the guitar track into multiple clips – e.g. one for the intro, a 

second for the first verse, a third for the bridge, and so on – to facilitate the task of arranging your 

material but these would not (initially) be regarded by Melodyne as separate audio sources. So it’s 

perfectly possible for a track containing multiple clips to comprise some lesser number of audio 

sources – perhaps only one.

Sound Editor settings invariably affect at least one entire audio source – never some smaller 

musical fragment, such as a clip you may have created within it.

So in the example given above it would be possible to give the first verse (i.e. the overdubbed guitar 

repair) a different sound to the rest of the guitar track but not to apply different settings to the intro 

and the bridge, because these – you could almost say “coincidentally” – share the same audio 

source, because they were part of the same take and therefore recorded on the same audio file.

The note selection

If you select a single note only – from the guitar intro, for example – there can be no ambiguity as to 

which audio source you mean to edit; it can only be the first take; this, you will remember, comprises 

the entire guitar part except for the first verse, which you repaired on a subsequent take. This means 

that if you change the sound of the selected note in the Sound Editor, you will change the sound of all 

the other notes belonging to the same audio source – i.e. the entire guitar part  the first verse.except

So although you may only have selected and edited one note, you are in fact instructing Melodyne to 

apply the same changes to all the notes belonging to the same take.
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Individual value settings

Let’s suppose you are looking at a track in Melodyne derived from more than one audio source and 

have either selected all the notes or none whatsoever (it comes to the same thing). If you now lower 

the third overtone by 10 dB, the tone color of all the notes on the track will be affected.

If you then select just some of the notes and raise the same overtone by 4 dB, the net result will be a 

setting of -6 dB for the third overtone of the notes selected; others, however, may be unaffected by 

this most recent change, in which case their third overtones will remain at -10 dB. Whether the notes 

not selected are, or are not, affected by the change (once again) depends upon the audio sources to 

which they belong and the number of transfers involved.

If all the contents of the track are derived from a single long transfer, the answer’s easy: Any change 

applied to one note (or any selection of notes) applies to all of them, so in this case, the third overtone 

of all the notes will be set to -6 dB.

Suppose, however, that in our guitar example you began by transferring everything but then, after 

recording the overdub, transferred the first verse to the Melodyne plug-in again. In that case, the note 

selection would play a decisive role:

If the notes selected belonged to the first verse only, when you set the value of the third overtone to 

-6 dB, all the notes of the first verse (whether selected or not) would be affected – but no others. In 

other words, you would have changed not only the notes selected but also one or two others to the 

right or left of it, as long as they were part of the same overdub.

If on the other hand, you had selected only notes belonging to the intro, then set the level of the third 

overtone to -6 dB, you would have changed the tone color of almost the entire track – i.e., the guitar 

part of every segment of the song that was recorded on the same take (the first) as the intro, which in 

our example means every segment except the (overdubbed) first verse.

So, if you want to apply different settings to different segments of the same track, you can do so 

quickly and easily. You can only edit a segment independently of the rest of the track if it has an 

audio source all to itself – not if it shares one with one or more other segments.
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If you want to see which settings have been applied to a particular segment, just select one of its 

notes. In our example, the value for the third overtone will be either -10 dB or -6 dB. If, on the other 

hand, you select a larger range of notes, spanning several audio sources (in our example, say, the 

intro  the first verse), you will see a value somewhere between -10 dB and -6 dB for the overtone and

in question. This value is a display compromise: an average of all the audio sources concerned.

In the same way, any or all of the other Sound Editor controls will sooner or later end up showing 

approximate values, too, if you are constantly applying different settings to different segments by 

making targeted note selections. This is unavoidable, so when in doubt, place greater reliance upon 

what you are hearing than the values displayed.

Naturally, the techniques described here can also be applied to multiple tracks simultaneously. 

Select, for example, all the backing vocal tracks and boost a few overtones; assuming there were ten 

such tracks, the change would affect all ten. If you decided the results were too drastic, you could 

tone them down by selecting, say, five of the tracks and partially or completely undoing the changes, 

before perhaps tweaking entirely different parameters for those tracks. With no other tool can you 

improve the sound of your production as swiftly and with a comparable degree of flexibility.
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The Sound Editor – Operation

This tour explains how to use the Sound Editor’s parameters to modify the tone color of your 

recordings. For more on the subject, such as how to make the desired note selection for editing in the 

Sound Editor, see the preceding tour: “The Sound Editor – Introduction”.

The mean spectrum

Before we examine the functions of the Sound Editor in detail, there is one term has to be explained, 

as it runs like a thread through them all: the “mean spectrum”.

Once it has detected the notes of which an audio track is composed, Melodyne conducts a spectral 

analysis to determine which harmonic partials (from now on, we’ll call them “harmonics”) each note 

contains and how loud in each case these are. When the analysis is complete, Melodyne has an 

“acoustic fingerprint” (in spectral form) of each note. After averaging the spectra of all notes on the 

track, Melodyne obtains what we call the “mean spectrum” of the entire track.

The starting point for any spectral adjustments you effect using the Sound Editor is the mean 

spectrum of the track in question, which we can think of as the average timbre (or “tone color”) of its 

notes. For the purpose of orientation, the mean spectrum is displayed in the form of a thin line that 

remains stationary as you resize the columns or redraw the curve in the various working areas of the 

Sound Editor.

If multiple tracks are selected when you open the Sound Editor, it is the mean spectrum of them all 

that is displayed and forms the basis for editing.

Emphasis and Dynamics

The Emphasis and Dynamics sliders offer you a simple but effective way of influencing the tone color 

and amplitude of the track. They work independently of the other elements of the Sound Editor and 

have no effect upon their displays. It is sometimes worth opening the Sound Editor just to use either 

or both of these controls.
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In case you haven’t already done so, check the option Show Tooltips on the User Interface page of 

the Preferences dialog, so that the names of the various control elements pop up as you pass the 

mouse over them.

Emphasis: As you move this slider from its neutral midpoint towards the right, any differences 

between the spectra of the notes actually sounding and the mean spectrum are increased. This 

makes their peculiarities more pronounced, as wherever their spectra departs from the mean 

spectrum, the difference is progressively exaggerated, in the manner of a caricature.

Moving the slider to the left has the opposite effect, assimilating the spectra of the notes in question 

ever more closely to the mean. In this way, their peculiarities gradually disappear, making the timbre 

throughout the track more uniform.

The Emphasis slider offers an outstanding means of raising the profile of certain sources within the 

mix and helping them cut through, whilst making others less obtrusive so that they blend in better – in 

each case,  changing their volume.without

Please note that the Emphasis slider has a very wide range in each direction (± 200 %) making it also 

a powerful tool for generating effects. Valuable results can be obtained, however, depending upon the 

material, with far smaller values. We recommend, therefore, that you operate this particular control 

with a light touch. Holding down the [Alt] key as you move the slider will make it easier to increment

/decrement the parameter one per cent at a time.

Dynamics: This slider influences the amplitude of the notes – specifically, their internal dynamics. As 

you move the slider to the right, the quieter parts of each note become quieter still; as you move it to 

the left, they become louder. In other words, moving the slider to the right exaggerates any 

fluctuations in amplitude within each note, whereas moving it to the left smoothes them out.

If you apply the Dynamics slider to a piano recording, for example, you can make the notes decay 

more rapidly (for a staccato effect) by moving the slider to the right, whereas moving the slider to the 

left gives them a longer decay, lending the passage in question more of a legato feel. Given the way it 

operates, the Dynamics slider obviously has no effect on notes with a uniform amplitude – with the 

same envelope, in other words, as an organ – other than, at most, to make them somewhat louder.
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Tip: With polyphonic material, moving the Dynamics slider to the left can cause notes to overlap that 

didn’t do so originally, which, if there was scant headroom to begin with, can lead to the distortion 

threshold being crossed. This is easily avoided, however, by giving the Gain knob (described in the 

next section) a slight twist anticlockwise.

Bypass, Gain and the global Sound Editor menu

In the top right-hand corner of the Sound Editor, you will find a bypass switch that deactivates the 

Sound Editor altogether, so that what you hear is the unedited track signal. Use this switch for a quick 

comparison between the sounds of the edited and unedited signals.

Since editing the spectrum can involve dramatic changes in level, Melodyne automatically 

compensates, to ensure that the output level remains approximately the same. On rare occasions, 

however, you may find either that the distortion threshold is being crossed or that the output level is 

too low, in which case you can adjust the level manually using the gain control.

The drop-down menu contains three commands: Reset All governs all the working areas of the 

Sound Editor, returning it to the state it was in when first opened for the track in question. Similarly, 

Copy Settings copies the settings of  the working areas of the open Sound Editor, which you can all

then apply to another track using the command below: Paste Settings.

Please note that the Copy Settings command does not copy the mean spectrum of the source track; 

only the relative adjustments you have made to it – to make a particular harmonic louder or quieter, 

for instance. When the settings are pasted, therefore, the same offsets are applied to the mean 

spectrum of the destination track. The eventual level of the harmonic in question therefore depends 

partly upon how loud it was to begin with and only partly on the editing of the same harmonic in the 

source track that you have copied over (along with the other settings).
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The working areas

Using the tabs, you can switch between the various working areas of the Sound Editor. If you hold 

down the [Command] key at the same time, you can open several working areas side by side, 

provided there is enough space. To close one of multiple open working areas, [Command]-click in the 

same way on its tab.

Each of these working areas contains a central display and, beneath it, a number of sliders. Before 

going into the details, let’s take a quick look at the various working areas.

Harmonics, Lo and Hi: These three working areas allow you to intervene directly in the overtone 

structure of the notes. They are laid out identically, Harmonics being of central importance as it 

governs all the notes. Lo and Hi merely allow you, if you wish, to make further adjustments to the 

harmonics of the notes whose fundamentals lie in the lower and upper halves (respectively) of the 

track’s register.

EQ: This is a graphic equalizer in which the frequency spectrum is sliced up into bands one semitone 

wide. The important difference between the EQ and the Harmonics, Lo and Hi working areas is that 

the latter govern the levels of the overtones of the notes (the frequencies of which depend upon the 

pitch of their respective fundamentals), whereas the EQ acts upon fixed frequency bands like a 

conventional graphic EQ.

Synth: This working area contains three envelopes that govern (respectively) the influence over the 

lifetime of each note of whatever changes you have made to the spectrum, the gliding upwards or 

downwards of formants, and internal changes in amplitude. Here you will also find two sliders that 

govern the resynthesis in the Sound Editor.
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The Harmonics, Hi and Lo working areas

The Harmonics area displays and allows you to edit the harmonic spectrum of the notes of the 

selected track.

The bar chart dominating the pane may remind you of a filter bank or one of those plug-ins that allow 

spectral filtering. It differs, however, from such filters in one important respect: The spectrum here 

relates to the individual notes – i.e. the pitch of the fundamentals; this is only possible because 

Melodyne is able to recognize the notes heard on the track.

This means that when you increase or decrease the height of the third bar, for example, you are not 

altering the level of a fixed band of the frequency spectrum but that of the third harmonic of all the 

notes, the frequency of which, obviously, varies from note to note.

You are editing the sound, so to speak, at the source, exercising a very direct influence upon the 

timbre. The harmonics bars therefore have far more in common with the oscillators of an additive 

synthesizer or the drawbars of an organ than with the bands of an equalizer. They reflect and 

determine the relative amplitude of the harmonics – including that of the fundamental, which is the 

first harmonic – of all the notes on the track. The possibilities they afford for the shaping of the timbre 

are at once subtle and far-reaching.

The starting point for any editing is the mean spectrum of the entire track, which Melodyne has 

determined from its prior analysis. The balls that bounce up and down as the track plays back reflect 

the instantaneous level of the harmonics in question. You will notice that these are constantly 

crossing and recrossing the mean value indicated and determined by the top of the bar. When you 

increase or decrease the height of a bar, the original level of the harmonic in question in the mean 

spectrum remains visible, being indicated by a thin line.
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The Lo and Hi working areas complement the Harmonics area. All three areas are active 

simultaneously and their effect is cumulative. The Lo and Hi working areas offer exactly the same 

function sets as the Harmonics area but affect only the harmonics of notes lying in the lower and 

upper halves, respectively, of the register of the track in question, the halfway point being determined 

by Melodyne automatically. The settings for the two regions morph into one another in the crossover 

zone to ensure a smooth transition in timbre.

Example: You have a piano track on which the high notes are perfect but the low notes sound a little 

dull. If you tried making the lower notes and the midrange brighter using a conventional equalizer, the 

high notes would then be too bright. With the Sound Editor, no such problem occurs; you can edit the 

harmonic spectrum of the low notes in the Lo working area without this influencing the high notes – 

with, at the same time, quite different settings in the Hi working area governing the high notes without 

these affecting the bass. The settings in the Harmonics working area remain active, offering you 

complementary control over all the notes.

The harmonics bars and how to use them

The bars or columns in the Harmonics, Lo and Hi working areas represent the harmonic partials of 

the notes; they have nothing to do, obviously, with bars in the metrical sense (as in “the chorus is 8 

bars long”). The bar marked “1” represents the first harmonic (the fundamental), and the bars to its 

right marked “2”, “3”, “4”, represent the second, third and fourth harmonics, the frequencies of which 

are (respectively) 2, 3 and 4 times that of the fundamental – and so on as you carry on up. The 

leftmost bar, marked “<”, influences the level of all frequencies below that of the fundamental. With 

many sources, pulling this bar down can make the sound cleaner.
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To adjust the height of the bars, proceed as follows:

Drag the top of a bar upwards or downwards to alter its height (and the level of the 

corresponding harmonic).

For finer adjustments, hold down the [Alt] key as you do so.

Drag horizontally in the white zone above the bars to make a range selection.

To adjust the height of all the bars within the selection by the same amount, drag upwards or 

downwards in the medium-dark area (not the darkest band at the bottom) within the selection. 

If, on the other hand, you drag from a point just above the selection (where the mouse pointer 

changes shape), the bar closest to the pointer will move the greatest distance and those 

further away progressively less.

[Shift]-click to select (or deselect) non-adjacent bars.

Double-click a bar to select all octaves of the corresponding harmonic.

To restore a harmonic or selection of harmonics to their original levels in the mean spectrum, 

[Command]-click the bar or selection in question.

The local pull-down menus of the Harmonics, Lo and Hi working areas contain the following 

commands, which affect all the harmonics bars of their respective displays.
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Reset Spectrum: This restores the harmonics bars in the working area in question to their 

original positions, reflecting the mean spectrum.

Copy Spectrum: This copes the spectrum of the selected area, so that it can be copied into 

another area or track. The copying of spectra can create interesting coloring and morphing-like 

effects. As the copy is performed, the current Contour setting is factored into the copied 

spectrum, whereas the values of the other macro sliders are simply copied and the formant 

settings ignored.

Paste Spectrum: This command works in conjunction with the Copy Spectrum command 

described above, the result being to paste the copied spectrum into the currently selected 

working area (Harmonics, Hi or Lo) of the track being edited. You can copy and paste between 

tracks in the same document or from one document to another. As the paste is performed, the 

Contour parameter of the destination track is reset, so its entire range is available for future 

editing.

Clear Spectrum: This is like pulling down all the faders of a mixer: the result is silence, which 

can be a good place to start if you wish to create a new timbre from scratch.

Shuffle Spectrum: This sets all the harmonics to random levels.

Show All Harmonics: You have the choice of displaying all the harmonics (however high) or 

only the lowest and most important ones, the bars of which will then be wider and easier to 

manipulate. When the highest harmonics are not being displayed but a selection includes the 

rightmost bar that  visible, all the harmonics above it that are excluded from the display are is

nonetheless included in the selection and edited accordingly.
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The Harmonics, Lo and Hi macro controls

Each of these three working areas offers the same four sliders. These are macro controls that govern 

the level of the various harmonics, and their effects are immediately reflected by the display. 

[Command]-clicking on any of the macro controls resets it to its neutral position. This removes any 

influence it previously had on the level of the harmonics and height of the harmonics bars but any 

changes you may have made manually (i.e. other than with the macro) remain effective.

Brilliance: When you move this slider to the right, the level of the higher harmonics is raised, making 

the sound brighter. Moving it to the left makes the higher harmonics quieter and the sound duller.

Contour: Moving this slider to the right increases any difference in height between neighboring bars, 

making the peaks higher and the troughs deeper, and generally sharpening the contours of the 

display. Moving the slider subsequently to the left has the opposite effect, restoring gradually the 

original contours as it moves back towards the middle, before flattening them out as it moves further 

to the left.

Odd/Even: This gradually fades out the odd-numbered harmonics (when moved to the right) or even-

numbered ones (when moved to the left). In the former case, the octaves are steadily reinforced, 

whereas in the latter, the source takes on a progressively hollower, clarinet-like sound.
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Comb: This slider thins out the harmonic spectrum, creating increasingly weird effects, with the 

display resembling a comb losing its teeth. The buttons to each side of the slider allow you to slide 

the comb sideways (without removing further teeth) and this, too, has a dramatic effect upon the 

sound. If the slider is left in the central position, the effect of clicking the button to its right is to 

eliminate one by one the lowest harmonics from the spectrum.

You can combine freely use the four sliders with that of the bars representing the harmonics; this 

gives you an abundance of sound design options.

The EQ working area

This working area contains a graphic equalizer that – in the usual way – operates upon fixed bands of 

the frequency spectrum. The equalizer divides the frequency spectrum into bands a semitone wide 

and is calibrated with the note names at the bottom.

Since the equalizer operates on fixed frequency bands within the audio spectrum, it offers a quite 

different approach to the shaping of sounds than that offered by the Harmonics, Lo and Hi working 

areas, in which the bars represent the various harmonics. All four working areas can be used at the 

same time.

The starting point for any editing using the equalizer is the mean spectrum of the track being edited, 

which is referenced here to the entire audio spectrum. If the track contains a large number of high or 

very bright-sounding notes, the right-hand end of the EQ curve will naturally be more elevated or 

“mountainous” than if it did not.
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When you reshape the curve, the original mean spectrum remains visible in the form of a thin line. 

During playback, the instantaneous spectrum is indicated by balls that cross and recross the current 

curve as they bounce up and down.

To avoid confusion between the EQ working area and the other, harmonics-based ones, the current 

levels of the individual bands are indicated here by a curve rather than horizontal lines. The same 

techniques, however, are used to adjust the level of the various frequency bands as to adjust the 

height of the harmonics bars in the other windows, so if you have not already read the section there 

explaining how to select and drag the bars, please do so now.

The equalizer employs as a basis the notes that have been detected in the track being edited. This 

means that a note in the audio material that has not been correctly identified will not be assigned to, 

or governed by, the correct EQ band. If a note in polyphonic material is not detected, its contribution 

to the overall sound will be wrongly attributed either to a lower or to a higher note.

In the former case, its energy will be distributed among the overtones of the lower note and will only 

be visible as such in the EQ spectrum. If it is attributed to a higher note, on the other hand, it will end 

up in the lowest band of the equalizer: the one marked “<”. This collects all frequency components 

lying beneath the fundamentals of the detected notes or that cannot be assigned to any note. To hear 

what signal components of the track are gathered in the “<” band, you can clear (i.e. set to zero) all 

the other bands before lifting this one.

Examine and if necessary edit in Note Assignment Mode the detection, activating all notes that have 

not been detected so that these too can be correctly handled by the equalizer.
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In the local drop-down menu you will find the following commands for the EQ spectrum:

Reset Spectrum: This restores the original mean spectrum.

Copy Spectrum: This copies the current EQ spectrum so that it can be pasted into another 

track. As the copy is performed, the current Contour setting is factored into the copied 

spectrum, whereas the values of the other macro sliders are simply copied and the formant 

settings ignored.

Paste Spectrum: This command works in conjunction with the Copy Spectrum command 

described above, the result being to paste the copied EQ spectrum into the EQ working area 

of the track being edited. You can copy and paste between tracks in the same document or 

from one document to another. As the paste is performed, the Contour parameter of the 

destination track is reset, so its entire range is available for future editing.

Paste Spectrum: This command works in conjunction with the Copy command ( [Ctrl]-C ) also 

found in the Edit menu and the context menu of the Note Editor. If you select and copy in the 

Note Editor a blob (or a selection of blobs on the same track), you can paste the spectrum of 

the blob in question (or the mean spectrum of the blobs selected) into the EQ working area. 

The copied spectrum is then applied to the sound, by which means interesting tone colors can 

be obtained.

Clear Spectrum: This sets all bands to the minimum, the result being silence.

Shuffle Spectrum: This sets all the bands to random levels. Let your EQ surprise you!

The EQ macro sliders

The macro sliders affect the levels of all the frequency bands and their influence is immediately 

reflected in the height of the vertical bands. [Command]-clicking on any of the macro controls resets it 

to its neutral position. This undoes whatever effect it previously had on the height of the bands but 

any changes you may have made manually (i.e. other than with the macro) remain effective.

The controls are from left to right:

Brilliance: When you move this slider to the right, the level of the higher bands is raised, giving 

greater prominence to the high frequency content of the signal. Moving it to the left attenuates the 

higher bands, making the sound duller.

Contour: Moving this slider to the right increases any difference in height between neighboring 

bands, making the peaks higher and the troughs deeper, and generally sharpening the contours of 

the display. Moving the slider to the left initially makes the spectrum increasingly linear, before 

inverting it, so that what were formally peaks become troughs and vice versa.

Tonality: When moved to the right, this fades out notes foreign to the scale; when moved to the left, it 

fades out notes that do belong to the scale.
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Comb: In the former case, the notes furthest from the tonic in the circle of fifths are removed 

progressively until finally only it and its octaves remain. With the buttons on each side of the slider, 

you can determine which note should be considered the tonic for the purpose, cycling clockwise or 

anticlockwise around the circle of fifths. The left button indicates the note currently designated as the 

tonic.

You can combine freely use the four sliders with direct editing of the individual frequency bands in the 

main EQ display.

Formants

Formants are peaks in the frequency spectrum, the position of which is not directly related to the pitch 

of the fundamental, that help to give each instrument or voice its individual character. If you have 

used Melodyne before, you will be familiar with the Formant Tool that allows you to alter the sound of 

notes by shifting their formants up or down.

The Sound Editor, too, offers access to the formants: you can edit them in the EQ, Harmonics, Lo and 

Hi working areas, the resulting shift in each case affecting all the notes of the track in question. The 

formants are accessible in the dark gray zone at the base of the bars or bands, in which the number 

of the harmonic or name of the note are displayed.

Drag horizontally in this area to shift the formants governing all the harmonics or EQ bands.

Select adjacent bars or bands to shift the formants governing only these. By repeating the 

process successively, you can shift the formants of multiple selections in different directions 

and by varying amounts to arrive at complex formant transposition patterns.
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[Command]-clicking in the formant zone restores the original formants throughout the register.

The Formant Tool, the technique just described in the Sound Editor, and the Formants knob in the 

Track Inspector can be applied simultaneously. Their combined effect is as follows:

The Formant Tool shifts the formants of the selected notes upwards or downwards. If you have 

already, in the Sound Editor, ‘bent’ the formants of the track to which the notes in question 

belong, it is these ‘bent’ formants that will be shifted. The Formant Tool, in other words, adds a 

note-based offset to the formant structure displayed in the Sound Editor.

The Formants knob in the Track Inspector and the formant shifting functions offered by the 

Sound Editor affect the track as a whole and work hand in hand. Each time you turn the 

Formants knob, the entire formant structure in the Sound Editor (including any editing of it you 

may have performed) will be shifted up or down. If you shift all the harmonics in the EQ or 

Harmonics working areas, the Formants knob will move accordingly. If, on the other hand, you 

shift merely a selection of harmonics or frequency bands in the Sound Editor, the Formants 

knob will not reflect the change.

Since formants, almost by definition, do not move when the fundamental changes, strictly speaking it 

is only in one of the four working areas of the Sound Editor, namely the EQ working area, that they 

can be edited; in the Harmonics, Lo and Hi working areas, the bars are tied to harmonics that move in 

parallel as note follows note, so it would be better in their case to speak of “manipulation of the 

spectrum”. Useful results can nonetheless be achieved using the techniques just described in all four 

working areas, and their combined effects are as follows:

A formant shift applied to all the bands of the EQ will be reflected in the Harmonics working 

area; similarly, a formant shift applied to all the bars in the Harmonics working area will be 

reflected in the EQ. The Hi and Lo working areas will reflect a shift applied to all the bands of 

the EQ.

No shifting of formants in the Hi or Lo working areas, however, will ever be reflected in the 

Harmonics or EQ working areas. This is because the Hi and Lo working areas only access half 

each of the register of fundamentals, so changes effected in either area could not be displayed 

in the Harmonics or EQ working areas.

If you have shifted the formants in the Hi and/or Lo working areas and then shift all the 

formants in either the Harmonics or EQ working areas, the resulting shift will be reflected in the 

Hi and/or Lo working areas. Whatever formant structure(s) you had established in the Hi and

/or Lo would in this case simply be shifted en bloc. By the same token, you can reset the 

harmonics in the Hi or Lo working areas without this being reflected in the Harmonics or EQ 

working areas.
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If, on the other hand, you reset the formants in either the Harmonics or EQ working areas, all 

four working areas will reflect the change. In the Harmonics and EQ working areas the 

formants will be reset, whereas in Hi and Lo, only whatever editing was performed in those 

individual windows will remain effective.

Whenever, in fact, you select anything less than all the harmonics or frequency bands before 

shifting formants, the change will only be reflected in the working area in which the shift is 

performed.

The envelopes in the Synth working area

This working area contains three envelopes with which you can control dynamically the intensity of 

the spectral editing, the formant shifts and also the volume of the notes. Here you will also find two 

sliders that govern the resynthesis in the Sound Editor.

The envelopes allow you to influence the notes of the track being edited in a variety of ways. You 

could, for instance, lengthen slightly the attack of the notes of a piano track, giving the instrument a 

subtly different character. You could introduce spectral filtering that diminished in intensity within the 

lifetime of each note leaving the original spectrum in its stead. At the same time, you could make the 

formants of each note glide upwards.

These effects act directly on all the notes of the track you are editing. Each note, even in polyphonic 

audio material, follows the dictates of its own envelope, independently of the other notes. The 

operating principle is the same as that of the envelope generator of a polyphonic synthesizer, except 

that the Sound Editor’s envelopes are not triggered by MIDI messages but by the notes of an audio 

track – or, to be more precise, by the musical starting points of the notes. If a note has no definite 

starting point, the note separation preceding it serves as an envelope trigger. (You can examine and 

set the starting points of the notes in Melodyne’s Note Assignment Mode.)
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To shape the envelopes, either drag their triangular handles or drag directly in the gray area. Each 

envelope has six parameters: starting level, attack time, sustain level, sustain time, decay time and 

final level (i.e. the level subsequent to the decay phase).

By dragging in the ruler beneath each envelope, you can determine the length of time in seconds 

represented by the envelope display and available for the creation of the envelope.

The checkboxes next to the words “Spectrum”, “Formant” and “Amplitude” in the various panes are 

used to activate and deactivate the corresponding envelope generators. [Command]-click an 

envelope to restore its original, neutral settings.

These are represented by the horizontal line in the middle of the three envelope displays. In the area 

above this central line, depending upon the envelope, the intensity of the spectral filtering is 

increased, the formants are shifted upwards, or the amplitude is increased. In the area beneath this 

central line, again depending upon the envelope, the intensity of the spectral filtering is decreased, 

the formants are shifted downwards, or the amplitude is reduced.

The Spectrum envelope governs the intensity of all changes to the original mean spectrum effected in 

the Harmonics, Hi, Lo and EQ working areas. The Formant envelope influences all the formant 

shifting in these areas by moving all the formant structures created there upwards or downwards.
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The Resynthesis parameters in the Synth working area

The Sound Editor, evidently, breaks the signal down into different frequencies that are modified and 

then combined to form a new signal. The signals thus combined include not only harmonic partials 

(the frequencies of which are integer multiples of that of the fundamental) but also enharmonic 

partials and simple noise included in the signal, such as the squeaking of strings or pedals and 

background noise) scattered throughout the spectrum and only rarely or accidentally coinciding with 

the harmonic partials.

Admittedly the bars in the Harmonics, Lo and Hi working areas are centered on the harmonic partials, 

but with Melodyne, unlike a pure synthesizer that has only a finite number of sine wave oscillators at 

its disposal, signal components lying between the partials are not lost but reproduced in the signal, to 

remain faithful to the original. By moving the Harmonics bars, you can alter the sound – radically, if 

you so desire – but the basis of your work is always the material of your original recording.

The case is different when you employ the two Resynthesis sliders.

Magnitudes: As you move this slider to the right, changes in the amplitude of the individual 

harmonics are gradually reduced until, when the slider reaches its rightmost extent, no timbral 

changes at all take place within the lifetime of each note. The balls as a result stop bouncing up and 

down and come to rest on the tops of the harmonics bars. Moving the slider to the right has the 

additional effect of narrowing the band assigned to each harmonic so that any non-harmonic 

components gradually disappear from the signal.

Phases: The different phases of the various partials also have a considerable influence upon the 

natural reproduction of the signal. As you move this slider to the right, the original phase ratios 

between partials are gradually reduced until all the partials are in phase. This primarily affects the 

transients in the signal, making the sound more synthetic. You can use the Phases and Magnitudes 

controls singly or in combination.

With both sliders at their rightmost extremes, the results sound particularly “artificial” and reminiscent 

of a static synthesizer waveform. Aside from the fact that this may sometimes be precisely what you 

want, the sound that results can also be an excellent starting point for further sound design using the 

harmonics bars, envelopes and so on.
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Variable tempo in the DAW

Normally the bar rulers of your DAW and the plug-in implementation of Melodyne will always be in 

sync. If, however, there is a tempo change in your DAW between two track segments that you have 

transferred to Melodyne, or if you have altered the overall tempo in your DAW after transferring 

material to Melodyne, you must inform Melodyne of such changes so that synchronicity between the 

bar rulers of the two programs can be restored.
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A new constant tempo

Whenever Melodyne registers a tempo change in the DAW, the button near the tempo display will 

flash to indicate that a matter requires your attention. If you do nothing, you resign yourself to there 

being a discrepancy between the bar ruler in the DAW and that of the Melodyne plug-in.

Click the button to open the tempo dialog. Here you can inform Melodyne of the nature of the tempo 

change it has detected, in order to ensure that the two bar rulers remain in step.

If you have simply changed the overall tempo and there are no tempo changes within the song itself, 

select Constant Tempo. This tells Melodyne that the new tempo registered applies to the entire song 

and that it should adjust its own bar ruler accordingly.

If you want Melodyne to stretch or compress the audio material to reflect the new tempo, check the 

box below.

If you select this option, Melodyne will employ time-stretching (or -compression) to adjust the material 

already transferred to the new tempo. If your DAW performs its own time-stretching on audio material 

when there is a change of tempo, Melodyne will behave exactly the same way whenever this box is 

checked, so the audio material in the DAW and the plug-in will remain in sync.

If your DAW does not employ time-stretching and merely changes the grid beneath the audio material 

when tempo changes occur, to ensure identical behavior in Melodyne clear the check box in question. 

Of course, even in this case you may prefer to check the box, in order to achieve through Melodyne 

what with your DAW you cannot, namely an adjustment of the audio material to the new tempo by 

means of time-stretching.

A new variable tempo

If you have not selected a new constant tempo in your DAW but simply introduced an internal tempo 

change (whether sudden or gradual), select Variable Tempo.
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Melodyne is perfectly capable of registering tempo changes and implementing them correctly without 

any assistance, but it can only do so if they occur within a passage that has been transferred to it. If a 

variation in tempo occurs between two transferred passages, Melodyne is obviously in the dark.

The simplest way of informing Melodyne about such tempo variations is to save from the DAW a 

standard MIDI file that runs from Bar 1 to the end of the project and then load it using the Import 

button in the tempo dialog. This will provide all instances of Melodyne with the information they need 

concerning the tempo variations in the DAW project. The synchronicity of the two bar rulers will 

therefore be assured.

A second way of doing it is to play through to Melodyne the passage containing the variations in 

tempo so that it can analyze them. It is enough to play the passage through to a single instance of 

Melodyne as the other instances will be informed of the tempo changes automatically.

To do this, proceed as follows (heeding also the advice in the following section):

While the tempo dialog is open, stop the playback in the DAW and move its playback cursor to 

a point in the timeline about one bar prior to the start of the new tempo acceleration or 

deceleration

Next, for the benefit of Melodyne, play through the entire passage until the acceleration or 

deceleration comes to an end and a constant tempo has been maintained for at least one bar.

Now stop the playback in the DAW. In the tempo dialog, you will see indicated the range of the 

tempo variation within the passage concerned. The tempo displayed here is somewhat more 

precise than that shown in the tempo field, so do not worry if there is a small discrepancy 

between the two values.

Note: Some DAWs (at present only Cubase) are capable of keeping Melodyne informed of changes 

in tempo. Since Melodyne in their case already has the information it needs, the minimum and 

maximum tempos within the passage in question will be displayed automatically as soon as the 

tempo dialog is opened and there is no need to play through the passage in question. Just click OK to 

close the dialog.
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Specify once more whether you want the audio material itself or only the grid to be stretched or 

compressed to reflect the tempo variations.

Exit with OK to apply your settings or Cancel to discard them. The OK button will remain greyed out 

until you have started your DAW to play the tempo change through to Melodyne and then stopped it 

again.

Important when working with variable tempo

If Melodyne has not been fully informed of changes in the tempo or time signature, the time rulers of 

the DAW and Melodyne can get out of sync and transfers will sound at the wrong time or be recorded 

in the wrong place.

The handling of variable tempo is unfortunately not self-explanatory. It would be far simpler if DAWs 

transmitted all information about changes in tempo or time signature to plug-ins, but, sadly, the plug-

in interface at the moment does not provide for this. Melodyne is therefore obliged to obtain all the 

relevant information from the material transferred. However, since transfers as a rule do not extend 

the full length of the song, the tempo dialog makes it possible for Melodyne to analyze changes in the 

tempo or time signature during pure playback – in other words, without any transfer being necessary. 

With respect to Melodyne’s analysis of the tempo, if the following rules are observed, everything 

should go as expected and there is no reason why you should not be able work successfully with 

variable tempo.

Prior to the first transfer, with the tempo dialog open, play through to one instance of Melodyne 

the  song including  passages in which the tempo accelerates, decelerates or entire all

changes abruptly or in which there is a change of time signature. This will allow Melodyne to 

create a tempo map, which will be adopted by all instances of Melodyne. Alternatively, using 

the Import key you can load a standard MIDI file exported previously from the DAW containing 

the requisite tempo data. If in doubt, use this method, which is described above, as it is quicker.

If you have made further changes to the tempo in the DAW, play through once again to one 

instance of Melodyne in the tempo dialog the  song. This will allow Melodyne to map all entire

the tempo changes and preserve the synchronism of the bar ruler.

If,  to changing tempo progressions in your DAW you have already transferred material to prior

Melodyne, then once Melodyne has learned about the changes, before closing the tempo 

dialog check the Audio Stretching option. This is the only way of ensuring that the material 

already transferred can adapt to the new tempo environment.
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Melodyne 5: Update guide

The following is a brief summary of all you need to know to get started with the new Melodyne 5. In 

the individual tours in the Help Center, you will find plenty of exciting tips, tricks and background info 

to read later, but the best place to begin is here.

The Melodic Algorithm with Sibilant Detection

First the good news: You don’t have to do anything; during its initial analysis of the material (the 

‘detection’), the algorithm in its default setting automatically separates the pitched from the unpitched 

(noise-like) components of the sound and thus behaves correctly during the playback. The upshot is 

better sound, pure and simple.

The extent of any noise-like components that have been detected – we call them ‘sibilants’ – is 

indicated by hatching. This is how Melodyne marks not only sibilants proper (“s”, “z”, “ch” and “zh”) 

but also other unvoiced consonants like “k” and “t” as well as the sound of the vocalist inhaling or 

exhaling between words.

If any part of the detection seems strange or incorrect to you, you can switch to Note Assignment 

Mode where you will find the requisite  though doing so is seldom necessary.Correction Tools

When you alter the pitch of a note, Melodyne does not alter the frequency of the sibilants, as that 

would sound unnatural – after all, in real life no singer has the wherewithal to sing one “S” higher than 

another or pitch the sound of their own breathing. In the display, however, the hatched areas do move 

up or down with the rest of the blob when the corresponding note is transposed, but they do this 

solely in the interests of legibility, so that the visual integrity of each syllable is preserved.
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The way changes in the length of notes is implemented in Melodyne now also better represents the 

natural behavior of singers: if a note contains both sibilants and pitched components, the sibilants 

remain unaltered. When time-stretching is applied to the word “sweet”, for example, it becomes “s-

weeeeeeee-t” (not “sss-www-eeeeee-ttt” or anything ghastly like that!).

The case is different where the note in question (or, in this case, the sound to which the blob refers) 

consists  of sibilants and has no pitched components at all, as is often the case with breath solely

noise: this would certainly be shortened to make room for a time-stretched word invading its space. 

But here, too, the principle is the same, because if the rest between two words were shorter, the 

singer would necessarily take a shorter breath. So even when it comes to lengthening or shortening 

breathing sounds, Melodyne 5 automatically achieves a natural effect.

And once they have been isolated, breaths can be stretched or squeezed using a different algorithm, 

with results that sound considerably better than those of earlier versions of Melodyne.

Since, however, sibilants often coincide with pitched components, it can happen that breath sounds 

do sometimes move; when this happens, it is because Melodyne has detected a small pitched 

element in them that has been transposed, and this fact must naturally be reflected in the display. 

This should not surprise you.

All editions of Melodyne profit from these improvements – even the entry-level Melodyne essential.
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Compatibility with Melodyne 4

When you open projects that were saved by an earlier version of Melodyne, they sound exactly the 

same in the new version as in the old. This is because when you open old documents, two new 

functions are initially not activated:

Sibilants are not detected.

Pitch centers of notes are still calculated as in Melodyne 4.

The upshot is that everything sounds exactly as it did before, so if you open your old project today 

with the intention simply of making some minor change to the mix, you do not need to take any 

special precautions.

If, however, you plan to do substantially more work on the project, taking advantage of the new 

features of Melodyne 5, you can do so simply by switching on Sibilant Handling on the vocal tracks. 

This is done by:

placing a checkmark next to the option “Sibilant Handling” in the Algorithm Inspector in Note 

. This will trigger a fresh analysis of the entire track; when this is finished, Assignment Mode

any sibilants will be marked and the playback algorithm will behave accordingly. This may 

change the sound, usually for the better. Please note however that Sibilant Detection is only 

available with the Melodic or the Percussive Pitched algorithm; with all the others, the function 

is grayed out.

Unfortunately, this function is not available with the edition Melodyne essential. If you want to edit an 

old Version 4 project taking advantage of the new sibilant functions, you must trigger a fresh detection 

of the material by clicking the words ‘Melodic’ or ‘Percussive Pitched’ (as appropriate) in the Algorithm 

menu. Please bear in mind, however, that if you do this, all your previous editing will be lost, so it will 

seldom be worth it. Another option would be to upgrade to Melodyne assistant; then not only would 

the entire tool kit be at your disposal but you would also be able to switch Sibilant Handling on and off.

triggering a recalculation of the pitch center of the notes. To do this, you must enter Note 

Assignment Mode and ALT-double-click on the relevant notes. While it is replotting the Pitch 

Curve of each note, Melodyne also recalculates its pitch center. As a result of the improved 

method of determining the pitch center of each note, the blobs may realign themselves slightly 

in the vertical plane, with some moving upwards and others down; the results in either case 

reflect more faithfully the perceived pitch of the notes.

More on the .new way of calculating the pitch center

New tools (not only) for vocals

With Version 5, Melodyne assistant, editor and studio have gained two new tools:
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The Sibilant Balance Tool: This governs the ratio between the amplitude of the sibilants and that of 

the other (pitched) components of the sound. Its uses range from the defusing of problematic sibilants 

(de-essing) and the rapid adaptation of doubled vocal tracks, to creative sound design and improved 

mixing options.

The tool is easy to use: Drag downwards to attenuate the sibilants, or upwards to attenuate the 

pitched components. You can make very fine adjustments but also – when double-tracking, say – 

mute altogether either the sibilants or the pitched components.

The tool can be used for the detailed editing of single notes or, when multiple notes are selected, to 

apply the same change throughout an entire passage.

You will find all the details .here

The Fade Tool: With Melodyne 5, you can fade in at the start of a note and/or fade out at the end. No 

doubt you’re familiar with the principle from your DAW. Using the tool is easy: just double-click to 

insert a fade; then use the left/right arrows to move it, and the up/down arrows to adjust its slope. 

That’s all you need to know.

What is much more interesting, however, is that this function increases the control Melodyne offers 

over the playing dynamics of all types of instrument, because it operates on a per-note basis. So in 

polyphonic material, for example, you can fade in or out on individual notes within chords. The Fade 

Tool also makes possible the rapid elimination of extraneous noise in material of all kinds – most 

notably, polyphonic instrument tracks – as well as providing totally new scope for creativity.

You will find all the details .here
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The Leveling Macro

The new Leveling Macro allows you to rein in volume disparities swiftly. Its effect is to reduce 

differentials between the amplitude of different notes on a track – not only in melodic but also in 

percussive and even polyphonic material.

The left-hand fader makes the quiet notes louder, whilst the right-hand fader makes the loud notes 

quieter. With both faders set to 100%, all the notes will have the same amplitude.

Whilst this may sound simple, it can accelerate your workflow considerably – particularly in the case 

of polyphonic material, as it allows you swiftly and effortlessly to iron out or reduce disparities 

between the volume levels of different notes within chords.

You can find out more about the Leveling Macro .here

Pitch correction by double-clicking and the Correct Pitch Macro

Whether you double-click on out-of-tune notes to correct intonation errors or use the macro, the new, 

musically weighted calculation of pitch centers delivers better results. Whereas previously you often 

had to fine-tune individual notes manually, even after double-clicking or using the macro, now Select 

All followed by a double-click always results in musically correct intonation. Further editing is now 

required, at most, in a handful of specific genres to steady-up the beginning or ending of words – and 

even this can be performed in Melodyne 5 in next to no time.

More on this....

Both the Correct Pitch macro and double-clicking also profit from the new Chord Track. To an extent 

you can control, and in an extremely musical manner, not only can the intonation of the notes be 

improved swiftly but they can also be transposed simultaneously to fit the chords of the song. This 

allows any instrument track or any sample to accompany any song.

Chord Recognition and the Chord Track

If it is not already visible, click here to show the Chord Track.
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There are now various ways of filling in the chords:

by hand. If you know the chords, you can just type them in. From the Preferences dialog, you 

can choose between various chord naming conventions.

via ARA: If your DAW is equipped with a chord track and makes it available via ARA, 

Melodyne can simply take the chords from the DAW. Any subsequent chord changes you 

make in the DAW will be reflected immediately in Melodyne.

using the Chord Recognition function. If you do not know what the chords of the song are, 

Melodyne can find out for you. Select for the purpose tracks with as much harmonic 

information as possible (e.g. guitar, keyboard or bass) and as little pitch fluctuation as possible 

(so preferably not vocals); do not include drum tracks.

Now right-click on the Chord Track and choose “Analyze Chords”.
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Once the Chord Track has been filled in, you can set the Pitch Grid in the note-editing background to 

reflect the changing harmonies of the song. From this, you can tell at a glance which pitches are, and 

which are not, suitable destinations for notes.

If you now activate the grid by selecting ‘Chord Snap’, whenever you drag and drop notes they will 

snap to pitches consistent with the named chord.
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The same thing will happen whenever you double-click on a note or selection of notes; each note will 

move to the nearest pitch consistent with the named chord. It can happen, of course, that two or more 

notes then come to rest at the same pitch, so it is worth casting a quick eye over the results.

You will find everything relating to chords, the Chord Track and adapting new material to fit the 

chords .here
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The new Percussive Pitched Algorithm

With Version 5, Melodyne has acquired a new algorithm. The Percussive Pitched Algorithm combines 

the strengths of two of the existing algorithms.

Like the Percussive algorithm, the new algorithm is optimized acoustically for drums and percussion, 

or – in more general terms – for noise-based material.

In other respects, though, with its display format in which pitches are clearly identified, the Percussive 

Pitched algorithm is more like the existing Melodic algorithm.

Suitable candidates for the new algorithm are all drum-like instruments that are capable at the same 

time of producing recognizable melodies: an 808 loop, for example, which in addition to the noise-

based snare and hi-hat sounds includes a kick drum tuned to the bass of the song as well as tuned 

toms. A beatboxer track would be another typical candidate for the new algorithm; there, too, melodic 

(bass) with percussive (snare) elements are united in one and the same recording.

More on this....
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Keyboard shortcuts

In Melodyne, virtually any function can be controlled using a keyboard shortcut. Experienced 

Melodyne users know how to take advantage of this, and are able to perform tasks considerably more 

swiftly by using shortcuts tailored to their own specific working habits.

To facilitate the handling of keyboard shortcuts, the Shortcuts page of Melodyne 5’s Preferences 

dialog offers a search function that makes creating your own sets of shortcuts easier and more 

intuitive.

You can find out more about keyboard shortcuts .here
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Already own a Melodyne?

If you are already a Melodyne customer and have received a license for Melodyne 5 essential 

bundled with some other software or hardware product, don’t worry; you can use the license in our 

web shop as a coupon when purchasing any other update or upgrade. Here’s how it works:

http://helpcenter.celemony.com/M5/?lang=en&startPageEdition=melodyne-studio
http://www.celemony.com


Melodyne 5 studio - Live 12.0

   © Celemony Software GmbH 2024 • Last updated on 06/19/2024 • Help Center • www.celemony.com 251

How does the coupon work?

In our web shop, first place the update for your existing Melodyne or the desired upgrade in your 

shopping cart; then, when you come to pay, enter the serial number of your Melodyne 5 essential as 

your coupon code and click on “Redeem”.

The coupon has a value of €/US$ 20. This is what you will save if you use the coupon when 

upgrading to a larger edition of Melodyne or when adding a workstation to your existing license. If you 

use it when  from an older version of Melodyne to the current edition, the coupon will save updating

you even more:

Melodyne assistant: with the coupon, the update is free of charge, so you save 49 €/US$

Melodyne editor: with the coupon, the update costs only 29 €/US$, so you save 70 €/US$

Melodyne studio: with the coupon, the update costs only 49 €/US$, so you save 100 €/US$
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What if I have already activated my Melodyne 5 essential by mistake?

In that case, you can still use the Melodyne 5 essential serial number as a coupon code. If you do so, 

however, you will no longer be able to reactivate your Melodyne 5 essential, as use of the coupon 

voids the license.

Coupons: terms and conditions of use

Anyone who has received a serial number for Melodyne 5 essential as part of some other product 

bundle can, if he or she is already a Melodyne customer, use this serial number instead on a single 

occasion as a Melodyne coupon in the Celemony web shop. Use of the coupon in this way voids the 

Melodyne 5 essential license.

The coupon is only valid in the Celemony web shop (under www.celemony.com) and only 

when purchasing Melodyne updates or upgrades or when adding an additional workstation to 

an existing Melodyne license. The coupon cannot be used for the purchase of any other 

products. When the coupon is used in the purchase of a product for which it is valid, you will 

be credited with the amount in question, which will therefore be subtracted from the purchase 

price.

The coupon can be redeemed within one year of receipt of the serial/coupon number and in 

any case within three months of the release of Melodyne 6.

Only one coupon can be redeemed per purchase transaction in the Celemony web shop. The 

coupon cannot be exchanged for cash.

The coupon cannot be used in combination with other coupons/discounts and cannot be 

redeemed for purchases already made.
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Version history

Here you will find an overview of all changes introduced by the most recent Melodyne updates.

New in Version 5.4

The update to Version 5.4 contains improvements and bug fixes, which is why we recommend it to all 

users.

Pro Tools and Cubase with ARA: When opening a project with Melodyne, crashes sometimes 

occurred.

Pro Tools with ARA: Deleting a clip from a stereo track with Melodyne ARA during playback 

sometimes led to a crash.

All versions under Windows: In the event of a faulty connection with the Celemony server, a 

crash sometimes occurred.

Studio One with ARA: When using the Fade Tool or closing a session, crashes sometimes 

occurred.

ARA: Opening a second tab after opening the Sound Editor sometimes resulted in either a 

blank user interface or a crash.

Stand-alone implementation: Under macOS, invoking the Undo function during a copy 

operation sometimes led to a crash.

Stand-alone implementation: Crashes sometimes occurred when activating Melodyne.

Stand-alone implementation: The command “Save and Replace Audio” sometimes resulted in 

a crash when the audio file being edited was at the same time being used and played back in 

a DAW.

Trial version of Melodyne: Interrupting activation under Windows sometimes led to a crash.

All versions: In the Japanese user interface, an incorrect localization for “Sibilant Handling” 

was displayed in Note Assignment Mode.

ARA: The ARA mode is now also displayed correctly in the “About Melodyne” window.

Stand-alone implementation: Activating the record-enable function via the track view in the 

Note Editor had no effect on the track pane, where the Record Enable button remained grayed 

out.
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New in Version 5.3.1

The update to Version 5.3.1 contains improvements and bug fixes, which is why we recommend it to 

all users.

Pro Tools with ARA: When repeated use was made of the Undo function in Melodyne, under 

very special circumstances Pro Tools could crash.

ARA and plug-in: Under certain circumstances, not every note was included in local playback.

ARA: When creating a new project, the DAW under certain circumstances displayed an error 

message even though the new project was error-free.

ARA: When you switched back to Edit Mode from Note Assignment Mode, it could happen that 

the display scrolled all the way to the top instead of returning to the previous vertical position.

Studio One: When Studio One was launched, a crash sometimes occurred while the Melodyne 

plug-in was being scanned.

Digital Performer: Under rare circumstances, moving blobs could lead to a crash.

Samplitude: In Melodyne 5.3, it sometimes happened that the ARA files of older projects were 

muted during playback.

Stand-alone implementation: In Note Assignment Mode, execution of the “Convert Selection to 

Connected Sequence” function sometimes led to a crash.

Stand-alone and ARA: On very high-resolution screens under macOS Monterey, crashes 

could occur in Full Screen Mode.

Keyboard shortcuts: The assignments for Track Mode and Clip Mode were erroneously listed 

under “Editing Tools” instead of “View Configuration”, as they are now.

Keyboard shortcuts: The Fade Tool and Sibilant Balance Tool now appear directly beneath the 

Amplitude Tool, which corresponds to the layout in the toolbox.

Note Assignment Mode: Under certain circumstances when you were editing in Note 

Assignment Mode, individual notes were not played back.

Time Handles: When undoing an edit made with the Time Handle Tool, it sometimes 

happened that the sound of the note in question remained unchanged.

ARA: When the Universal algorithm was used, a display error (gaps between the blobs) 

sometimes occurred when blobs were being edited.
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New in Version 5.3

The update to Version 5.3 contains improvements and bug fixes, which is why we recommend it to all 

users. Moreover, Melodyne 5.3 is required for ARA integration into Pro Tools 2022.9.

New features and improvements

Surround: In both ARA and Transfer modes, Melodyne can now also be used for the editing of 

tracks in the standard surround formats.

ARA in Pro Tools: Melodyne 5.3 comes with all the technical prerequisites for ARA integration 

into Pro Tools from Version 2022.9 upwards and thus makes a significantly improved workflow 

in Pro Tools possible.

Preferences: When Melodyne is employed for the first time as a plug-in, it loads the set of 

keyboard shortcuts corresponding to the DAW you are using.

Bug fixes

Recording: In the stand-alone implementation of Melodyne, you can now also use a recording 

device with a mono input (e.g. a MacBook microphone).

ARA in Cubase: When moving an ARA event to a track that is not selected, the selection in 

Melodyne is now retained.

Pro Tools: The position of the playback cursor in Melodyne is now correctly updated even 

when playback is stopped.

AAX in Pro Tools: When bouncing/committing, Melodyne now correctly evaluates the offline 

setting.

The Correct Pitch macro: When the macro was applied to a very large number of notes 

simultaneously, Melodyne would sometimes freeze. This no longer happens.

Preferences: Previously, in ARA mode, the keyboard shortcut for “Playback Selection” was 

erroneously listed under “Others” instead of under “Transport Bar”. This has been fixed.

The Note Inspector: The input field for Sibilant Balance now reliably accepts input even when 

multiple tracks are being edited simultaneously.

ARA in Cakewalk by Bandlab: Under certain circumstances, Melodyne would crash when 

loading a session. This has been fixed.

Ableton Live: The cause of random crashes when Melodyne was running in Live 11.1.1 under 

macOS Monterey on a Mac with an M1 chip has been detected and eliminated.

Note editing: The “Restore Original” commands in the Edit menu now behave more 

consistently in the stand-alone implementation, in the Transfer plug-in and under ARA.
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New in Version 5.2

New features and improvements

Compatibility: In version 5.2, Melodyne now runs natively on Macs with Apple Silicon 

processors. The Mac version is supplied in Universal Binary format with native code for 

processors from Intel/AMD and Apple.

Pitch editing: The scale snap behavior for pitch systems with closely spaced alternate stages 

has been improved.

The playback function: In ARA mode and when using the transfer plug-in, you can now trigger 

playback of the current blob selection using the shortcut Alt+Space. If you would prefer to 

assign a different key combination to this shortcut, you can do so from the Shortcuts page of 

the Preferences dialog.

Cache: The location of Melodyne’s internal cache is now displayed in the Preferences dialog in 

ARA mode too, and you can alter its size.

Bug fixes

Pitch editing: “Monitor When Editing Blobs” now also functions reliably with the arrow keys 

when pitch shifting.

Editing the tempo assignment under certain circumstances led to a crash. Fixed.

Accidentally dragging a track to the Project Inspector tab under certain circumstances led to a 

crash. Fixed.

Changing the pitch reference at high zoom levels under certain circumstances led to a crash. 

Fixed.

Moving an inserted note separation under certain circumstances generated an error message. 

Fixed.

Scale changes: If the “Tuning and Mode” option is active when using “Notes Follow Scale 

Changes”, notes are now moved correctly.

Windows: Melodyne’s file name extension is now correctly assigned.

Melodyne essential: The option “Highlight Notes During Playback” has been added to the 

Options > Note Editor submenu.

Stand-alone mode: When the Replace Audio command has been used, local playback now 

correctly reflects the track selection.

Melodyne essential: The option “Show Fades” that appeared erroneously in the Options menu 

has been removed.

The Note Inspector: When algorithms without sibilant detection are in use, the Sibilant Balance 

parameter is now grayed out.

Selection: When removing a note separation results in two blobs merging, the resulting blob is 

now also selected in ARA mode.
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New in Version 5.1.1

Change: A workaround has been integrated for ARA compatibility with Mixcraft 8.

Fixed: Lead sheets are now exported correctly via MIDI.

Fixed: In Apple Logic, playback can also now be started reliably from Melodyne.

Fixed: Under macOS, shortcuts using the “cmd” and function keys are now displayed correctly.
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New in Version 5.1

Features and improvements

macOS 11 Big Sur: Melodyne 5.1 is compatible with macOS 11 Big Sur on Intel-based Macs 

as well as on ARM-based Macs under “Rosetta”.

DAW-oriented keyboard shortcuts: We are always looking for ways to make the operation of 

Melodyne even easier for users of digital audio workstations. That’s why we’ve included sets of 

keyboard shortcuts customized for Pro Tools, Logic, Cubase and Studio One in Version 5.1. 

You can choose the set you want from the Shortcuts page of the Preferences dialog.

Exporting lead sheets: It is now possible to export the contents of the Chord Track as a lead 

sheet via MIDI; you will find the relevant command in the Chord Track’s context menu.

Algorithm selection: During ARA operation with Cakewalk, Melodyne’s Select Algorithm menu 

is now displayed prior to any MIDI export.

ARA improvements: The interaction with ARA DAWs has been optimized in various ways – 

partly to ensure compatibility with future DAW versions.

New keyboard shortcuts: It is now also possible to assign keyboard shortcuts to the following 

commands: “Show Sibilants”, “Note Leveling”, “Copy Song Data to Note Assignment…” and 

“Copy Note Assignment Data to Song…”.

Bug fixes

A keyboard shortcut assigned to “Toggle Cycle Mode” now also works reliably when Melodyne 

is running as a plug-in and under ARA.

MIDI export has been improved and muted notes are no longer included in the export.

Under macOS, keyboard shortcuts using the function keys are now also correctly displayed in 

the menu.

The “Set Cycle to Selection” function now also works correctly in Studio One.

When you stop playback in Pro Tools, the playback cursor in Melodyne now remains where it 

was when playback was halted, instead of springing back to the previous start position.
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New in Version 5.0.2

Bugfix: The installation program no longer launches under Windows 7, displaying instead a 

message saying that Windows 7 is not supported.

Bugfix: In the Note Editor, you can now also place time handles without having to select a note 

first.

Bugfix: In the Note Editor, you can now also move note separations without having to select a 

note first.

Bugfix: In Samplitude X5, when a new audio file is detected, whichever algorithm is selected 

as the default is now used.

Bugfix: There is no longer a delay before newly inserted note separations are displayed in the 

Note Editor.

Bugfix: In Cubase (in Transfer mode, i.e. without ARA), Melodyne still displays correctly even if 

you have changed the size of its window.

Bugfix: During local playback in ARA mode, overlapping notes are no longer erroneously 

played back at the comping boundaries.

New in Version 5.0.1

Bugfix: Use of the “Separate Notes as Trills” command no longer produces occasional artifacts.
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User manuals for older versions

Melodyne studio, editor, assistant and essential 4

The user manuals for Version 4 in English, German, French, Japanese and Spanish as PDFs in ZIP 

archive file format:

Melodyne studio |  |  | Melodyne editor Melodyne assistant Melodyne essential

These versions were replaced in May 2020 by Melodyne 5 studio, editor, assistant and essential.

Melodyne editor, assistant and essential 2 (singletrack)

The user manuals for Version 2 in English, German, French, Japanese and Spanish as PDFs in ZIP 

archive file format:

Melodyne editor |  | Melodyne assistant Melodyne essential

These versions were replaced at the beginning of 2016 by Melodyne 4 editor, assistant and essential.

Melodyne studio 3

The user manual for Melodyne studio 3 is available here in PDF format:

 |  |  |  | English German French Spanish Japanese

This version was replaced at the beginning of 2016 by Melodyne 4 studio.
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Ending support for older versions of Melodyne

The following versions of Melodyne are very out of date and no longer compatible with current 

operating systems. For that reason, support for them was discontinued at the end of 2018. It is no 

longer possible, therefore, to download, activate or obtain technical support for these versions of 

Melodyne:

Melodyne studio versions 1 and 2

Melodyne cre8

Melodyne uno

Melodyne plugin

Melodyne essential from a Digidesign or E-mu bundle

We have, however, provided links to free updates to the latest versions of all the discontinued 

products. If you have one of them and have not already received a notification from us to this effect, 

please contact our support for an update.
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